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Dorico 1.2 

1 December 2017 

This version contains the following new features, improvements and issue 
resolutions. 

New features 

Cues 

Cues are passages of music to be played by a different instrument shown in an 
instrumental part, usually to help orientate the player before an entry or a solo (for 
example, after a long passage of rests), but also on occasion to assist with co-
ordination or tuning, or to indicate material that the player may be asked to double. 

Cues are normally notated using notes of a smaller size, with the name of the 
instrument being cued indicated clearly at the start of the passage. Normally, full-
sized rests are also shown below or above the cue to reinforce that the player 
reading the cue should not play these notes. Cues may exclude some notations 
that would be present in the source instrument’s part, but may include slurs, 
articulations, and dynamics. Depending on the register of the instrument being 
cued and the tessitura of the specific cue passage, a clef change may also be 
needed at the start of the cue. 

 

Dorico naturally makes it very quick and easy to create a correctly-formatted cue, 
but it is the only scoring program to include dynamic cues that are linked to the 
original source material, and which are updated in real-time if the source material 
changes. 

Where cues appear. You can create a cue in any layout, but by default the music 
within a cue does not appear in the full score layout, since for most kinds of scores 
cues are shown only in the instrumental parts. In a full score, therefore, cues 
appear only as signposts by default, unless you are using galley view, in which 
case the cued music appears in addition to the signpost. 

You can, however, choose for cues to appear in a full score layout in page view by 
activating the Show cues option on the Players page of Layout Options. 
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In rare circumstances, for example when the same player’s music appears in 
multiple part layouts, you may also need to prevent a particular cue from appearing 
in a layout: this can be done by activating Hide in the Cues group of the Properties 
panel. 

Creating a cue. To create a cue, make a selection in the staff on which you want 
the cue to appear in Write mode. If you already know how long you want the cue to 
be, first make a block selection of the appropriate length, by selecting a rest, then 
holding Shift and clicking on another rest, but it’s easy to edit the duration of a cue 
after creation, so there’s no need to get this precisely right from the outset. Once 
you have an appropriate selection in the instrument on which you want the cue to 
appear, either: 

 Type Shift+U to open the new cue popover directly; or 
 Choose Write ▸ Create Cue; or 

 Click the new  button in the notations toolbox on the right-hand side of the 
window to open the Cues panel, then click Insert Cue. 

The cue popover appears, into which you type the name of the instrument whose 
music you want to cue. Typing the beginning of the name of the instrument will 
show candidate instruments in a menu that opens up from the popover: select the 
desired instrument, either by pressing the down arrow key until it is highlighted, 
then press Return to complete its name in the popover, or by clicking it directly 
with the mouse. Then press Return again to confirm the popover and create the 
cue. 

If you are editing the full score layout in page view, at this point you probably see 
only the signpost for the cue, showing the name of the instrument to be cued. 
Switch to the part layout (try the new Window ▸ Counterpart Layout command, 
with default key command W) and you will see the cued music. 

The list of candidate instruments that opens up from the popover excludes the 
instrument on which the cue will be created (you cannot cue an instrument with its 
own music), but lists all other instruments, and lists each staff of grand staff 
instruments such as piano separately (as e.g. Piano (a) and Piano (b)). Each 
unpitched percussion instrument also appears separately: for example, if one player 
in your project is playing a drum set, each constituent instrument from the drum set 
appears as a candidate for cueing, so you can cue, say, the kick drum (you cannot, 
however, use the entire percussion kit as a cue). 

Deciding where to cue. The Suggest Cues section of the Cues panel can help 
you to determine good locations for cues in your score. Dorico can find all of the 
places in the current flow where the players in the current layout have not played 
anything for at least a certain span of time – by default, 30 seconds. The resting 
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period is specified in absolute time rather than in bars or 
beats because the meter and tempo can change many 
times throughout a flow, and indeed the music may be 
either partially or completely meterless, whereas one 
second is always one second long, so specifying an 
absolute time ensures some consistency in the 
approach to finding possible places where cues might 
be appropriate. 

To specify the threshold for the period of rests after 
which Dorico should suggest that an instrument might 
need a cue, set Resting for n secs to the desired value. 

You can choose whether to consider or ignore rehearsal 
marks when determining the resting period. Rehearsal 
marks often coincide with new sections or other 
landmarks in the music, which may well be obvious to 
the player without needing any further kind of cue, in 
which case you can decide whether the presence of a 
rehearsal mark should reset the timer. By default, 
rehearsal marks are ignored, since they do not always 
act as signposts to musical structure. 

You can also choose whether to consider or ignore cues that between notes 
played by the destination player. A cue that occurs immediately before an 
instrument’s entry will always be ignored and never show up as a suggested 
location, even if you choose to consider cues. However, orientation cues – cues 
that do not immediately precede an instrument’s entry, but which serve to help the 
player keep his or her place during an extended rest – will reset the timer if you tell 
Dorico to consider cues. 

Once you have made your choices, click Update. Below the Update button you 
can see the names of the flow and layout that were active when you last updated 
the list of cue suggestions: this allows you to freely navigate through the project, 
switching layout and flow, etc., and when you return to the list of cue suggestions, 
you will be able to see at a glance which flow and layout the suggestions apply to. 
To generate cue suggestions for another flow or layout, simply select an item in the 
desired flow, and/or switch to the layout, then click Update. 

One possible workflow you might consider for larger projects is to switch to one of 
the part layouts and click Update to generate cue suggestions for that player. The 
list of suggestions will then include only suggestions for the player included in the 
layout, and you can then switch back to the full score (by typing W) to get an 
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overview of which material you might use as a cue at each suggestion, and you can 
freely switch back and forth between the score and the part layout without losing 
your list of cue suggestions. 

The list of cue suggestions itself can be sorted either in bar order, or in order of 
length of resting periods. Clicking on a row in the list of cue suggestions navigates 
directly to that location, and by default an area corresponding to between five and 
10 seconds prior to the instrument’s entry is highlighted in red to help you to spot 
the location at a glance, which is especially useful when zoomed out. The 
highlighted area is not a specific recommendation for the length of cue you should 
create, but depending on the musical context it may be a good indication. If you 
would prefer not to see the red highlighted areas, deactivate the Highlight 
suggestions checkbox below the list and click Update again to regenerate the 
suggestions. 

When you select a cue suggestion in the list, a further list of Playing instruments 
is populated with the instruments that are playing in the 5-10 seconds prior to the 
destination instrument’s entry, to help you determine which instrument might be 
suitable to use as the cue. 

If you create a cue at the location of one of the suggestions in the list, that 
suggestion is automatically removed from the list in the Cues panel. If you review a 
particular suggestion and decide that in fact a cue would not be appropriate there, 
you can click Ignore in the action bar at the bottom of the list to hide that 
suggestion; however, if you regenerate the list by clicking Update, that suggestion 
may reappear again in the future. 

Editing the duration of a cue. Once a cue has been created, its duration can be 
edited at any time. In Write mode, in a layout where the cued music is shown, 
select the label at the start of the cue showing the name of the source instrument: 
round handles appear at the left-hand side of the label and at the end of the cue. 

To lengthen the cue, click and drag either handle: as you do so, you will see the 
music in the cue change, as notes are snapped into the cue. You can start or stop 
the cue at any note onset position, even in the middle of a beamed group or a 
tuplet, but you should carefully consider whether a cue that begins or ends these 
kinds of partial notations would be helpful to the player. 

Like other items in Write mode, you can also move the cue while retaining its 
current length with Alt+left/right arrow, and lengthen or shorten the cue with 
Shift+Alt+left/right arrow. 

Editing the music in a cued passage. The music that appears in a cue is 
dynamically shown from the source instrument, and changes made to the source 
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music will be automatically shown in the cue, but it cannot be selected in the cue. 
However, it is possible to make graphical changes to the cued music without 
affecting the source instrument, such as adjusting the placement of slurs, or 
lengthening or shortening stems. 

It is also possible to change the enharmonic spelling of notes in cues in Engrave 
mode using the Alt+- and Alt+= key commands. Respelling notes in the cue will 
not affect the spelling of notes in the source material. 

Rests in cues. If a cue starts or ends in the middle of a bar, the cue will be padded 
with appropriate cue-sized rests up to the bar boundary or to the next entry in the 
player’s instrument, whichever is the sooner, to ensure it is clear to the player how 
the rhythm of the cue fits with the existing material. 

If you prefer not to see these padding rests to either side of the cued music, they 
can be hidden by selecting the cue label or signpost, then activating the Hide 
rests around cue property in the Cues group of the Properties panel. It is not 
possible to select or otherwise edit the cue-sized rests that are created to pad 
cues to the nearest entry or barline. 

By default, full-sized bar rests will also appear throughout the cued passage, to 
make it clear to the performer that he or she should not play. In some jazz scores, 
or in scores where the cues are provided as potential passages for doubling, it may 
be appropriate not to show bar rests during cues, in which case you can set Bar 
rests in cues to Omit bar rests on the Rests page of Notation Options. 

Full-sized bar rests are automatically positioned appropriate to the stem direction 
of the notes in the cue: if the cue uses up-stem notes, bar rests will be positioned 
below the cued notes, and if the cue uses down-stem notes, bar rests will be 
positioned above the cued notes. You can adjust the position of the full-sized bar 
rests using the Rest pos. property in the Notes and Rests group of the Properties 
panel. 

Stem direction in cues. Because cues are normally shown together with full size 
bar rests to indicate to the performer that he or she should not play the cue, 
provided a cue contains music in only one voice, all of the notes normally take the 
same stem direction; if, however, the cue contains music in multiple voices, the 
original stem directions of the source music are used instead. 

For single-voice cues, Dorico determines the default stem direction depending on 
whether the balance of notes fall below the middle line of the staff (in which case 
the stems will point downwards) or above (in which case the stems will point 
upwards). 
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You can override the default stem direction of a single-voice cue by selecting the 
cue label or signpost and activating the Voice direction property in the Cues 
group of the Properties panel. 

Ties into and out of cues. If a cue begins in the middle of a sustained note, then a 
tie will be shown at the start of the cue, joining to the first note in the cue; similarly, 
if a cue ends in the middle of a sustained note, then a tie will be shown at the end 
of the cue, proceeding from the final note in the cue. For monophonic instruments, 
these ties will normally be well-positioned by default, but in complex cases 
involving cued chords, you may find that the positions of these ties may require 
some adjustment. Ties into and out of cues can all be edited in the same way as 
normal ties in Engrave mode. 

Rhythmic cues. Sometimes it is necessary only to provide a rhythm as a cue, for 
example when many instruments play the same distinctive rhythm together. 
Rhythmic cues are displayed above the staff, with all notes from the source 
instrument shown at the same nominal pitch, showing no change of clef, no 
accidentals and no ledger lines. To make a rhythmic cue, create a cue from a 
pitched instrument in the normal way, then activate the Rhythmic cue property in 
the Cues group of the Properties panel. The material will then appear above the 
top line of the staff, and can be moved closer or further away by activating the 
Distance property: a value of 0 corresponds to the space immediately above the 
top line of the staff, with higher values moving the material further away from the 
staff. Since rhythmic cues often include music from multiple instruments, you may 
find it useful to change the text of the cue label, which can be done using the Start 
label property. 

Cueing from an unpitched instrument. If you choose to cue music from an 
unpitched percussion instrument, it will be created as a rhythmic cue. If you switch 
off the Rhythmic cue property, all of the notes in the cue will be placed on a single 
staff position, by default the middle line of the staff. To move the notes to a different 
staff position, select the cue label or signpost and activate the Unpitched notes 
pos. property in the Cues group of the Properties panel (0 = middle line of the 
staff, 4 = top line of the staff, -4 = bottom line of the staff). 

Cueing to an unpitched instrument. You can use other unpitched instruments as 
the source for a clef on an unpitched instrument. If you need to cue pitched 
material for a player of unpitched instruments, add any pitched instrument to the 
player in Setup mode, and create the cues from pitched instruments in galley view 
on the staff belonging to the pitched instrument. When you switch back to page 
view, Dorico will automatically show transitions between the pitched and unpitched 
instrument, with the pitched cues appearing in the pitched regions. 
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Cueing octave transposing instruments. When you cue music from an instrument 
that is normally written an octave lower or higher than its sounding pitch, such as 
piccolo or double bass, the cue is automatically shown at the normal written octave 
as it would be shown in a conductor’s score, rather than at the sounding octave. 

Dorico automatically appends an indicator such as 8va or 15mb to the cue label to 
tell the player that the cue they are reading is not written at its sounding octave. 
You can disable this by setting Octave transposition to Exclude from cue label 
on the Cues page of Engraving Options, and you can also override this setting on 
a per-cue basis using the Show octave transposition property. 

Furthermore, if you want to shift a cue by one or more octaves, you can activate the 
Octave shift property and set the number of octaves by which to raise or lower the 
cue. If the octave transposition is shown in the cue label, it will include this shift. 

Clef changes for cues. If the music for the source instrument is written in a different 
clef than is used by the destination instrument, Dorico will automatically include a 
clef change to the source instrument’s clef at the start of the cue, and a restorative 
clef change to the destination instrument’s previous clef at the end of the cue.  

Clef changes at the start of cues are positioned differently to normal clef changes: 
if the cue starts at the beginning of a bar, any clef change appears on the right-
hand side of the barline rather than the left. (Restorative clef changes at the end of 
the cue are positioned like normal clef changes.) 

If a cue that requires a different clef crosses a system or frame break, the 
destination’s original clef is shown in the usual place at the start of the new system, 
and the clef required for the cue then appears immediately before the first note of 
the new system (to the right of any key and time signature that may appear). 

When multiple cues abut, clef changes will be created as needed: if two abutting 
cues use the same clef that is different than the clef in force on the destination 
instrument, a single clef change will appear at the start of the first cue, with a 
restorative clef at the end of the second cue. If cues overlap, and the second cue 
requires a different clef than the first, Dorico will create a clef change at the start of 
the second cue. 

You can override the automatic behavior for clefs, with separate options for the 
layout in both concert and transposed pitch, by selecting the cue label or signpost 
and using the Concert clef or Transposed clef properties in the Cues group of 
the Properties panel; which property appears depends on whether the layout is 
currently using concert or transposed pitch. Dorico can show a treble G clef, bass 
F clef, alto C clef, or tenor C clef. You can furthermore choose None, which means 
that the clef of the destination instrument will be used instead of the clef of the 
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source instrument. When two cues abut and the first cue uses a different clef than 
the destination instrument, if the clef property for the second cue is set to None, 
then the clef change that restores the destination instrument’s original clef will 
appear at the end of the first cue. 

Any clef changes that occur in the source instrument in the middle of the cued 
passage will not be included in the cue on the destination instrument. 

If you would prefer Dorico not to create clef a change to the source instrument’s 
clef automatically at the start of a cue when the clefs used by the source and 
destination instruments differ, you can set Clef at the start of the cue to Use clef 
of destination instrument on the Cues page of Engraving Options. You can still 
make a clef appear for those cues that need it using the appropriate properties, as 
described above. 

Choosing which notations should be cued. Only certain notations are included in 
cues, so as to avoid overloading the player with too much information: by default, 
Dorico includes slurs, articulations, ornaments and playing techniques in the cued 
material. If you are cueing vocal music, lyrics will also be included by default. 

To change which notations are included in cues by default, set the options in the 
Included Notations section of the Cues page of Engraving Options to match your 
preferences. 

You can also selectively choose which notations should be included in an 
individual cue by selecting the cue label or signpost, then setting the appropriate 
properties in the Cues group of the Properties panel. 

Even when playing techniques are set to be included in cues, not every playing 
technique is included: playing techniques that indicate something that is of interest 
only to the player whose music is being cued (such as bowing marks for string 
players) will not be included in the cue. It is not currently possible for you to decide 
whether a particular kind of playing technique should or should not be included in 
cues, but this will become editable in a future version. 

Beware that, for example, a playing technique such as pizz. for strings must exist 
within the range of the cued material for it to be included in the cue: if the pizz. 
instruction in the source instrument comes before the start of the cue, it will not 
appear in the cue. You could consider overriding the Start text property of the cue 
to include this information. Likewise, a slur will only be included in the cue if it both 
starts and ends within the cued material. 

Changing the size of cued material. By default, cued material is scaled to three-
quarters size. To edit this, change Cue note scale factor on the Cues page of 
Engraving Options. 



 

 
Dorico Version History Page 11 Steinberg Media Technologies GmbH 

Changing the labels for cues. The abbreviated form of the source instrument’s 
name is shown as a label at the start of the cue. If you prefer to use the full 
instrument name, change the Instrument name in label option on the Cues page 
of Engraving Options to Use full name. By default, the transposition or pitch of the 
instrument is not included in the label. If you prefer to include the transposition, 
change Instrument pitch or transposition to Include in cue label. 

If the Additional label at end of cue option is set to Show ‘Play’ at next entry, 
the word “Play” will be shown at the end of the cue. This is sometimes used in jazz 
scores, where it is also sometimes customary not to show bar rests along with 
cues. 

Sometimes a cue may be for multiple instruments playing in unison or in octaves, in 
which case you can override the default label at the start of the cue to, for example, 
“Vln. I & Vln. II coll’ottava”. This can be done by selecting the cue label or the cue 
signpost, and activating the Start text property in the Cues group of the Properties 
panel. Similarly, you can activate the End text property to make a label appear at 
the end of the cue even if no label would otherwise be shown. 

The cue label is shown above the staff for up-stem cues (and cues including 
multiple voices), and below the staff for down-stem cues, but this default can be 
changed by way of the Placement of cue label option on the Cues page of 
Engraving Options, and overridden for an individual cue by activating the 
Placement property and setting it to Above or Below as desired. 

Rhythmic spacing for cues. Cues are normally spaced more tightly than destination 
instrument’s regular music. You can determine by how much the rhythmic spacing 
for cues should be tightened by setting the Scale space for cue notes by n% 
option on the Note Spacing page of Layout Options, and this can also be 
overridden for a range of music using a note spacing change event. By default, 
ideal rhythmic spacing is scaled to 70% for cues. 

Hiding cues. If the same player’s music appears in multiple layouts, it may be 
necessary to show different cues depending on the layout in which the player’s 
music appears. As such, it is possible to hide an individual cue by selecting the cue 
and activating the Hide property in the Cues group of the Properties panel, which 
will hide the cued music in the current layout. 

View options. View ▸ Highlight Cues shows a translucent yellow highlight behind 
the bars where a cue is shown, and a translucent blue highlight behind the bars 
that are used as the source for a cue. As you zoom out, the highlights become 
more opaque, allowing you to get an overview both of where cues have already 
been added, and which instruments are being used as cues. This is especially 
useful when viewing the full score layout in galley view. 
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View ▸ Note and Rest Colors ▸ Cues shows the cued material in grey, to remind 
you that this material cannot be edited directly. 

Fingering 

Sophisticated support for keyboard, brass and string fingering has been introduced 
in this update. 

 

Inputting fingering. Fingering is associated with an individual notehead, so you 
must first select the note or notes to which you want to add fingering. To add 
fingerings to all of the notes in a chord efficiently, first select all the notes in the 
chord (one quick way to do this is to click on the stem that the notes share). Once 
you have selected the note or notes to which you want to add fingerings in Write 
mode, either: 

 Type Shift+F to open the new fingering popover directly; or 
 Choose Write ▸ Create Fingerings; or 
 Click the new  button in the notations toolbox on the right-hand side of the 

window. 

The fingering popover appears, into which you type the fingerings you want to 
appear as follows: 

 For multiple selected notes, separate fingerings with commas, e.g. 1,3,5. For 
keyboards, the order of the numbers doesn’t matter: Dorico will automatically 
order them appropriately according to whether the notes are to be played by the 
right or left hand, under the assumption that unless otherwise specified, the 
notes will be played by the right hand for the upper piano staff and the left hand 
for the lower piano staff. 

 To explicitly specify which hand a keyboard fingering refers to, add L for the left 
hand or R for the right hand before the first fingering. (As alternatives for “left” in 
other languages, you can also specify G for gauche, S for sinistra, I for 
izquierda, and H for hidari; as alternatives for “right”, you can also specify D for 
droit, destra and derecho, and M for migi.) 
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 You can specify multiple fingerings for a single note, for example to specify the 
fingering for an ornament such as a mordent or turn, by typing a series of 
numbers with no separators, e.g. 2343. 

 Sometimes the same finger – typically the thumb – is used in keyboard music to 
play multiple notes. Simply specify the same fingering number for two adjacent 
notes, and Dorico will either display a single fingering number and a small 
bracket, or show the fingering number twice, according to your chosen 
Engraving Options. 

 To specify an alternative fingering, which is shown immediately following the 
fingering number either in parentheses (the default) or square brackets, simply 
type the alternative fingering in parentheses into the popover immediately 
following the standard fingering number, e.g. 2(3). Even if you choose to show 
alternative fingerings in square brackets via Engraving Options, they must be 
specified with parentheses in the popover. 

 To specify an editorial fingering, which is shown either in square brackets (the 
default) or parentheses, type the fingering in square brackets into the popover, 
e.g. [4]. An editorial fingering appears instead of a standard fingering for that 
note. 

 To specify a finger substitution – where a note is played with one finger, and the 
performer must smoothly switch to another finger during the duration of the note 
– separate the first and second fingers with a hyphen, e.g. 1-3. This creates an 
immediate substitution, the duration of which can be edited afterwards. 

 For fingering on string instruments, you can also type T to input a thumb 
indicator. 

 For fingering on brass instruments, you can enter the valve number (for 
trumpets, horns, etc.) or slide position (for trombones, etc.) in the same way as 
keyboard fingerings; for slide positions you can enter numbers up to 7. 

To finish inputting fingering for the selected note or chord, simply hit Return to 
confirm the popover. 

Because you need to select the notes to which the fingerings should be added 
before you add fingerings, the popover does not advance on its own: after 
confirming the popover, either move the selection with the arrow keys or select the 
next note or chord with the mouse before opening the popover again. 

Choosing where fingering appears. By default, fingering will appear both in full 
score and part layouts, but depending on the nature of your project it may be more 
appropriate for fingering to appear in only the full score or part. Whether or not 
fingering appears in a layout is determined by the Show fingering option on the 
Players page of Layout Options. 
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Editing fingering. To edit an existing fingering for a note, select the note and open 
the fingering popover (e.g. by typing Shift+F), then type the new fingering. 
Alternatively, the fingering can be edited by changing the value of the Finger or 
position property in the Fingering group of Properties. 

Deleting fingering. When you select a fingering in Write mode, the note will be 
selected as well, because the fingering is an intrinsic part of the note. Therefore, 
you cannot delete fingering by selecting it and pressing Delete. Instead, select the 
note and deactivate the Finger or position property in the Fingering group of 
Properties. To remove many fingerings efficiently, try making a block selection (click 
in a blank part of the staff in one bar, then Shift+click in a blank part of a later bar), 
then use Edit ▸ Filter ▸ Notes and Chords to filter the selection to only notes, then 
switch off the Finger or position property for all notes at once. 

Fingering substitutions. To show that the performer should play a note with one 
finger and then inaudibly substitute another, input the two fingerings separated by 
a hyphen in the Shift+F popover (e.g. 2-3). This will create an instantaneous 
substitution, centered above or below the note to which the fingering applies. You 
can choose on the Fingering page of Engraving Options whether an instantaneous 
substitution should be indicated using a horizontal line between or a slur above or 
below the two fingerings. 

To specify that the performer should change finger at a specific rhythmic position, 
you can create a deferred substitution. Either: 

 In Write mode, select an instantaneous substitution with the mouse: a circular 
handle appears on the fingering following the substitution indicator. Drag this 
left or right to change the position at which the substitution should occur; or 

 In Write or Engrave mode, select an instantaneous substitution, and then 
activate or change the value of the Substitution offset property in the 
Fingering group of the Properties panel. The first value is the number of quarter 
notes (crotchets) after the initial depression of the note that the fingering 
substitution should be performed; this can be expressed as fractions of a 
quarter note. The second value is for the grace note position at which the 
substitution should occur; normally you do not need to set this value. 

Deferred substitutions are always indicated with a horizontal line, even if 
instantaneous substitutions are indicated by a slur above or below. 

Dorico automatically arranges deferred substitutions such that they are ordered 
appropriately with any other fingerings that coincide with the substitution. 

Cautionary fingerings. A cautionary fingering is used to remind the performer that a 
fingering that was specified at a previous rhythmic position still applies for a note 
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that is still sounding. You do not need to create cautionary fingerings: Dorico 
automatically displays them if you add another fingering at a rhythmic position at 
which a note previously given a fingering is still sounding, enclosing them in 
parentheses by default. If you would prefer cautionary fingerings to be shown 
without parentheses, or indeed not to be shown at all, set the Cautionary 
fingering appearance option on the Fingering page of Engraving Options 
accordingly. 

Choice of font. By default, fingerings are drawn in a bold, roman font that is similar 
in appearance to the digits in time signatures. If you would prefer fingerings to be 
drawn in another font, set Fingering appearance to Plain font on the Fingering 
page of Engraving Options. With this option set, Dorico will use the Fingering text 
font font style to draw fingering numbers, parentheses, and brackets; the thumb 
indicator, substitution lines and slurs, and brass valve separators will continue to be 
drawn as before. 

Position relative to the staff. For keyboard instruments, fingering is positioned 
above the right-hand staff, and below the left-hand staff. For string and brass 
instruments, fingering is always positioned above the staff. 

To position an individual fingering on the opposite side of the staff from its default 
position, select the fingering or its associated note and activate the Staff-relative 
position property in the Fingering group of the Properties panel, then set either 
Above or Below as necessary. 

In complex contrapuntal music, you may find it preferable for fingerings in general 
to be positioned above the staff for up-stem notes and below the staff for down-
stem notes. This can be achieved by setting Position of fingering relative to the 
staff to Follow voice directions on the Fingering page of Engraving Options. 

Position relative to slurs. By default, fingerings are positioned inside the arc of 
slurs, but outside the starts or ends of slurs. You can change this default by setting 
Position of fingerings relative to slurs, octave lines and tuplets on the 
Fingering page of Engraving Options. If you would prefer an individual fingering to 
be positioned outside a slur, select the fingering or its associated note in Engrave 
mode and activate the Slur-relative position property in the Fingering group of 
the Properties panel, and set Outside. Be aware that fingerings positioned inside 
slurs will also be positioned inside tuplets and octave lines, unless they coincide 
with the first or last note of a slur, in which case they will be positioned outside all 
of these notations.  

Adjusting the position of fingering. Fingerings can be nudged in Engrave mode by 
selecting them and using Alt+arrow keys to move them, with Ctrl (Windows) or 
Command (Mac) for larger steps. You can also drag fingerings directly with the 
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mouse. Alternatively, you can adjust the value of the Offset X and Y properties in 
the Fingering group of the Properties panel. 

To reset the position of a fingering number, select it in Engrave mode and choose 
Edit ▸ Reset Position, or deactivate the Offset X and Y properties. 

Fingering for valved brass instruments. For instruments like trumpet and horn, 
fingering is used to show which valves need to be depressed to produce a specific 
note. For example, to play C sharp on a trumpet, the first two valves must be 
depressed. To enter this into the Shift+F popover, simply type 12. By default, 
Dorico stacks brass fingerings vertically, and inserts a dot between the numbers. If 
you prefer the fingerings to be positioned in a single row, or if you would prefer to 
use either a slash as a separator, or no separator at all, use the options in the 
Brass section of the Fingering page of Engraving Options to change them. 

Slide positions for brass instruments. To indicate the slide position for slide brass 
instruments, such as trombones, either Arabic or Roman numerals are used. By 
default, Dorico shows slide positions as Arabic numerals, but you can choose to 
show Roman numerals instead by setting Trombone slide position appearance 
to Roman numerals on the Fingering page of Engraving Options. To input slide 
positions, use Arabic numerals in the Shift+F popover even if you want to see 
Roman numerals printed in the score. 

Horn branch indicators. To indicate whether a note should be played on the F of B♭ 
branch of a double horn (or indeed on the alto E♭ or F branch of a triple horn), a 

horn fingering may be prefixed with an indicator of the branch to be used. Some 
publications simply indicate T for thumb, while others more explicitly indicate which 
branch is to be used by specifying its pitch. To add a branch indicator, select a 
note belonging to a horn in F (no other pitch of horn is supported at present), and 
activate the Horn branch property in the Fingering group of the Properties panel. 
Dorico does not, however, attempt to establish whether the branch chosen is 
actually valid for the selected note. Options for the appearance of these indicators 
can be found in the Horn Branch Indicators section of the Fingering page in 
Engraving Options. 

String fingering shifts. When a string player has to shift position on the fingerboard 
of the instrument to play a higher or lower note with the same fingering as the 
previous one, this is sometimes indicated by way of an angled line that shows the 
direction of movement up or down the fingerboard. Dorico can show fingering shift 
indications if you specify which string a note is to be played on, and then activate 
the Indicate shift to next note property in the Fingering group of the Properties 
panel. 
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To specify which string a note is to be played on, select a note on a string 
instrument, and activate the new String property in the Notes and Rests group of 
the Properties panel. The property will show the pitches of the possible strings on 
which the note could be played on that instrument, to make it easy to set the 
correct value. If you subsequently edit the pitch of the note, the property will 
automatically be unset if it can no longer be played on that string. 

Specify the string for both the first and second notes, and then activate the 
Indicate shift to next note property. It is not necessary for either the first or 
second note to show an explicit fingering in order for the shift indicator to appear. 

Options for the length, thickness, angle, and placement between the two notes for 
the shift indication can be found in the String Fingering Shifts section of the 
Fingering page in Engraving Options. 

If you find that Dorico shows the fingering shift indicator pointing in the opposite 
direction to that which you expect, you can activate the Shift direction property 
and force the direction of the shift indicator. 

MusicXML import. Fingerings that are specified in the proper way in MusicXML 
files, i.e. using the fingering element, will be imported by Dorico. MusicXML files 
exported from Finale, for example, typically represent fingerings in the correct way, 
but Sibelius does not, so Dorico cannot import fingerings from MusicXML files 
exported by Sibelius. 

Unpitched percussion notation 

Dorico 1.2 introduces comprehensive support for unpitched percussion notation, 
with flexible options for combining music for multiple instruments into kits that can 
then be displayed differently in different layouts. 

Setup mode. Unpitched percussion instruments can be assigned to players in the 
same way as pitched instruments. When a player holds several individual 
percussion instruments, each will appear as a single line in the music: if instrument 
changes are enabled (on the Players page of Layout Options), then only the first 
instrument held by the player will appear, and Dorico will change from one 
instrument to the next as it does for pitched instruments. 

To show multiple unpitched percussion instruments held by a single player at the 
same time, they should be arranged into a percussion kit. By way of example, a 
drum set instrument is a percussion kit: a drum set consists of a number of 
separate instruments mounted together on a frame, and typically written on a 
regular five-line staff, with each instrument given 
its own position on the staff, and sometimes its 
own notehead type. Similarly, a pair of bongos 
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are likewise a percussion kit consisting of the two bongo drums, and typically 
written on a grid with two lines, the smaller drum shown on the top line, and the 
larger drum shown on the bottom line. 

When you expand a player holding percussion instruments in the Players panel in 
Setup mode, you will notice that kit instruments are colored green, whereas 
individual percussion instruments are colored the same light blue as all other 
instruments. 

Percussion kits versus individual instruments. When a player holds multiple 
individual percussion instruments, only a single kind of presentation is possible: 
each percussion instrument appears separately on a single line, labeled separately, 
in all the layouts in which the player is included. This will often be appropriate if a 
player has only one or two percussion instruments, but combining the instruments 
into a kit gives you more flexibility with how music for this player can appear: you 
can choose to use either of the other two presentation types – showing the music 
on a grid or on a five-line staff – and vary this per layout, and you have greater 
control over how the player’s instruments are labeled. 

Combining individual instruments into a kit. If a player is holding one or more 
individual percussion instruments, you can combine them into a percussion kit: 
simply right-click on the player’s card in the Players panel in Setup mode and 
choose Combine Instruments into Kit. If the player already has one or more kit 
instruments, the individual instruments and any further kits will be combined into 
the first kit; if no kit exists, then one will be created. The Edit Percussion Kit dialog 
opens immediately to allow you to edit the resulting kit, for example to change the 
order in which the instruments appear in a grid or on a five-line staff. 

Creating an empty percussion kit. To add an empty percussion kit to a player, 
right-click on the player’s card in the Players panel in Setup mode and choose 
Create Empty Kit. The Edit Percussion Kit dialog opens immediately to allow you 
to add instruments to the empty kit. 

Moving percussion instruments from one player to another. If you have already 
written music for your percussion players and then find that you need to reallocate 
instruments between players, this is easy to do in Setup mode. 

You can move an individual percussion instrument from one player to another in the 
usual way: simply expand the card of the player holding the instrument you want to 
move, then click and drag to move it to another player, or hover over the 
instrument’s light blue label, click to show its context menu, and choose the 
destination player from the Move Instrument to Player submenu. 
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If the percussion instrument you need to move is part of a kit, then you must first 
remove it from the kit from within the Edit Percussion Kit dialog. To open the 
dialog, hover over the instrument’s green label in the Players panel, click to show 
its context menu, and choose Edit Percussion Kit to open the dialog. Select the 
instrument you want to move to another player from the list of instruments in the kit, 

and click  to remove it from the kit. Close the kit editor, and the instrument will 
appear as an individual instrument belonging to the player, at which point you can 
simply drag it to another player (and then combine it into a new or existing kit held 
by that player if necessary). 

Changing percussion instruments. You can change any pitched instrument into 
any other pitched instrument in Setup mode by clicking the instrument’s light blue 
label (in the expanded card for the player in the Players panel) and choosing 
Change Instrument from the context menu that appears. Any existing music 
belonging to that instrument is retained by the new instrument. When percussion 
instruments are involved, things are a little different. 

Firstly, you cannot change a percussion kit into any other kind of instrument: if you 
click a kit’s green label, Change Instrument is always disabled. 

You can, however, change any individual unpitched percussion instrument into any 
other unpitched percussion instrument: when you choose Change Instrument all 
of the unpitched instruments will appear in the picker. 

Presentation types for percussion kits. The music belonging to a percussion kit can 
be shown in one of three types of presentation, and each layout in your project can 
use a different presentation type if needed: 

 5-line staff: all of the instruments are shown together on a single five-line staff, 
with each instrument allocated its own staff line or space, showing a single staff 
label in the margin, and able to show a percussion legend to show either all of 
the instruments on the staff or only those instruments sounding at a particular 
point. 

 Grid: each instrument is shown on its own line, but sharing a single clef, time 
signature, etc., and where appropriate it is possible for notes to be written in the 
spaces directly above and below the line if needed. The lines of the grid are 
typically two or three spaces apart, and not all of the lines must be equally 
spaced from each other. The grid can have flexible staff labeling, with each 
instrument labeled separately, or several instruments grouped together with a 
single label. 

 Individual instruments: each instrument is shown on its own individual line, 
with its own clef, time signature, etc., and where appropriate it is possible for 
notes to be written in the spaces directly above and below the line if needed. 
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Multiple instruments held by the same player are vertically spaced according to 
the ideal distances defined on the Vertical Spacing page of Layout Options. 

The following simple examples showing the same material for a kit consisting of 
four instruments illustrate each presentation type: 

 
5-line staff 

 
 

Grid 

 
Individual instruments 

 

To change the presentation type, go to the Players page of Layout Options. In the 
Percussion section, a row of buttons appears for each player in the selected 
layout that holds a percussion kit instrument. 

 

Editing percussion kits. To edit a percussion kit, use the Edit Percussion Kit 
dialog. You will be taken to this dialog automatically if you create an empty kit or if 
you combine instruments into a kit. To edit an existing kit instrument, expand the 
player holding it in the Players panel in Setup mode, and click its green label. In the 
context menu that appears, choose Edit Percussion Kit. The dialog appears: 
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At the top of the dialog, you can set the full and abbreviated name for the kit 
instrument. This is the name that will be used as the staff label when using the five-
line staff presentation type. 

The main editing area of the dialog has three tabs, allowing you to edit how the kit 
will appear in each of the three presentation types: 

 5-line staff. The numbers down the left-hand side of the editing area 
correspond to staff positions: position 0 is the middle line of the five-line staff 
(on a staff using a treble G clef, B4; on a staff using a bass F clef, D3). Position 
1 is the space immediately above the middle staff line, position -2 is the line 
below the middle staff line, and so on. The five lines of the staff are shown with 
bold black lines, while nominal staff line positions above and below the staff are 
shown with grey lines. Each instrument is shown on its staff position. To move 
an instrument to another position, simply drag and drop it. Multiple instruments 
can share the same staff position, but it is advisable to ensure that they use 
different noteheads so that the player can tell them apart. 

 Grid. The numbers down the right-hand side of the editing area correspond to 
the number of staff spaces between each instrument’s line. By default, all 
instruments in a grid are two spaces apart. The order in which the instruments 
are listed here matches the order in which they will appear in the grid. To 
change the order, select an instrument and click the up/down arrow Move 
buttons in the action bar at the bottom of the editing area. To change the gap 
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between one instrument and the next, select the upper instrument and then set 
the Gap value in the action bar at the bottom of the editing area. Each 
instrument in a grid shows its own staff label by default, aligned vertically with its 
own line, but you can group adjacent instruments together and show a single 
label instead: select instruments by clicking on the first, holding Shift and 
clicking on the last, then click the + button to create the group. To change the 
name of the group, double-click it in the column to the left of the instruments 
contained in the group. 

 Single-line instruments. The editing area lists all of the instruments in the 
order in which they appear in the score. To change the order, select an 
instrument and click the up/down arrow Move buttons in the action bar at the 
bottom of the editing area. 

Editing the name of an instrument will affect its appearance in all presentations: this 
can be done by clicking the Edit Names button below the action bar. 

The action bar at the bottom of the dialog provide other operations that apply to all 
presentation types. From left to right: 

 

 Add new instrument: shows the instrument picker to allow you to choose a 
new unpitched percussion instrument to be added to the kit. 

 Add existing instrument from player: shows a menu listing the other players 
holding individual percussion instruments (i.e. those not in kits), to allow you to 
move an instrument from another player to this kit, bringing its music with it. 

 Remove instrument from kit: removes the selected instrument from the kit, so 
it appears as an individual instrument and can be moved to another player or 
into another kit instrument. 

 Change instrument: shows the instrument picker to allow you to choose a new 
unpitched instrument to replace the selected instrument, retaining its music. 

 Delete instrument: deletes the instrument from the kit, along with its music. 

Voices in percussion kits. When music belonging to multiple percussion 
instruments is displayed in the five-line staff or grid presentations, Dorico combines 
the music from each instrument into a smaller number of voices: by default, one up-
stem voice and one down-stem voice. Alternatively, you can choose to notate all 
notes in a single voice, which is a convention sometimes followed for drum set but 
less often for orchestral percussion. 

To choose between using the voicing set in the Edit Percussion Kit dialog or only 
using a single voice, set Voicing for drum set kit presentation on the 
Percussion page of Notation Options to the desired option. 
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Furthermore, you can override this option on a per-percussion kit basis by 
activating or deactivating Is drum set in the Edit Percussion Kit dialog. 

In the Edit Percussion Kit dialog, you can specify the default stem direction for 
each instrument, and also whether it should share the same voice as another 
instrument or use a new one. Select an instrument in the editing area, and these 
controls in the action bar are enabled: 

 

Click the note whose stem direction matches the desired stem direction. If you 
want to move the instrument into its own voice, change the number to the right. 
The number corresponds to the number of voices for each stem direction, so you 
don’t need to change the number simply because you are switching between up- 
and down-stem voices. 

Notes in the same voice cannot be notated using different durations, so if you 
combine notes of different durations into the same voice, they will be notated using 
ties by default. If you would instead prefer to truncate longer notes so that only 
their onsets appear, thereby eliminating the use of ties, set Overlapping notes in 
the same voice in a kit or grid presentation on the Percussion page of Notation 
Options to Truncate to shortest duration. 

If one of the instruments has a tuplet rhythm, other instruments can still share the 
voice if their notation is compatible: if the tuplet structure is the same, or if they 
have a single note that coincides with the start of the tuplet, in which case that 
note will be notated as the same duration of the first note of the tuplet. If the music 
is incompatible, then Dorico will dynamically create another voice and notate the 
remaining music in that voice for the duration of the tuplet or otherwise 
incompatible region. 

It is also possible to override the default choice of voice for an instrument for only 
one or a few notes: select the notes whose voice you want to override, and choose 
the desired up-stem or down-stem voice from the Edit ▸ Percussion ▸ Change 
Voice submenu. To reset an overridden note back to its default voice as defined in 
the Edit Percussion Kit dialog, choose Reset Note Destination Voice. 
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Playing techniques. In addition to the playing techniques that can be added via the 
Playing Techniques panel in Write mode or the Shift+P popover – which is how, 
for example, open/closed techniques for hi-hat are input – unpitched percussion 
instruments can also specify different playing techniques by the use of different 
noteheads, positioning notes in the space directly above or below the line on which 
notes are normally written, or by the addition of articulations (staccato, accent, etc.) 
or single-note tremolo (for rolls, etc.). 

You can edit the set of playing techniques defined for each percussion instrument 
using the Edit Percussion Playing Techniques dialog, which is opened as 
follows: 

 For an individual percussion instrument held by a player, expand the player’s 
card in the Players panel in Setup mode, click the light blue instrument label, 
and choose Edit Percussion Playing Techniques from the context menu. 

 For an instrument that is part of a percussion kit, first open the Edit Percussion 
Kit dialog, then select the instrument whose playing techniques you want to edit 
in the main editing area, and click Edit Percussion Playing Techniques below 
the action bar. 

 

At the top of the dialog are the main playing techniques that are defined for this 
percussion instrument, showing the notehead set and, optionally, the staff position 
corresponding to this playing technique. Normally a percussion instrument will 
define at least the Natural playing technique, which is usually shown using the 
default notehead set. 
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To add a new playing technique, click the + button in the action bar, and in the 
dialog that appears, choose the playing technique you want to create. After clicking 
OK, a new entry appears in the list at the top of the dialog. If the technique should 
use the default notehead set, leave Notehead set at (Unset) rather than choosing 
a specific notehead set, and then Dorico will use the default notehead set as 
defined on the Notes page of Engraving Options. To specify that this playing 
technique should be positioned on the space either above or below the grid line, 
set Staff position to Above or Below respectively. 

This is all that is required to specify a playing technique that you can cycle through 
using Shift+Alt+up/down arrow when inputting or editing music on a percussion 
instrument, but you may also want to define specific behaviors for particular 
combinations of articulations and single-note tremolos, in which case you can 
define further combinations for each playing technique defined in the list at the top 
of the dialog in the Playback of Articulations and Tremolos section below. 

For example, to define a roll, first click + in the action bar in the list at the bottom 
left-hand corner of the dialog to add a new entry to the list. Click the … button next 
to the Playing technique read-out, and choose Roll from the list of playing 
techniques, then click OK to confirm your choice. It is possible to choose a 
combination of playing techniques from this dialog with Ctrl+click (Windows) or 
Command-click (Mac). Choose Replace if you want this playing technique to be 
used instead of the default playing technique defined for this combination of 
notehead and staff position, or choose Add if you want this playing technique to be 
added on top – for our roll example, choose Replace. Finally, click the number of 
tremolo strokes that you want to produce the roll. 

All of these settings are saved in the percussion instrument within your project, and 
can be exported from one project and imported into others later on. 

Overrides for articulations and tremolos are not currently respected in playback, 
but this will be addressed in a future version of the software. 

Overriding playing technique appearance. The choices you make in Edit 
Percussion Playing Techniques apply when a percussion instrument is shown in 
any of the three presentation types, but when the instrument is shown in a five-line 
staff presentation, if the instrument shares a staff position with one or more other 
instruments, it may be necessary to change the noteheads used to disambiguate 
the notes for one instrument from another. To do this, select the instrument whose 
noteheads you want to override from the main editing area and click Edit 
Noteheads. The following dialog appears: 
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This lists the playing techniques defined for the instrument in the Edit Percussion 
Playing Techniques dialog, and shows which notehead type is mapped for each 
technique. To override a notehead, click in the Notehead Override column for the 
appropriate playing technique, and choose the new notehead type from the menu 
that appears. Click OK to confirm your choices. 

Exporting and importing percussion kits. All of the choices made in the Edit 
Percussion Kit dialog and its subsidiary dialogs pertaining to a particular 
percussion kit can be exported to a library file that you can reuse in other projects 
later on. To export the library, click Export Kit at the bottom left-hand corner of 
Edit Percussion Kit, and choose the name and location of the file to save. 

To use a percussion kit you have exported in another project, you can either click 
the Import Kit button in the instrument picker to choose the library file containing 
your kit, or right-click a player in the Players panel in Setup mode and choose 
Import Kit from the context menu. In both cases, the imported kit will be assigned 
to the chosen player. 

Setting up note input for percussion. Inputting music for unpitched percussion 
instruments works differently than it does for pitched instruments. You can use any 
of the usual methods for unpitched percussion input, but using a MIDI keyboard or 
the computer keyboard is most efficient. 

On the General page of Preferences you will find options relating to note input for 
percussion, with one set of options for input onto five-line staves, and another for 
input onto grids and individual instruments. The main choice affects both input via 
MIDI and computer keyboard: 
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 Use percussion map: a percussion map defines which MIDI notes produce 
which sound for a particular patch in a sound library. For example, in General 
MIDI percussion, C2 (note 36) produces bass drum, and D2 (note 38) 
produces snare drum, and so on. If you know a particular mapping well, then 
you may find it helpful to use the mapping directly for input.  

 Use staff position: this option uses the staff position defined in the Edit 
Percussion Kit dialog. For example, on a drum set, the bass drum is normally 
positioned in the bottom space of the staff, while the snare drum is positioned in 
the third space from the bottom. You might think of the staff positions relative to 
what they would be when using a treble G clef (F4 and C5 respectively) or 
using a bass F clef (A2 and E3 respectively). For five-line staves, therefore, 
when Use staff position is chosen, you can specify whether the staff positions 
are relative to a Treble G clef or a Bass F clef. 

When Use staff position is set, you can designate one octave of your MIDI 
keyboard to input playing techniques. By default, the Input techniques from MIDI 
key option is set to MIDI note 48, which is C3, the C one octave below middle C 

(C4 = MIDI note 60). You can click the MIDI learn  button and then play a note 
on your MIDI keyboard to change the starting pitch if you wish. 

Assuming a starting pitch of C3, ascending notes operate as follows: 

 C3 (48): Previous playing technique. 

 C♯3 (49): Next playing technique. 

 D3 (50): First mapped playing technique. 

 E♭3 (51): Second mapped playing technique. 

 E3 (52): Third mapped playing technique. 
 …and so on, until… 
 B3 (59): Tenth mapped playing technique. 

In general, it is recommended that you set Use staff position for percussion input: 
Use percussion map will normally be useful only when you are inputting onto a 
drum set and you have already memorized the General MIDI percussion map. 



 

 
Dorico Version History Page 28 Steinberg Media Technologies GmbH 

Note input for percussion. When inputting music on a percussion instrument using 
either the five-line staff or grid presentation type, the caret is smaller than when 
inputting music on a pitched instrument: instead of occupying the whole height of 
the staff, the caret is centered around a particular staff position, and can be moved 
up and down to different staff positions using the up and down arrow keys. Above 
the staff, directly above the rhythmic grid display, the name of the current 
percussion instrument and, if applicable, the current playing technique appears. 

You should make sure the appropriate playing technique is chosen before you 
input a note: if you are using alphabetic input, you can cycle through the playing 
techniques for the current instrument using Shift+Alt+up/down arrow; if you are 
using a MIDI keyboard, you can use the MIDI pitches defined in Preferences. 

If you later want to correct a playing technique after input, you can select the note 
and type Shift+Alt+up/down arrow to cycle through the playing techniques for the 
current instrument. On a five-line staff or grid, if you keep going in the same 
direction, once you have exhausted the playing techniques for the current 
instrument, the note will be moved to the next instrument in that direction (in other 
words, the next staff position on a five-line staff, or the next line on a grid). 

When inputting onto a percussion kit in either the grid or individual instruments 
presentation, you can type any note name A–G or play any MIDI note (outside of 
the octave designated for changing playing technique) to input onto the line 
corresponding to the caret’s current position. 

By contrast, when Use staff position is set in Preferences and inputting onto a 
five-line staff, you can type e.g. F to input a note on the F space or line. If you have 
the staff positions set relative to Treble G clef, then F could mean either the 
bottom space or the top line: in a standard drum set, this would mean either the 
kick drum (bottom space) or ride cymbal (top line). Dorico chooses the lower or 
upper possible staff position based on the current position of the caret: however, 
rather than choosing the staff position that is closest to the caret’s current position, 
instead Dorico chooses the staff position that will produce a note with the same 
stem direction as the last input note. 

Consider the case of inputting kick and snare drum notes on a standard drum set: 
the kick drum is on the bottom space, and the snare drum two spaces above, five 
staff positions away from the bottom space, and four staff positions away from the 
top line (ride cymbal). First, input kick drum by moving the caret towards the 
bottom of the drum set staff, and type or play F: now input snare drum by typing or 
playing C. Now play or type F again: instead of inputting a note for ride cymbal on 
the top line of the staff, Dorico inputs a note for kick drum on the bottom space. 
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This is because the kick drum uses the same stem direction (i.e. voice) as the 
snare drum. 

You can also input a note for the instrument and playing technique shown above 
the rhythmic grid, i.e. on the staff position currently occupied by the caret, by typing 
Y. This works on all three percussion kit presentation types. 

Articulations. When working in the grid or five-line staff presentation, you can add 
articulations in the same way as for other instruments, but be aware that any 
articulations you add will be set for all instruments who have notes at that rhythmic 
position in the shared voice that appears on the grid or five-line staff. For example, 
if you have both a snare drum and tom-tom note at the same rhythmic position, and 
add an accent, because both of these notes are shown in the same down-stem 
voice by default, the accent is actually added to both instruments: if you switch to 
the individual instruments presentation type, you will see the accent appear on both 
instruments. 

Tuplets. When working in the grid or five-line staff presentation, any tuplets you 
add will be added to all instruments who share the same voice. If you need to write 
a cross-rhythm for two instruments that normally share the same voice, you can 
switch to the individual instruments presentation type and input the independent 
rhythms on each instrument. When you switch back to the grid or five-line staff 
presentation, Dorico will do its best to resolve the conflicts: 

 If there are conflicting tuplets, one tuplet will be broken out into an extra voice 
for the duration of the conflict. 

 If there is a tuplet in one instrument and non-tuplet notes in another instrument, 
a non-tuplet note at the same position as the start of the tuplet and of any 
duration up to the total length of the tuplet will be displayed as if it were part of 
the tuplet, since the note onset is at the same position as the start of the tuplet, 
and hence will sound the same as the original notation. 

 If the non-tuplet notes in another instrument do not coincide with the start of the 
tuplet, or if there are further notes that start part-way through the tuplet, then the 
non-tuplet notes will be broken out into an extra voice for the duration of the 
conflict. 

Be aware that deleting a tuplet from a grid or five-line staff presentation will also 
delete the tuplet from all instruments whose notes contribute to the same shared 
voice. 

Crossing notes to other instruments. When using the five-line staff or grid 
presentation type, you cannot use the commands in the Edit ▸ Cross Staff 
submenu to cross notes to other instruments. You can, however, cross notes 
between percussion instruments when using the individual instruments 
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presentation type, or when a player is holding multiple individual percussion 
instruments that are not combined into a kit. 

Playing techniques. You can add playing techniques – such as + for closed and o 
for open hi-hat – in the same way as for other instruments using the Shift+P 
popover or the Playing Techniques panel in Write mode. Playing techniques are 
added only to the instrument to which the note you select belongs. 

Dynamics. Unlike other items, dynamics are not shared between the grid and five-
line staff presentation type and the individual instruments presentation type: any 
dynamics that you add to individual instruments will not appear when you switch to 
either of the other presentation types. Dynamics can therefore be added 
independently in the grid/five-line staff and individual instruments presentations. 

Percussion stickings. Dorico does not yet have a dedicated feature for showing 
percussion stickings, but you can use lyrics as a reasonable approximation in the 
meantime. Lyrics can be added either in the grid or five-line staff presentation by 
selecting a note in the instrument to which the stickings should apply, or by 
switching to the individual instruments presentation and inputting the lyrics directly 
on that instrument: when you switch back to the other presentation type, the lyrics 
will be shown on the grid or five-line staff. 

Staff labels. Staff labels for percussion instruments vary according to the 
presentation type: 

 Five-line staff: a single staff label will appear, using the full or abbreviated name 
defined at the top of the Edit Percussion Kit dialog. 

 Grid: each line in the grid will show its own smaller staff label, using the full or 
abbreviated name for the appropriate instrument, which can be edited by 
clicking Edit Names in the Edit Percussion Kit dialog. Adjacent instruments in 
the grid can be grouped, in which case a group label will appear centered 
vertically on the group. The group label can be edited in the main editing area of 
the Edit Percussion Kit dialog. 

 Single-line instruments: each instrument will show a full-size staff label, using 
the full or abbreviated name for the appropriate dialog. 

Smaller staff labels for each line in a grid presentation use the Staff labels 
(percussion grid) paragraph style, which can be edited in Engrave ▸ Paragraph 
Styles. 

Percussion legends. When using the five-line presentation type, it can be helpful to 
be able to show which instruments are represented on the staff, or to periodically 
remind the player which instruments are to be played. 
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To create a legend that shows all instruments in the five-line staff, select a note or 
other item on the staff at the position at which you want the legend to appear, and 
choose Edit ▸ Percussion ▸ Legend for All Instruments. The legend appears 
above the staff, listing the instruments in the order in which they appear in the five-
line staff, from highest staff position to lowest. 

To create a legend that shows only the instruments that are sounding at a 
particular position, select a single note or a range of notes in the staff, and choose 
Edit ▸ Percussion ▸ Legend for Sounding Instruments. The legend appears 
above the staff, and shows a circular handle at its right-hand extent: this can be 
dragged with the mouse, or the duration of the legend can be edited with 
Shift+Alt+left/right, to enlarge or reduce the range over which the instruments to 
be included in the legend should be considered. 

Using the new Percussion Legends group in the Properties panel, you can also 
change the Placement of the percussion legend to below the staff, or use 
abbreviated instrument names by activating Use short names. 

The font size and style of the percussion legend can be edited by editing the 
Percussion legend paragraph style in Engrave ▸ Paragraph Styles. 

Percussion legends appear as signposts if there are no instruments sounding at 
their position, or when using the grid or individual instruments presentation type. 
These signposts can be hidden or shown using View ▸ Signposts ▸ Percussion 
Legends. 

Percussion maps. Unpitched percussion instruments are played back using 
patches that map unpitched sounds onto different MIDI notes: for example, 
General MIDI percussion maps the bass drum onto C2 (MIDI note 36, two octaves 

below middle C), kick drum onto D2 (MIDI note 38), closed hi-hat onto F♯2 (MIDI 

note 42), and so on. The pitch required to produce a particular unpitched sound 
varies by device, sample library, manufacturer, etc., and has no connection to the 
position on a five-line staff that a percussion instrument might be using. 

To connect the written representation of notes and playing techniques for 
percussion instruments to what needs to be played back, Dorico uses percussion 
maps. A percussion map describes which unpitched percussion instruments and 
their playing techniques are present in a particular patch, and how to play them 
back: for example, which MIDI note to play, and optionally which other MIDI note 
should be used as a keyswitch to trigger a particular playing technique. 

A set of percussion maps for the unpitched percussion patches that are part of the 
HALion Symphonic Orchestra and HALion Sonic SE factory libraries are provided 
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with Dorico, and will be automatically chosen when you add percussion 
instruments to your project. 

However, if you want to use a third-party sound library or MIDI device, you will 
need to define one or more custom percussion maps in order to obtain correct 
playback. To get started, choose Play ▸ Percussion Maps: 

 

The list on the left shows all of the percussion maps that are present in the current 
project. Select one of the maps to show its contents in the main area of the dialog 
to the right, click + in the action bar to create a new empty map, or click Duplicate 
to create a copy of the selected map. 

The Percussion Map section on the right allows you to specify the display Name 
for the percussion map that appears in the Endpoint Setup dialog, which is where 
you tell Dorico which percussion map to use for which channel on your VST 
instrument or MIDI output device. You can set anything you like in the ID field. Set 
the option Map defines sounds for appropriately: 

 Multiple instruments: choose this if the patch for which you are creating a map 
contains many different percussion instruments; for example, the General MIDI 
drum map. 

 Individual instrument: choose this if the patch for which you are creating a 
map contains only a single percussion instrument, perhaps with multiple playing 
techniques for that instrument; for example, a snare drumline patch in Virtual 
Drumline or another specialist sample library. 
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The Drum Kit Note Map area lists all of the MIDI notes from 0 to 127, and allows 
you to specify which combination of unpitched instrument and playing technique is 
produced by each note. To add a new entry, first click Show all in the action bar at 
the bottom of the list of MIDI notes so that unmapped notes are shown. Select the 
row corresponding to the MIDI note for which you want to create a mapping. The 
Edit Drum Kit Note section at the bottom of the dialog allows you to specify the 
data for this MIDI note: 

 Name: the display name for the specific combination of instrument and 
technique; you may choose to input whatever name is used in the 
manufacturer’s documentation for your VST instrument or MIDI output device. 

 Instrument: click … to open a list of all of the unpitched percussion instruments 
you can create in Dorico: choose the appropriate instrument that corresponds 
to the sound produced by this MIDI note and click OK. 

 Techniques: click … to open a list of all of the playing techniques you can 
create in Dorico: choose the appropriate playing technique or techniques (you 
can use Ctrl+click or Command-click to make a multiple selection) that 
correspond to the specific sound produced by this MIDI note (for example, a 
roll, side stick or rim shot) and click OK. 

 Keyswitches: if this sound requires another MIDI note to be played to trigger 
this specific combination of instrument and playing technique(s), specify the 
MIDI note number of the keyswitch in this field. 

Repeat the process of selecting an unmapped MIDI note in the Drum Kit Note 
Map table and filling in the Edit Drum Kit Note fields for each one until you have 
created all of the required mappings. You can save your progress at any time by 
clicking OK to confirm the dialog, then saving your project as normal. 

Once you have created your percussion map, the final step is to tell Dorico to use 
it: in Play mode, click the  button for the VST instrument or MIDI device that 
provides the patch corresponding to the percussion map. In the Endpoint Setup 
dialog that opens, make the appropriate selection in the Percussion map column 
for the channel in which your percussion patch has been loaded. 
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Play mode. Unpitched percussion instruments are handled differently in Play mode 
than pitched instruments. Instead of showing the usual piano roll view, the onset of 
each note on each percussion instrument is shown, as follows: 

 

You can expand each instrument in a kit in the track header at the left-hand side in 
order to assign that particular instrument to another playback endpoint (for 
example, another channel on the same VST instrument or MIDI output device, or 
indeed to a completely different device if you wish). Be aware that the chosen 
endpoint must have an appropriate percussion map chosen, or Dorico will not 
know how to play that instrument’s music. 

Notes can be moved in Play mode by dragging them to the desired rhythmic 
position, but in the current release it is not possible to drag them from one 
percussion instrument to another, nor is it possible to change their duration within 
Play mode. These operations are planned for future releases. 

Percussion in imported MIDI files. When importing a MIDI file, Dorico will 
optionally interpret music for tracks set to use channel 10 as drum sets if the 
Interpret channel 10 as General MIDI percussion option is set in the MIDI 
Import Options dialog. This is the only condition under which Dorico will interpret 
any of the music in the MIDI file as percussion. 

Percussion in imported MusicXML files. There are a number of ways in which 
unpitched percussion music can be expressed in MusicXML, and different 
applications take different approaches to what data is exported, and how it is 
encoded. Results may vary considerably. 

Other scoring applications, and indeed MusicXML, have a different approach to 
how unpitched percussion music is represented: a drum set, for example, is 
effectively notated as pitched notes on a staff, and annotated with additional 
information to help identify which instrument corresponds to which staff position. 
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Dorico takes the reverse approach, instead explicitly identifying each instrument 
that is part of the kit, and then combining them dynamically onto a five-line staff. 
Mapping between the slightly fuzzy representation in MusicXML and the more 
explicit representation in Dorico can be challenging and employs heuristics to try to 
achieve a good result. 

Typically, drum set instruments in MusicXML files exported from both Sibelius and 
Finale will import quite cleanly. Results will be particularly good if the voicing of the 
drum set is consistent; for example, if the snare drum is consistently notated in a 
down-stem voice, this will help Dorico to identify and import it correctly. If the 
voicing changes from bar to bar, it is possible that some notes may be 
misidentified, or in extreme cases not import. 

Other kinds of percussion that are notated on a five-line staff will produce more 
variable results: Finale tends to include information about which percussion 
instrument maps onto each staff position, but Sibelius does not. As a result, you 
may find that Dorico chooses different instruments than you might expect, but you 
can easily change to the correct instruments using the Edit Percussion Kit dialog. 

Universal Indian Drum Notation. Dorico is the first scoring application to support 
the new Universal Indian Drum Notation system developed by Keda Music Ltd. 
Universal Indian Drum Notation has been designed primarily for tabla, but can also 
be applied to other Indian drums with two heads, such as nagara, dhol, dholak, 
mrindangam, and pakhawaj. 

 

For more information about Universal Indian Drum Notation, please visit 
www.keda.co.uk.   

http://www.keda.co.uk/


 

 
Dorico Version History Page 36 Steinberg Media Technologies GmbH 

Improvements 

Articulations 

The Horizontal position of staccato on stem side option in the Horizontal 
position section of the Articulations page of Engraving Options now contains a 
new choice: Half-centered. When Half-centered is chosen, a staccato 
articulation will be positioned halfway between the center of the stem and the 
center of the notehead. If any other articulation is also present, then all articulations 
will be positioned as normal. (STEAM-6519) 

Barlines 

A new option Maximum number of staff lines to use minimum barline 
protrusion has been added to the Barlines page of Engraving Options. Barlines 
for any set of percussion instruments shown as a grid that has fewer than the 
number of staff lines specified here will protrude beyond the outermost staff lines 
by the value of Minimum barline protrusion (which was previously called 
Minimum barline height for single-line staves). (STEAM-6827) 

Bar numbers 

Bar numbers below the staff. Bar numbers positioned below the staff and centered 
on the barline are now positioned inside dynamics by default. (STEAM-7086) 

First bar number. A new option Hide first bar number when shown every bar 
has been added to the Bar Numbers page of Layout Options. When switched on, 
the first bar number will not be shown if Show bar numbers is set to Every bar. 
(STEAM-7164) 

Chord symbols 

Modal chord symbols. Dorico now supports chord symbols that represent modes, 
including the church modes (Lydian, Dorian, Ionian, etc.), the whole-tone scale, and 
diminished or octatonic scales (either whole-half step or half-step whole versions). 
To input a modal chord symbol, you can type the following: 

 Ionian: ionian 
 Dorian: dorian 
 Phrygian: phrygian 
 Lydian: lydian 
 Mixolydian: mixolydian 
 Aeolian: aeolian 
 Locrian: locrian 
 Melodic minor: melodic minor 
 Harmonic minor: harmonic minor 
 Whole tone: whole tone 
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 Octatonic or diminished half-whole: diminished half whole, diminished 
semitone tone, octatonic half whole or octatonic semitone tone 

 Octatonic or diminished whole-half: diminished whole half, diminished tone 
semitone, octatonic whole half or octatonic tone semitone  

It is also possible to input these chord symbols using a MIDI keyboard, by playing 
all of the scale degrees including both the lower and upper root note. An option to 
determine whether Dorico should interpret such input as a modal chord symbol or 
as a regular chord symbol with quality, intervals, alterations etc. is found on the 
MIDI Input page of Note Input Options. 

A new Modal Chord Symbols section has been added to the Chord Symbols 
page of Engraving Options in which options are provided for whether the mode 
and scale names should be presented in title case or lower case. 

Editing chord symbol components. When editing an individual chord symbol in 
Engrave mode, or the default appearance of a chord symbol via the Project 
Default Chord Symbol Appearance dialog, it is now possible to directly edit both 
chord symbols in a polychord, or to edit the main chord symbol and altered bass in 
a chord symbol with an altered bass note, etc. When editing one of these 
components, a row of “breadcrumb” buttons directly above the editing area shows 
the current component being edited, and you can return to editing the top-level 
chord symbol by clicking the left-most breadcrumb. (STEAM-6832) 

Left-aligned chord symbols. A new option Horizontal offset when left-aligned 
has been added to the Chord Symbols page of Engraving Options, allowing you 
to specify that a left-aligned chord symbol should be offset a little to the left. 
(STEAM-7087) 

Appearance of root-only chord symbols. For a chord symbol that consists only of 
the root note, you can type e.g. Cbass or Gonly into the Shift+Q popover. For a 
chord symbol that is intended to act as a pedal note, you can type e.g. Fped into 
the popover. New options have been added to the Root section of the Chord 
Symbols page of Engraving Options to allow you to choose the exact appearance 
of pedal and root-only chord symbols. (STEAM-7090) 

Appearance of chords with no third. When choosing to show an omitted third as 
e.g. C5, Dorico will now correctly use either omit 3 or no 3 for chord symbols that 
contain higher scale degrees. For example, you will now see GMA9(omit 3) rather 
than the mildly nonsensical G5MA9. (STEAM-7091) 

Clefs 

Invisible clefs now show signposts, which can be hidden and shown by choosing 
View ▸ Signposts ▸ Clefs. (STEAM-6770) 
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Dynamics 

Alignment of text dynamics relative to the notehead. The Alignment of text 
dynamics relative to note option in the Horizontal Position section of the 
Dynamics page of Engraving Options has a new option: Align optical center with 
left-hand side of notehead. When chosen, this results in text dynamics being 
positioned slightly further left than when aligned with the center of the notehead. 
(STEAM-6911) 

Inputting combined dynamics via the popover. If you specify a particular separator 

when inputting a combined dynamic (such as -), the separator you type is now 

automatically set for the resulting dynamic. (STEAM-6772) 

Playback of gradual dynamics to and from niente. Dorico now correctly follows the 
Niente property in playback. (STEAM-6957) 

Engrave mode 

Frame selection. Hitting Return with a text or graphics frame body selected now 
behaves identically to double-clicking the frame body, i.e. opens the text editor or 
opens the file chooser to select the graphic to display respectively. (STEAM-6733) 

Filters 

Filter notes by pitch. A new Edit ▸ Filter ▸ Notes by Pitch dialog has been added, 
allowing you to either select or deselect notes of specific pitches. 

 

Choose the pitch of the note and the accidental from the drop-down menus, and 
click Add to add the pitch to the list of Pitches to filter. By default, the chosen 
pitch will be filtered in any octave, but if you want to filter only notes in a specific 
octave, activate in octave and specify the octave number using the spin box (C4 = 
middle C). You can choose whether or not the pitches should be filtered according 
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to their Written or Sounding pitch. To perform the filter, click either Select or 
Deselect. 

The list of pitches is preserved for each project during the session, so that you can 
easily repeat the filter operation. To remove one of the pitches from the Pitches to 
filter list, select the entry and click Remove Selected; alternatively, to clear the list 
altogether so you can start a new filter operation, click Clear. (STEAM-6929) 

Filtering all sharp or flat notes. In the Edit ▸ Filter submenu, two new commands 
All Sharp Notes and All Flat Notes have been added, which will select or 
deselect all sharp or flat notes. This may be useful in the event that you have 
imported a MIDI file and after changing the key signature, all of the accidentals are 
spelled incorrectly, allowing you to quickly select all sharp or flat notes in order to 
respell them. (STEAM-7197) 

Expanded filters for lyrics. A new Edit ▸ Filter ▸ Lyrics submenu has been added, 
allowing you to select or deselect lyrics with greater flexibility than before. It is now 
possible to filter lyrics above or below the staff separately, to filter chorus and 
translation lyrics separately, and to filter lyrics by line separately. By combining 
these operations, it is possible to select, for example, only the lyrics that make up 
the translation for line 2 above the staff. (STEAM-6909) 

Flows 

Export Flows dialog. The choices made in the File ▸ Export ▸ Audio, Flows, MIDI, 
and MusicXML dialogs – such as the folder to export to, which layouts to export, 
and so on – are now saved in the project, so that your choices are preserved 
through multiple export operations. (STEAM-6710) 

Importing flows. When importing flows from another Dorico project and choosing 
to merge the incoming players with the existing players in the destination project, 
player groups are also matched, so incoming players in groups will be merged with 
identical players in compatible groups. (STEAM-6683) 

Glissando lines 

It is now possible to edit the placement and length of glissando lines in Engrave 
mode. You can move between the handles by typing Tab, and move the selected 
handle by holding Alt and using the arrow keys (with Ctrl on Windows or 
Command on Mac for larger steps). The handles can also be dragged with the 
mouse. New properties for the position of each end of the glissando line are also 
found in the Glissando Lines group of the Properties panel. The position of an 
edited glissando line can be reset by choosing Edit ▸ Reset Position. (STEAM-
7101) 
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Importing MIDI files 

Import options dialog. When importing a MIDI file, a new MIDI Import Options 
dialog appears allowing you to make various decisions about how the MIDI file 
should be interpreted: 

 Interpret as General MIDI: when switched on, Dorico will use the program 
numbers specified by each track as a hint to determine which instruments to 
create. 

 Interpret channel 10 as General MIDI percussion: when switched on, Dorico 
will import any tracks that are set to channel 10 as drum set instruments. 

 Use split point for grand staff instruments: when switched on, any notes 
higher than the value specified for Split at MIDI note number will be notated 
on the right-hand staff, and any lower notes will be notated on the left-hand staff 
(MIDI note number 60 = middle C, or C4). (STEAM-6584) 

 Preserve note velocities: when switched on, the velocities of individual notes 
in the MIDI file will be preserved and played back in Dorico. There is currently no 
display of the velocity of individual notes in Play mode, so this option is switched 
off by default. If you import note velocities from a MIDI file and later want to 
remove them so that dynamics you input in Write mode will take effect in 
playback, use Play ▸ Reset Playback Overrides. 

 Preserve note positions: when switched on, any offsets to the start and end 
position of individual notes in the MIDI file will be preserved and played back in 
Dorico, so that the rhythmic feel of the original MIDI performance is retained. 
These adjustments can also be removed by way of Play ▸ Reset Playback 
Overrides. (STEAM-3887) 

Key signatures. Dorico now imports key signatures from MIDI files, if they are 
specified in the file to be imported. (STEAM-3195) 

Automatic transcription of MIDI files. Some further improvements to Dorico’s 
quantization algorithms have been made, improving the recognition of tuplet 
structures in imported MIDI files. (STEAM-6901, STEAM-4652) 

Type 0 MIDI files. Dorico can now import Type 0 MIDI files. (STEAM-6427) 

Track names. Players are now named according to the track in the imported MIDI 
file to which their instrument corresponds. (STEAM-7121) 

Importing MusicXML files 

Notehead types. Non-default notehead types are now imported from MusicXML 
files. (STEAM-6607) 
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MusicXML sound IDs. The default playback sound for a part in an imported 
MusicXML file, if specified, is now considered when determining what kind of 
instrument to create. (STEAM-4405) 

Instrument changes 

Editing instrument change labels. It is now possible to select the labels that appear 
to announce an imminent instrument change, and to mark the entry of the new 
instrument. These labels can be nudged with Alt+arrow keys or dragged with the 
mouse in Engrave mode to adjust their position; this is reflected in the values of the 
Offset X and Y properties in the Common group of the Properties panel. 

The text shown in the labels themselves can also be overridden by way of two new 
properties in the new Instrument Changes group in the Properties panel: 

 Activating Hide prefix will hide whatever prefix is specified on the Players page 
of Layout Options. 

 Custom text allows you to replace the name of the instrument with text of your 
choosing. To remove the name altogether, set the Custom text property to an 
empty string, i.e. one or more space characters. (STEAM-6599) 

Placement of instrument change labels. Instrument change labels are now placed 
outside text items above the staff by default. (STEAM-7125) 

Multi-bar rests 

Selecting multi-bar rests. It is now possible to select multi-bar rests in Write mode; 
in Engrave mode, the H-bar or bar rests and bar count number can be selected 
independently. When selected in Engrave mode, it is possible to adjust the width 
of an H-bar by way of the new H-bar width delta property in the new Multi-bar 
Rests group of the Properties panel: negative values make the H-bar narrower, 
while positive values make the H-bar wider. It is also possible to adjust the position 
of the bar count number by adjusting the new Bar count offset properties. 
(STEAM-6599) 

Single empty bars. Single empty bars will no longer be treated or spaced as multi-
bar rests if the Bar count for single bar rests option on the Rests page of 
Engraving Options is set to No bar count. (STEAM-7202) 

Noteheads 

Shape note or Sacred Harp notation. Dorico now supports the four most 
commonly-used systems for shape note or Sacred Harp notation, whereby each 
note is given a different notehead according to the degree of the scale to which it 
corresponds. To use shape notes, choose the desired system using the Shaped 
noteheads based on scale degree option in the Noteheads section of the Notes 
page of Engraving Options: 
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The Root scale degree for minor keys allows you to specify whether the root of 
the minor key or the root of the relative major key should be used to determine 
which shape of notehead is used for the root of the scale. The system in widest 
common use today, the Aikin 7-shape system, assumes the relative major key 
when determining which shape to use for the first degree of the minor scale. 

The choice of notehead shape is completely dynamic and automatic, and is 
updated as the music is input and edited. The only situation in which you may need 
to intervene is for unison notes in multiple voices that use a triangular notehead, 
such as the fourth degree of the scale in the Aikin 7-shape system. On an up-stem 
note, the triangle points left, while on a down-stem note, the triangle points right. 
Consequently, if these notes are on the same staff position, the noteheads 
tessellate to make a rectangle. In this situation, select the notehead belonging to 
the down-stem voice, and set it to be transparent using the Color property in the 
Common group of the Properties panel. 

During mouse input, the shadow note will show the correct notehead shape for the 
staff position under the mouse pointer. (STEAM-2178) 

Figurenotes© note colors. Figurenotes is a fixed system for coloring notes 
according to pitch (e.g. A = yellow, B = green, C = red, etc.) that is widely used in 
education, particularly for students with accessibility or special educational needs. 
To use Figurenotes colors in your project, choose the new Figurenotes© colors 
option on the Notes page of Engraving Options. (STEAM-7081) 

Stem positioning for noteheads. For noteheads that have non-zero side bearings – 
for example, noteheads bisected by slashes from top left to bottom right or from 
bottom left to top right – the position of stems relative to the noteheads has been 
improved. (STEAM-4970, STEAM-6608) 
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Note input 

Add intervals popover. A new command Write ▸ Add Intervals Popover has been 
added, with the default key command Shift+I. This popover makes much of the 
functionality provided by both the Add Notes Above or Below and the Transpose 
dialogs accessible directly via the keyboard. 

To use the popover, select the notes to which you want to add notes or transpose, 
then type Shift+I. The syntax is as follows: 

 To transpose rather than add notes above or below, begin your input with t. 
 Specify intervals using positive numbers to add notes above or transpose 

upwards, or using negative numbers to add notes below or transpose 
downwards, e.g. 3 adds a third above, while t-2 transposes downwards by a 
second. 

 If you do not otherwise specify it, the interval will be calculated by adding or 
transposing notes by the number of staff positions specified, e.g. in C major, if 
the selected note is a D natural and you specify 3 to add a third above, the 
added note will be an F natural. You can specify the quality of the interval by 
typing any of the following before the interval: 
o p, per, or perf for perfect 
o M, maj, or major for major 
o m, min, or minor for minor 
o D, dim, or diminished for diminished 
o a, aug, or augmented for augmented 
o diat or diatonic for diatonic 

 Following the interval number, you can type an ordinal suffix for e.g. 2nd or 5th if 
you wish, but this is not necessary. 

 To add multiple intervals in a single operation, separate them with a comma. For 
example, to add a third and a sixth above the selected notes, type 3,6. To add a 
third below and a third above, type 3,-3. 

 If the selected material already includes chords, notes will be added above the 
top note in the chord, and added below the bottom note in the chord. If you do 
want to add notes above or below all of the notes in the selected chords, add all 
or to all at the end of the input, e.g. M2,-m2 to all. 

 To add a note below the top note of a selected chord, type e.g. -3 top (which 
will add a third below the top note); to add a note above the bottom note of a 
selected chord, type e.g. aug4 bottom (which will add an augmented 4th above 
the bottom note). (STEAM-6395) 

Editing durations. A new Write ▸ Edit Duration submenu has been added in order 
to make the existing commands to lengthen and shorten selected notes and other 
items by the current rhythmic grid value or, in the case of non-note items, by the 
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amount that their durations would be snapped if dragged with the mouse. This 
submenu also includes two new items, Double Duration and Halve Duration, 
which will double and halve respectively the durations of selected notes. (STEAM-
6896) 

Furthermore, when changing the duration of the selected note immediately to the 
left of the caret during note input, the caret will now automatically track the end 
position of the note as it is lengthened or shortened.  

Rhythmic grid. Dotted 16th note (semiquaver) and 32nd note (demisemiquaver) 
have now been added as possible choices for the rhythmic grid resolution. 
(STEAM-6708) 

Moving the caret up or down. Ctrl+up arrow now moves the caret to the top staff 
of the system, and Ctrl+down to the bottom staff of the system. On a percussion 
kit or grid, Ctrl+up/down arrow move to the top or bottom staff position to which 
an instrument is mapped. (STEAM-7119) 

Enharmonic spelling in MIDI input. The spelling of the leading note in minor keys 
has now been improved. (STEAM-7094) 

Ornaments 

Trill stop lines. To indicate the exact position at which a trill should stop, you can 
show a vertical line on the right-hand end of the trill’s wavy continuation line by 
activating the new Show stop line property in the Trills group of the Properties 
panel. The length and width of the trill stop line can be controlled using new 
options found in the Trills section on the Ornaments page of Engraving Options. 
(STEAM-7168) 

Page layout 

Moving pages. When moving pages in the Pages panel in Engrave mode, master 
page changes and page number changes are now moved along with other kinds of 
overrides. (STEAM-6596) 

Pedal lines 

Splitting and merging pedal lines. Two new commands have been added to the 
Edit ▸ Pedal Lines submenu to split and merge pedal lines: 

 To split a pedal line but preserve the position of retakes, select the note at the 
position where you want the pedal line to be split, and choose Split Pedal Line. 

 To merge two or more pedal lines into a single pedal line, again preserving the 
position of retakes, select the pedal lines to be merged, and choose Merge 
Pedal Lines. (STEAM-6771) 
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Signposts. If a pedal line’s properties are set such that it will end up completely 
invisible, a signpost will be shown. You can choose whether or not to see these 
signposts via View ▸ Signposts ▸ Pedal Lines. (STEAM-6565) 

Playing techniques 

Dorico now shows the ID of the playing technique in the tool tip that appears when 
you hover over an item in the Playing Techniques panel in Write mode. This is 
helpful in working out what playing technique is actually produced for the purposes 
of writing a VST expression map. (STEAM-6773) 

Play mode 

Pencil and drumstick tools. New Pencil and Drumstick tools have been added to 
the toolbox in Play mode, allowing you to draw notes onto the piano roll editor and 
drum editor respectively.  

Playback of multiple flows. Navigating between flows during playback has been 
improved. If the playhead is already at the start of a flow, clicking the Rewind to 
Beginning button in the mini transport on the toolbar will now set the playhead 
position back to the start of the project. Further, when playback moves from one 
flow to the next, the event display in Play mode now updates automatically. 
(STEAM-5589, STEAM-6615) 

Print mode 

Print preview. It is now possible to choose between fitting the page width or the 
page height in the print preview, by clicking the Whole Page or Page Width button 
in the status bar at the bottom of the window. 

Selecting all layouts for printing. Typing Ctrl+A (Windows) or Command-A (Mac) 
in Print mode will now select all layouts in the Layouts panel. (STEAM-7124) 

Rehearsal marks 

Individual rehearsal marks can now display custom prefix or suffix text, by way of 
the new Prefix and Suffix properties in the Rehearsal Marks group of the 
Properties panel. (STEAM-6860) 

Rest grouping 

Rests in irregular time signatures. A new option Rests in bars with irregular beat 
lengths has been added to a new Irregular time signatures section on the Rest 
Grouping page of Notation Options. This option allows you to specify whether 
rests at the start of a bar with irregular beat lengths, such as 7/8 (which might be 
3+2+2/8 or 2+2+3/8, for example) should be consolidated into as few long rests 
as possible (Allow to cross beat subdivisions) or shown as a series of rests 
(Split at beat subdivisions). (STEAM-6491) 
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Scaling 

It is now possible to change the scale factor of practically every item in the score. 
You can choose between one of four predefined sizes, and specify a custom scale 
factor as a percentage of the prevailing size. 

To scale an item to one of the four predefined sizes, select the item and activate 
the Scale property in the Common group of Properties. The four sizes are: 

 Normal: sets the item to its normal size, or 100%, relative to the current rastral 
size. 

 Cue: sets the item to the size specified of the Cue note scale factor option on 
the Cues page of Engraving Options; by default, 75%. 

 Grace: sets the item to the size specified by the Grace note scale factor 
option on the Notes page of Engraving Options; by default, 66%. 

 Cue grace: applies the Cue note scale factor to the Grace note scale factor; 
by default, 75% of 66%, i.e. 49.5%. 

To scale an item by an arbitrary factor, activate the Custom scale property in the 
Common group of Properties. This scale factor is applied on top of the size 
resulting from the Scale property. For example, if an item is set to Cue size using 
the Scale property and you set the Custom scale property to 50%, the resulting 
size for the item will be 50% of 75%, i.e. 37.5% of normal size. 

Slurs 

Reset Appearance and Reset Position. The behavior of Edit ▸ Reset Appearance 
and Reset Position have been improved for slurs. Choosing Reset Appearance 
now resets the control points at either end of the slur to the appropriate values 
relative to the end points of the slur to produce the default shape; choosing Reset 
Position likewise retains the relative position of the slur’s control points. (STEAM-
6962) 

Staff labels 

Overriding staff label visibility. To override the Staff labels on first system and 
Staff labels on subsequent systems options on the Staves and Systems page 
of Layout Options, you can now choose whether full, abbreviated or no staff labels 
should be shown for a specific system: simply create a system break, select the 
system break signpost, and set the new Staff labels property to Full, Abbreviated 
or None as desired. (STEAM-6613) 

Displaying instrument pitch in staff labels. It is now possible to specify whether or 
not a particular instrument’s pitch should be shown as part of its staff labels. To 
edit an instrument’s name, expand the card of the player holding the instrument in 
question, hover over the name of the instrument so that the chevron > appears, 
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click the mouse button to show the context menu, and choose Edit Names. The 
new option Show transposition has three values, which interact with the Show 
instrument pitch in staff labels option on the Staves and Systems page of 
Layout Options: 

 Always: always include the instrument pitch in the staff label, even if Show 
instrument pitch in staff labels is switched off. 

 Follow Layout Options: show the instrument pitch if Show instrument pitch 
in staff labels is switched on, otherwise do not show it. 

 Never: never include the instrument pitch in the staff label, even if Show 
instrument pitch in staff labels is switched on. (STEAM-5634, STEAM-6828) 

In addition, you can now determine whether or not instrument pitch should be 
shown in full and abbreviated staff labels independently, by setting Show in full 
staff labels and Show in abbreviated staff labels as appropriate. (STEAM-7165) 

Stems 

Adjustment to the length of a note’s stem are now reset using Edit ▸ Reset 
Position rather than Reset Appearance, and it is also possible to reset the stem 
lengths of all the notes in a beamed group by selecting the beam line itself and 
choosing Reset Position. (STEAM-6960) 

Tempo 

Signposts for gradual tempo changes. Gradual tempo changes whose properties 
are set such that they are invisible (for example, they have an empty text property, 
and no continuation line) will now show a signpost. These signposts can be shown 
or hidden by choosing View ▸ Signposts ▸ Tempo. (STEAM-6554) 

Inputting parenthesized tempo markings. If you enter a metronome mark in 
parentheses in the Shift+T popover – for example, by typing Allegro (q=120) – 
Dorico will automatically set the Parenthesized property. (STEAM-6749) 

Text 

Empty text items will now show signposts by default. These signposts can be 
shown or hidden by choosing View ▸ Signposts ▸ Text. (STEAM-7073) 

Ties 

Laissez vibrer ties. It is now possible to show l.v. (laissez vibrer, or “let ring”) ties. 
Select the note to which you would like to add a tie, and activate the Laissez 
vibrer tie property in the Notes and Rests group of the Properties panel. Laissez 
vibrer ties are drawn by default at a minimum length, defined in the new Length 
section of the Ties page of Engraving Options. You may find that you need to 
adjust the shape and placement of such ties, which you can do in the normal way 
in Engrave mode. 
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Engraving Options. The Ties page of Engraving Options now contains a number of 
new options, including for the minimum length of ties, laissez vibrer ties, and ties at 
the start and end of cues. Options have also been added for the dash length and 
gap length for dashed ties, dot diameter and gap for dotted ties, stroke length and 
thickness for editorial ties. In total some 15 new options have been added. 

Time signatures 

Bar rest design in long time signatures. A new option Bar rest design in long 
time signatures has been added to the Rests page of Notation Options, allowing 
you to choose whether bars longer than a whole note (semibreve) in duration, e.g. 
in time signatures such as 4/2 or 2/1, should show a double whole note (breve) 
rest or a whole note (semibreve) rest as a bar rest. (STEAM-7012) 

Cut common time signatures. It is now possible to display other time signatures 
with half note (minim) denominators than 2/2 using the cut common sign. In 
modern usage, only 2/2 is shown using this sign, but in historical usage, the cut 
common sign was used for other half note (minim) denominator time signatures. 
Set the Common/cut common property in the Time Signatures group of 
Properties to use the cut common appearance. (STEAM-7100) 

Tuplets 

A new property Split notes at spanned barline has been added to the Tuplets 
group in the Properties panel. When a tuplet crosses a barline and is shown as a 
single tuplet bracket by way of the Spans barline property, when Split notes at 
spanned barline is set, any note within the tuplet that crosses the barline will be 
split with a tie at the barline. (STEAM-4738) 

User interface 

Measurement units. The Preferred unit of measurement option on the General 
page of Preferences is now more widely respected throughout the application, 
and also now includes the new unit of Centimeters (cm). Controls that previously 
required you to specify measurements in points now show you the measurement in 
your preferred unit, and in fact allow you to specify the measurement in any unit, by 
providing the appropriate suffix: 

 Points: pt 
 Millimeters: mm 
 Inches: in or " 
 Centimeters: cm 

The controls for page width, page height, space size, page and music frame 
margins on the Page Setup page of Layout Options now all accept this multi-
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format input, as do the various properties in the Frames group of the Properties 
panel in Engrave mode. (STEAM-6535) 

Key commands. The way that user-defined key commands are saved has been 
improved such that only those key commands added, changed or deleted by the 
user are saved. This means that any new or changed default key commands in a 
new Dorico update will be available to existing users without requiring them either 
to add them manually or reset their key commands and recreate their custom key 
commands from scratch. When running Dorico 1.2 for the first time, any existing 
user-edited key commands files are converted automatically to the new format, so 
all new default key commands should be available to all users. (STEAM-6813) 

Switching between counterpart layouts. A new Window ▸ Counterpart Layout 
command has been added, with the default key command W. This command 
switches between the full score layout and a part layout, based on the currently 
selected item. For example, if you are editing the full score layout and have 
selected a dynamic in the Violin 1 staff, pressing W will switch to the Violin 1 part 
layout; having switched to this part layout, press W again to switch back to the full 
score layout. (STEAM-6707) 

Go to Page. A new Edit ▸ Go To ▸ Go To Page dialog has been added, allowing 
you to navigate quickly to any page in the current layout. (STEAM-6622) 

Properties. A number of properties that used to include a checkbox in addition to 
the slide switch used to activate the property now use only the slide switch. 
Properties need to include a checkbox if it must be possible to set the property to 
be explicitly switched off, but some properties were incorrectly set up this way, 
including Grace note before barline; the properties for hiding articulations, chord 
symbols, bar numbers, and time signatures; and Parenthesized for dynamics. 
Furthermore, the Show intensity marking property has had its meaning reversed, 
and is now Hide intensity marking. (STEAM-6060) 

Templates. A new Jazz category has been added to the Hub window and the File 
▸ New from Template submenu, including jazz trio, jazz quartet, and big band 
templates. 

Recent projects. It is now possible to remove individual projects from the list of 
recent projects in the Hub window: simply right-click a selected project in the list 
and choose Remove from Recent Projects from the context menu that appears. 
(STEAM-6750) 

Project Info. New < and > buttons have been added to File ▸ Project Info to allow 
you to quickly move between the information for each flow. (STEAM-6755) 
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Options dialogs. The scroll position for each page of multi-page dialogs such as 
Engraving Options is now retained while the dialog remains open, so if you switch 
to a different page and return to the original page, Dorico will not automatically 
scroll back to the top of the original page. Once the dialog has been closed, all of 
the scroll positions are reset. (STEAM-7196) 

Performance 

Adding and removing players from layouts. Adding and removing players from 
layouts is now considerably faster than before. (STEAM-6704) 

Note input into open meter. The speed of note input at the end of a flow that ends 
with an open meter has been improved. (STEAM-6869) 

Opening complex dialogs. Opening complex multi-page dialogs, such as 
Engraving Options, is now practically instantaneous. (STEAM-6680) 

Projects with many staves. The speed of editing in projects with many staves has 
been improved. (STEAM-7022) 

Localization 

Choice of default page size. A new Default paper size type option has been 
added to the General page of Preferences, allowing you to choose whether to use 
International (otherwise known as ISO216, European, or metric paper sizes, such 
as A3, A4, and so on) or North American (such as Letter, Tabloid, etc.) page sizes 
by default when starting a new project. By default, this option is set to Automatic, 
which will use your computer’s locale or region settings to determine the default 
paper size type to use. (STEAM-6540) 

Order of pages in options dialogs. The pages in multi-page options dialogs, such 
as Engraving Options, are now correctly alphabetically sorted according to the 
user interface language, rather than according to their order in the English-
language version. (STEAM-6748)  
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Issues resolved 
ID # Component Issue 

STEAM-6686 Articulations 
Stem-side articulations on stemless notes (e.g. whole notes) no longer collide with single-
note tremolos. 

STEAM-6766 Articulations 
The options in the Ties section of the Articulations page of Engraving Options can now 
be set correctly through the user interface. 

STEAM-6767 Articulations 
Adjusting the Y offset of an articulation on a chain of tied notes now correctly applies the 
offset even if the end of the tie chain on which the articulation appears is overridden. 

STEAM-7133 Audio export 
Exporting audio to a UNC network path (e.g. of the form \\server\folder) now works 
correctly (Windows only). 

STEAM-6692 Bar numbers 
Bar numbers now correctly appear above the system as expected if the top instrument in 
the system uses a single staff line. 

STEAM-7037 Barlines 
Dashed barlines representing subdivisions in aggregate time signatures now appear 
correctly following an instrument change. 

STEAM-7030 Beams 
Selecting a note and an implicit rest and attempting to beam them together no longer 
sometimes results in a crash. 

STEAM-6612 
STEAM-6672 

Chord 
symbols 

Under some circumstances, the graphical chord symbol editors could show some 
components either as being deletable or non-deletable incorrectly. This has now been 
resolved. 

STEAM-6825 
Chord 
symbols 

In larger projects and/or on slower computers, clicking outside the chord symbol popover 
after typing a chord symbol could cause a crash. This has now been resolved. 

STEAM-6847 
Chord 
symbols 

Increasing the Y offset values in the graphical chord symbol editors now moves the 
selected component upwards, as expected. 

STEAM-6872 
Chord 
symbols 

Chord components that use graphics are now positioned correctly and stably. 

STEAM-6757 Diagnostics 
On the rare occasions when Dorico crashes on Mac, it will now leave the expected crash 
log behind in ~/Library/Logs/DiagnosticReports.  

STEAM-6788 Dynamics 
Properties that are set when creating dynamics by typing them into the popover (e.g. 
parenthesizing a dynamic) can now be correctly unset via the Properties panel. 

STEAM-6852 Dynamics 
Dragging the inflection point in the middle of a messa di voce dynamic now works reliably 
for grouped dynamics. 

STEAM-6910 Dynamics 
It is now possible to set the dash length and gap for gradual dynamics whose continuation 
lines are drawn dashed in the Properties panel. 

STEAM-7117 Dynamics 
Hidden dynamics now show signposts. The Hide dynamic intensity property now also 
always takes effect, rather than only when the custom prefix or suffix properties are set. 

STEAM-6679 
STEAM-6821 
STEAM-6915 

Flows 
The automatic generation of filenames when exporting flows and layouts either as Dorico 
projects, audio, or MusicXML has been improved, so that illegal characters are removed 
correctly and the filename does not end up extremely long. 

STEAM-6726 Flows 
Split Flow will no longer position notes and other rhythmic items after the split incorrectly if 
the position of the split was followed immediately by implicit rests and tuplets. 
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ID # Component Issue 

STEAM-6831 
Key 
signatures 

Inputting a key signature onto a single instrument by clicking it in the editor in the Key 
Signatures panel and holding Alt now works correctly. 

STEAM-6639 Lyrics 
When adjusting the horizontal position of lyrics to minimize distortion to the ideal rhythmic 
spacing, lyrics could sometimes be adjusted incorrectly such that they would touch. This 
has now been fixed. 

STEAM-6735 Lyrics The horizontal position of a hyphen at the start of the system can now always be adjusted. 

STEAM-6730 
Multi-bar 
rests 

Multi-bar rests that are too wide to fit at the end of the system at their ideal width no longer 
sometimes cause part of the multi-bar rest to extend incorrectly beyond the frame edge. 

STEAM-6824 
Multi-bar 
rests 

Under some circumstances, single bar rests drawn as multi-bar rests could cause too 
much music to be forced onto a system. This problem has now been resolved. 

STEAM-6344 Note input 
Under some circumstances, adding ties to existing notes entered with forced durations 
could cause their duration to be changed unexpectedly. This has now been resolved. 

STEAM-6497 Note input 
The enharmonic spelling of notes input from a MIDI keyboard has been further improved, 
particularly in minor keys. 

STEAM-6541 Note input 
Inputting a tied note using Force Durations no longer unnecessarily results in two distinct 
notes tied together, instead producing a single note with the appropriate properties to split 
it with ties at the desired position or positions. 

STEAM-6630 Note input 
Very long notes that have been split into chains of tied notes at positions that are no longer 
valid now have all such splits removed, in order to ensure that the note can be notated. 

STEAM-6656 Note input 
The option Notes starting in the middle of the beat ending at a beat boundary without 
crossing the half-bar on the Note Grouping page of Notation Options no longer 
incorrectly takes effect in time signatures that do not have a half-bar. 

STEAM-7270 Note input Mouse input onto single-line percussion instruments has been improved. 

STEAM-6720 Note spacing 
Under rare circumstances, enabling the note spacing tools in Engrave mode could cause 
Dorico to hang. This problem has now been resolved. 

STEAM-6789 Note spacing 
Using Alt+right arrow to nudge a grace note’s spacing column no longer incorrectly 
removes the entire spacing adjustment. 

STEAM-6477 Ornaments 
Glissando lines from grace notes that precede implicit rests will no longer be incorrectly 
removed if the implicit rest is made explicit. 

STEAM-7109 Ornaments 
A problem whereby adding a slur could cause a trill continuation line that started on a 
previous system not to appear has been resolved. 

STEAM-6513 Page layout 
A problem whereby systems could be spaced unevenly by default on some pages has 
been resolved. 

STEAM-6769 Page layout 
Single-line percussion instruments are no longer incorrectly treated by Dorico’s vertical 
spacing algorithms as if they have zero height. 

STEAM-5820 Performance 
Selecting items in projects with multiple flows is no longer sometimes significantly slower 
than it should be. 
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ID # Component Issue 

STEAM-6666 Performance The speed of inputting music into projects that use open meter has been improved. 

STEAM-7106 Performance 
Dorico now filters out System Exclusive MIDI messages sent by MIDI input devices, which 
could previously cause Dorico to become unresponsive. 

STEAM-4870 Play mode 
The order in which tracks appear in Play mode now always correctly reflects the order of 
the players in the current layout. 

STEAM-6925 Play mode 
The non-functional edit button in the VST Instruments panel has been removed, and the 
display of which plug-in is currently in focus or selected has been improved. 

STEAM-4736 Playback 
A problem whereby the playhead and time display in the Transport would stall during 
playback, which could subsequently cause the score display not to update correctly, has 
been fixed (Mac only). 

STEAM-4936 Playback Edits made to dynamics are now reflected immediately on playback. 

STEAM-6586 Playback 
Further fixes to the playback of relative tempo changes using a beat unit other than a 
quarter note (crotchet). 

STEAM-6947 Playback pizz. playing technique now plays back correctly at the start of the flow (Mac only). 

STEAM-7084 Playback When starting playback, the first note is no longer sometimes much quieter than normal. 

STEAM-6846 Project files 
Dorico can now correctly open project files saved in Microsoft OneDrive using the Files 
On-Demand feature (Windows only). 

STEAM-6388 
Rehearsal 
marks 

Rehearsal marks left-aligned with the systemic barline are no longer sometimes incorrectly 
vertically positioned. 

STEAM-6496 
Repeat 
endings 

When duplicating a flow, repeat endings are now duplicated correctly. 

STEAM-6514 Rests 
It is no longer sometimes impossible to unset the Rest position property on an explicit 
rest. 

STEAM-6553 Slurs 
Dragging a middle segment of a slur that crosses two or more system breaks in Engrave 
mode no longer causes a crash. 

STEAM-6590 Staff labels 
The size of staff labels is now correctly determined by the staff size in use at the start of the 
system, including a size change set by way of a system break. 

STEAM-6899 Staff labels 
Changes to the Staff labels paragraph style will now automatically update all staff labels 
correctly without requiring you to switch to another layout. 

STEAM-5220 Text 
The point size shown in the text editor popover no longer varies depending on the current 
zoom level. 

STEAM-6402 Text 
A paragraph style and a font style set to the same point size now draw at precisely the 
same size. 

STEAM-6687 Text 
Using Reset Position on a text item no longer also incorrectly removes any overridden 
formatting. 
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ID # Component Issue 

STEAM-6906 Text 
The Relative size control in the Character Style dialog no longer always incorrectly 
shows zero, rather than the chosen size. 

STEAM-6907 Text 
Changing the size of a character style after using that character style in one or more text 
items in the score will now update those text items correctly. 

STEAM-7037 
Time 
signatures 

Dashed bar divisions in aggregate time signatures now draw correctly following an 
instrument change. 

STEAM-7162 Tremolos 
Dragging a single-note tremolo on a down-stem note in Engrave mode no longer drags the 
tremolo stroke in the wrong direction. 

STEAM-6870 Tuplets The positioning of the tuplet ratio digit for duplets has been improved. 

STEAM-6914 Tuplets 
Deleting the final note from a tuplet at the end of a flow in open meter no longer causes the 
music at the end of the flow to be drawn incorrectly. 

STEAM-6914 Tuplets 
Deleting the final note from a tuplet at the end of the flow in open meter now correctly 
updates the flow. 

STEAM-7060 Tuplets The horizontal position of tuplet ratios for tuplets without brackets has been improved. 

STEAM-6426 
Undo and 
redo 

Some complex operations would not redo correctly after being undone, or would not leave 
the expected items selected. These problems have now been resolved. 

STEAM-5517 User interface 
The Up/Down buttons in the Transpose dialog are now correctly enabled when No. of 
octaves is set to anything greater than zero. 

STEAM-5699 User interface 
Under certain circumstances, changing between page and galley view when there is no 
selection can now keep the same area of music in view. 

STEAM-6501 User interface 
The order of the Hub and Help menus has been swapped, so that Help is the right-most 
menu. 

STEAM-6665 User interface 
When a spin control in Properties has an inconsistent value, it is now possible to set a 
consistent value using the keyboard rather than only by clicking the paddle buttons. 

STEAM-6774 User interface 
The context menu for adding players to layouts no longer incorrectly shows the names of 
player groups instead of the names of players. 

STEAM-6816 User interface 
Under some circumstances, changing page in the Layout Options dialog would ask you to 
apply unsaved changes, even when no changes had been made. This has now been fixed. 

STEAM-6823 User interface 
Various horizontal alignment properties no longer incorrectly show a non-functional 
Justified option value. 

STEAM-6927 User interface 
The Can slope property for tuplets has been replaced with a simple Force horizontal 
property, which more closely reflects its actual behavior. 

STEAM-7056 User interface 
Under some circumstances, making an edit after closing one window for the current 
project could cause a crash. This problem has now been fixed. 

STEAM-7116 User interface 
The Reset to Factory buttons in the Engraving Options, Notation Options, Playback 
Options and Note Input Options dialogs all now correctly restore factory settings. 
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Dorico 1.1.10 

August 2017 

This version contains the following improvements and issue resolutions. 

Improvements 

Chord symbols 

If you need to customize the appearance of chord symbols above and beyond the 
dozens of options provided in Engraving Options – for example, if you need to 
tighten the spacing of one or two chord symbols in a passage with rapid changes 
of harmony, or if you want to use a particular convention that is not directly 
supported – you can now both edit how a specific chord symbol should look by 
default in your project (and save this as the default for future projects) and override 
the appearance of an individual chord symbol. 

Before you start editing chord symbols with either of these graphical editors, do 
take the time to check that the appearance you want is not achievable via 
Engraving Options: if it is, then changing a couple of options there will save you a 
lot of time. 

Changing the default appearance of a chord symbol in your project. To adjust the 
appearance of all instances of a specific kind of chord symbol in your project, click 
the Edit button in the Project Default Appearances section at the bottom of the 
Chord Symbols page of Engraving Options to open the Project Default Chord 
Symbol Appearances dialog. 
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On the left-hand side of the dialog are two lists of chord symbols: Project Default 
Appearances lists the chord symbols whose default appearance has been 
overridden in the project; and Single Overrides lists the individual chord symbols 
that have been edited. 

To change the default appearance of a particular chord symbol so that it will 
appear exactly as you wish whenever you create it, specify it by typing into the box 
at the top left-hand corner of the dialog and click the + button, which adds it to the 
Project Default Appearances list.  

If you have overridden the appearance of an individual chord symbol in your 
project, you can promote that override to become a default for new chord symbols 

in your project by selecting it in the Single Overrides list and click the  button. 
Selecting a chord symbol in the Single Overrides list will show it on the right-hand 
side of the dialog, but you will not be able to edit it from here: to edit it without 
promoting it to becoming the default appearance for that chord symbol in your 
project, instead leave this dialog and double-click the chord symbol in Engrave 
mode. 

To save the chord symbols in the Project Default Appearances list such that they 
will become the default appearances for those chord symbols in newly-created 
projects, click the Save as Default button at the bottom left-hand corner of the 
dialog. 

If you have made edits since opening your project but you want to return to your 
previous saved defaults, click Reset to Saved Defaults. If you do not have any 
saved defaults, the button will instead read Reset to Factory, and clicking this will 
remove all user-saved defaults. 

If you hold Ctrl (Windows) or Alt (Mac), the Save as Default button will change to 
Remove Saved Defaults if you have previously saved some default chord symbol 
appearances; likewise, the Reset to Saved Defaults button will change to Reset 
to Factory. 

The controls in the right-hand side of the dialog for editing chord symbols are 
common to editing default chord symbol appearances and overriding individual 
chord symbols, and are described below. 

Editing the appearance of individual chord symbols. To adjust the appearance of 
an individual chord symbol, switch to Engrave mode and double-click the chord 
symbol. In the dialog that appears, you can make fine adjustments to the position 
and size of the individual components that comprise the chord symbol. 
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The large editing area can be zoomed in and out using the slider directly below; 
you can click on each component of the chord symbol (e.g. root, root accidental, 
quality, interval, alterations, etc.), or use the Previous/Next buttons to change the 
selection, or use the left and right arrow keys to change the selection. 

When a component is selected, you can adjust its position relative to the 
component to its left either by clicking and dragging with the mouse, or using the X 
offset and Y offset controls, or holding Alt and using the arrow keys. Notice that 
any components to the right of the component you have selected also move: this is 
because the components are attached to each other, to ensure a good layout 
when using a different font. 

You can also adjust the relative size of each component by adjusting the Scale 
value, or by dragging the handle at the top right-hand corner of the border around 
the selected component. 

You can also substitute the selected component with other compatible 

components (e.g. replace maj7 with ) by clicking another component from the 

row of alternative components at the bottom of the dialog. 

When you override the appearance of an individual chord symbol, all of the 
components in the chord symbol are duplicated so that any edits you make to 
these components in the Project Default Chord Symbol Appearance dialog or 
edits you make in Engraving Options will not affect the overridden chord symbol. 
Components that exist either because you have created them or because they are 
used by an overridden chord symbol appear with a red triangle in the top corner in 
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the row of alternative components. Components that are not currently in use by any 
chord symbol in the project also show a delete icon: clicking this will delete the 
component from the project. 

In the Project Default Chord Symbol Appearance dialog, if you want to change 
the default appearance of a given individual component (e.g. maj7) such that it will 
be changed for all chord symbols in the current project, select it in the list of 
compatible components, and click the pencil icon to edit it. Any changes you make 
to this component will be reflected in all chord symbols that use it. 

If you would instead like to create a new component based on a current one, for 
example for use in a single chord symbol that is in a particularly tightly-spaced 
passage, then click the + button to create a new component based on the 
selected one. This new component will then be used only in the current chord 
symbol. 

 

When editing an individual component, you can add any glyph from any font 
installed on your computer, add a string of text, include a graphic (SVG format is 
recommended, to ensure optimal appearance when printed or exported to a 
graphics format), or even use one of the existing symbols used elsewhere in 
Dorico, in any combination. 

The relative positioning of each sub-component you add in this dialog is 
determined by the Attachment from and Attachment to menus below the large 
editor: for example, if you attach the bottom right-hand corner of one sub-
component to the top left-hand corner of the next, then X offset and Y offset of 
zero will result in the bottom right-hand corner of the first attachment touching the 
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top left-hand corner of the second. When using text or glyphs, it is recommended 
to attach the Baseline Right attachment of the left-hand component to the 
Baseline Left attachment of the right-hand component to ensure sensible default 
positioning. 

Resetting the appearance of edited chord symbols. To reset a chord symbol you 
have edited in Engrave mode back to its default appearance as specified by the 
current settings in Engraving Options, select the chord symbol and choose Edit ▸  
Reset Appearance. 

Showing chord symbols above the top staff. By default, chord symbols appear 
above the staves belonging to the players whose instruments are set to show 
chord symbols, which you can determine by right-clicking on a player’s card in the 
Players panel in Setup mode and choosing the desired option from the Chord 
Symbols submenu in the context menu. In some types of scores, however, such as 
piano-vocal pieces, it is instead desirable to show chord symbols above the top 
staff, whatever it happens to be on each system (because e.g. the vocal line may 
be hidden during an intro or instrumental break). To allow this, a new option has 
been added to the Staves and Systems page of Layout Options that allows you 
to choose between showing chord symbols Above specific players’ staves (the 
default) or Above top staff of system. (STEAM-6449) 

Transposing chord symbols. Write ▸  Transpose includes a new option, Keep 
chord symbol appearance overrides, switched off by default. A chord symbol 
with an overridden appearance cannot be transposed, so you can choose either to 
retain the overridden appearance, or you can choose to reset its appearance so 
that it can be correctly transposed. (STEAM-6406) 

Successive identical chord symbols with altered bass notes. When Dorico hides 
the part of the chord symbol before the altered bass note for a series of chord 
symbols that differ only by their altered bass notes, it now takes notice of whether a 
chord symbol is hidden, so a hidden chord symbol within the range for which only 
the altered bass note should be shown will be ignored. It is also now possible to 
set the Hide root and quality property independently for chord symbols on 
different staves. (STEAM-6404) 

Signposts for chord symbols. If the chord symbol visibility settings for the players in 
the layout are set such that chord symbols do not appear on any staff, signposts 
are now shown above the top staff. (STEAM-6524) 

Selecting chord symbols. In common with other system-attached items, chord 
symbols are no longer selected when clicking or Shift+clicking in the staff. Chord 
symbols can be selected via marquee selection or via Edit ▸ Select All (and can be 
filtered in or out of the selection as usual). (STEAM-6605) 
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Dynamics 

The special bold italic letters for immediate dynamics, combined dynamics, and 
dynamics of force all now use a new dedicated font style, Dynamic music text 
font, in new projects, allowing you to change the font used for dynamics 
independently of the main music font. (STEAM-6479) 

Example projects (STEAM-6543) 

Several example projects are now included with Dorico. When you run the 
application for the first time, the example projects will appear in the list of recent 
projects in the Steinberg Hub window. If you would like to open any of the example 
projects but they do not appear in the list of recent projects, you can find them 
here: 

 Windows: C:\Users\Public\Documents\Dorico Example Projects 
 Mac: /Users/Shared/Dorico Example Projects 

Flows 

Importing flows from MIDI and MusicXML files. When importing flows from MIDI 
and MusicXML files that do not specify a title, the title of the new flow will be based 
on the filename of the imported file, rather than the default “Flow 1”. (STEAM-
6600) 

Navigating between flows. Selecting a flow in the Flows panel in Setup mode now 
navigates to the first bar of that flow. (STEAM-6621) 

Importing MIDI files 

 Tempo events are now imported when importing MIDI files. (STEAM-6429) 
 When mapping a track in a MIDI file onto a transposing instrument, Dorico now 

prefers the most common transposition for that instrument (e.g. Clarinet in B 
rather than Clarinet in A). (STEAM-6589) 

Pedal lines 

A new option Case for full text at start and end of line has been added to the 
Una Corda Pedal group of the Design section of the Pedal Lines page of 
Engraving Options, allowing you to choose between using title case, sentence 
case, or lower case for the una corda and tre corde text at the start and end of an 
una corda pedal line. (STEAM-6445) 

Playback 

Marcato articulations. It is now possible to edit the default playback duration of 
marcato articulations on the Timings page of Play ▸  Playback Options. (STEAM-
6448) 
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Gradual tempo changes. It is now possible to set the Final tempo % property for 
gradual tempo changes, allowing you to specify the amount by which the tempo 
should change. (STEAM-6474) 

Repeat endings 

Showing repeat endings below the bottom staff of the system. To show repeat 
endings below the bottom staff of the system in addition to showing them above 
the top staff of the system and the other staves specified on the Staves and 
Systems page of Layout Options, switch on the new option Additionally show 
repeat endings below bottom staff. (STEAM-6466) 

Setting times played for the final segment. It is now possible for the final segment 
of a repeat ending to not be the final one played: for example, if the first segment 
should be played on the first and third times through, with a jump to another part of 
the score at the end of the third time, and the second segment should be played 
only on the second time through, you can now show 1.3. in the first segment and 2. 
in the second segment. (STEAM-6419) 

Tempo 

It is now possible to type a tempo range into the Shift+T popover, e.g. q=100-
120, and Dorico will automatically display the tempo range correctly. (STEAM-
6555) 

Vertical spacing 

A new option Justify staves when frame with single system is above this 
threshold has been added to the Vertical Justification group on the Vertical 
Spacing page of Layout Options. 

If you have a score that only has one system per page on most systems (e.g. an 
orchestral score), then it is desirable to justify the distances between staves within 
the system as there won’t ever be any space between systems. However, if you 
have a score that mostly has more than one system per page but occasionally has 
only one (e.g. a small chamber group), then it can look strange if the distances 
between staves are justified on some pages but not others, simply because the 
page happens to cross the threshold specified for Justify distance between 
staves and systems when page is at least n% full. 

If you are working on such a score that sometimes shows one and sometimes 
shows two systems per page, try switching off the new Justify staves when frame 
with single system is above this threshold option as you may find this produces 
a more consistent justification throughout the project. (STEAM-6476) 
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Issues resolved 
ID # Component Issue 

STEAM-6465 Audio export The choice between exporting in WAV or MP3 format has been reinstated. 

STEAM-6619 Audio export Only those flows selected for export in the Audio Export dialog will now be exported. 

STEAM-6455 
Brackets and 
braces 

When using the Wind band bracketing approach, system objects now once again appear 
only above the first bracket for a given family. 

STEAM-6407 
Chord 
symbols 

Chord symbols are no longer incorrectly transposed by edits made in Write ▸  Add Notes 
Above or Below. 

STEAM-6425 
Chord 
symbols 

Polychords with stacked alterations on both the upper and lower chord now show the 
correct stack of alterations on both chords. 

STEAM-6434 
STEAM-6507 

Chord 
symbols 

Chord symbols now correctly appear selected after creation via the popover, and after 
operations like moving a multiple selection. Other instances of the same chord symbol on 
other staves are also now drawn in blue to indicate that they are linked.  

STEAM-6459 
Chord 
symbols 

Chord symbols are now correctly auditioned when selected, provided the chord track is 
routed to an appropriate output in Play mode (Mac only). 

STEAM-6262 Dynamics 
The behavior of dragging dynamics to grace note positions in Write mode has been 
improved. 

STEAM-6408 Dynamics 
Dragging the start handle of a hairpin in Write mode now correctly adjusts the duration of 
the hairpin, rather than moving the entire item. 

STEAM-6409 Dynamics 
When pasting dynamics at the same rhythmic position as dynamics on another staff, they 
will now only be linked if their properties are equivalent. 

STEAM-6435 Dynamics 
Setting the aperture of a hairpin to 0 could under rare circumstances cause a crash. This 
problem has now been resolved. 

STEAM-6438 Dynamics 
It is now possible to create a hairpin by clicking and dragging it when it starts at the same 
position as an existing immediate dynamic. 

STEAM-6487 Dynamics 
Pasting part of a dynamic group no longer incorrectly offsets the position of subsequent 
dynamics in other groups. 

STEAM-6569 Dynamics 
Adjusting the prefix or suffix of an immediate dynamic now updates the rhythmic spacing 
immediately. 

STEAM-6663 Dynamics Cutting part of a dynamic group to the clipboard no longer pastes in the wrong position. 

STEAM-6685 
Engrave 
mode 

If a stem is dragged to the opposite side of the note in Engrave mode, when you stop 
dragging, the handle now draws at the end of the stem. 

STEAM-6530 Flows 
Using Split Flow or Duplicate Flow in a project with one or more empty-handed players 
(i.e. players with no instruments assigned) will no longer cause the project to be corrupted 
and unable to be reopened. 

STEAM-6628 Flows 
Multiple flows with the same name can now be exported correctly via the Export Flows 
dialog. 
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ID # Component Issue 

STEAM-6652 Flows Split Flow now works correctly for music that includes notes crossed to different staves. 

STEAM-6662 Flows 
Exporting flows is now more resilient to invalid characters in the names of flows and layouts 
in the project. 

STEAM-6682 Flows 
Dynamics of force (e.g. sffz) are now correctly imported when importing a flow from 
another Dorico project. 

STEAM-6512 
Instrument 
changes 

Under rare circumstances, the letter case of instrument change labels could change 
unpredictably when opening the project. This problem has now been resolved. 

STEAM-5938 
Key 
signatures 

Tonality systems saved as defaults for new projects now work correctly in new projects. 

STEAM-6448 
Key 
signatures 

Edits made in the Edit Tonality Systems dialog are now properly undoable. 

STEAM-6453 
Key 
signatures 

Signposts for key signatures on transposing instruments that don’t show key signatures 
now correctly include the accidental in the key signature root if necessary. 

STEAM-6629 
Key 
signatures 

Key signatures in user-defined tonality systems that do not use any accidentals now show 
a signpost that reads Custom. 

STEAM-6446 Localization 
The names of accidentals in the Interval Calculator in Write ▸  Transpose are now 
correctly translated. 

STEAM-6462 Localization 
A number of inconsistencies between the default key commands in the localized versions 
of Dorico have been resolved. 

STEAM-6440 
Multi-bar 
rests 

Multi-bar rests are once again correctly split in layouts with instrument changes. 

STEAM-6480 
Multi-bar 
rests 

Multi-bar rests at the end of the system will no longer cause grace notes at the start of the 
next system to be drawn incorrectly. 

STEAM-6486 
Multi-bar 
rests 

System objects (such as tempo and rehearsal marks) no longer have a different horizontal 
position relative to the start of the bar when coinciding with the start of a multi-bar rest. 

STEAM-6443 
MusicXML 
import 

Dorico will no longer crash when attempting to import a MusicXML file with an incorrectly 
positioned time signature. 

STEAM-6659 
MusicXML 
import 

Dorico can now correctly open MusicXML files (and files of other types) whose extensions 
are not in lower case. 

STEAM-6675 
MusicXML 
import 

Chord symbols in MusicXML files whose position is specified using the offset element are 
now imported at the correct positions. 

STEAM-6488 
Note 
grouping 

A syncopated pattern of short-n x long-short notes can now span an entire bar of 12/8. 

STEAM-5102 Note input The behavior of deleting bars when tuplets cross barlines has been improved. 

STEAM-6431 
STEAM-6432 

Note input 
When inputting using a MIDI keyboard and the option to allow Dorico to retrospectively 
change the spelling of notes is set, the produced spellings have been improved in a 
number of situations. 
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ID # Component Issue 

STEAM-6437 Note input 
Certain edits, such as pasting or changing voice, that involved setting two or more 
properties on a note would not always cause the display of the score to be updated 
correctly until another edit was made. This problem has now been resolved. 

STEAM-6495 Note input 
Copying and pasting ornaments and playing techniques from one project to another now 
always ensures that the pasted ornaments and playing techniques appear correctly. 

STEAM-6525 Note input 
When starting a new voice, the choice of octave now always uses the clef’s hot spot to 
determine the octave of the new note, rather than the octave of the previously active voice. 

STEAM-6496 Note spacing 
Note spacing adjustments made in Engrave mode on columns that do not contain notes, 
e.g. for a hairpin that does not start at the start of a note, are now applied correctly. 

STEAM-6454 Notes 
Rhythm dots on stem-down split stem cluster chords no longer sometimes collide with the 
noteheads. 

STEAM-6587 Notes 
When multiple rhythm dots have to be shifted vertically in multi-voice situations, dots are 
no longer shifted if they can stay in their default position without colliding with another dot. 

STEAM-6447 Options 
Clicking Save as Default in the Notation Options and Layout Options dialogs now 
correctly updates the respective options for newly-created flows and layouts in the current 
project, as well as new projects. 

STEAM-6151 Page layout 
Lock System and Lock Frame now work correctly once again when invoked with a 
selection of a single item. 

STEAM-6414 Pedal lines 
Different types of pedal lines (e.g. sustain and una corda) at the same rhythmic positions 
are now spaced independently. 

STEAM-6617 Pedal lines 
Pedal lines now draw correctly when one staff of a grand staff instrument is hidden 
because it is empty. 

 Performance 
Projects containing many chord symbols should both open more quickly and respond to 
certain large edits (such as changing Layout Options or Engraving Options) more 
quickly. 

STEAM-6456 Performance Edit ▸  Select All is no longer very slow when View ▸  Attachment Lines is switched on. 

STEAM-6464 Performance The speed of opening projects has been improved. 

STEAM-6415 Play mode 
A note selected in Write mode is now immediately editable when switching to Play mode, 
rather than requiring you to first reselect it. 

STEAM-6436 Play mode 
The chord symbol track and playing technique lanes no longer disappear when expanding 
and collapsing tracks in Play mode. 

STEAM-6444 Playback 
Adding an accent to a note played pizzicato will no longer cause that note to be played 
back arco. 

STEAM-6457 Playback 
Successive grace notes of the same pitch now play back correctly, without cutting each 
other off. 

STEAM-6458 Playback 
Using undo after changing the settings in Playback Options no longer sometimes causes 
a crash. 
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ID # Component Issue 

STEAM-6463 Playback 
Some of the GM patches in HALion Sonic SE 2 were set to use the wrong VST 
Expression Map by default and would not play back. This problem has been resolved. 

STEAM-6586 
STEAM-6645 

Playback 
Relative and gradual tempo changes now correctly take into account the beat unit of the 
prevailing tempo. 

STEAM-6604 Playback 
Instruments that use note velocity for dynamics now correctly respond to changes to the 
Dynamic curve setting on the Dynamics page of Playback Options. 

STEAM-6450 
Repeat 
endings 

Dorico no longer crashes when you create a repeat ending that crosses one or more 
instrument changes. 

STEAM-6489 
Repeat 
endings 

The last segment of a repeat ending line with the Open, short appearance now correctly 
obeys the end X offset specified in Properties. 

STEAM-6676 
Repeat 
endings 

It is now possible to set properties on segments of repeat ending lines that span 
instrument changes. 

STEAM-6365 Rests 
Double whole note (breve) rests are now correctly positioned relative to a single-line 
percussion staff. 

STEAM-6485 
Time 
signatures 

Setting the Hide time signature property now applies to all layouts. This will not affect 
existing projects in which the property is already set: select the time signature and use Edit 
▸ Reset Appearance to unset the property, and then set it again to make it take effect in 
all layouts. 

STEAM-6473 Tuplets 
Choosing the light weight for tuplet numbers on the Tuplets page of Engraving Options 
once again produces the expected numbers, rather than apparently random characters. 

STEAM-5825 User interface 
Under some circumstances, opening a project that was saved using one of the zoom levels 
that fits the page width or height in the viewport could crash. This has now been fixed. 

STEAM-6442 User interface Clicking outside a popover now correctly dismisses the popover once more. 

STEAM-6523 User interface 
The Save as Default button in Layout Options is now correctly enabled only when the 
right kind of layout is selected, and only one such layout is selected. 

STEAM-6536 User interface 
The page margin controls no longer incorrectly disappear when returning to the Page 
Setup page from another page of the Layout Options dialog. 

STEAM-6625 User interface 
Under some circumstances, closing a document window via the close button in the title 
bar when a popover is open could cause a crash. This problem has been resolved. 

STEAM-6502 
Vertical 
spacing 

The distances between systems no longer change unexpectedly for systems that contain 
staves with instrument changes. 

STEAM-6513 
Vertical 
spacing 

A problem whereby systems could be unevenly justified, causing them to end up too close 
to the system above or below, has been resolved. The appearance of projects affected by 
this problem will be changed when opening them in Dorico 1.1.10. 
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Dorico 1.1 

June 2017 

This version contains the following improvements and issue resolutions. 

New features 

Chord symbols 

Creating chord symbols. To create a chord symbol, select the note or rest where 
you want the first chord symbol to appear, and choose Write ▸  Create Chord 

Symbol, or use the key command Shift+Q, or click the  button in the right-
hand toolbox in Write mode. 

The chord symbol popover will appear, into which you can type the desired chord 
symbol using the computer keyboard, or play it using your MIDI keyboard. 

Inputting chord symbols using the computer keyboard. Chord symbols consist of a 
root, quality, optional interval, optional alterations, and optional altered bass note. 
Each of these elements can be entered in the popover as follows: 

 Root: English note names (e.g. C, Db, F#, B); German note names (e.g. C, Des, 
Fis, H); fixed-do solfège (e.g. do, reb, so#, ti); Nashville numbers representing 
scale degrees (e.g. assuming C major, 1, 2b, 4#, 7). 

 Quality: major can be specified by typing nothing following the root, or by 
typing maj, M, or ma; minor can be typed as m, min, or mi; diminished can be 
typed as dim, di, or o; augmented can be typed as aug, au, ag, or +; half-
diminished can be typed as half-dim, halfdim, or hd; 6/9 can be typed as 6/9, 
69, or %. 

 Interval: chords with extensions and major seventh can be typed as e.g. ^7, 
^9, etc. (^ on its own is interpreted as major seventh). You can also type e.g. 
maj9 or 9maj7 for chords with extensions beyond the major seventh. 

 Alterations: alterations can be typed as e.g. #5, b9, etc.; added notes can be 
typed as e.g. add#11 or addF#; suspensions can be typed as e.g. sus4; 
omissions can be typed as omit3, no7, etc. 

 Altered bass notes: these can be specified in the same way as root notes, 
separated from the preceding main chord symbol by typing /, e.g. Cm7b5/Eb. 

The specific shorthand you use in the popover to create the chord symbol does not 
directly influence the precise appearance of the resulting chord symbol: this is 
determined instead by the prevailing options set on the Chord Symbols page of 
Engraving Options. For example, you could choose to enter a C major chord as 
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either “C” or “Cmaj” or “CM”, but in each case the appearance of the resulting 
chord symbol will be the same, as specified in Engraving Options. 

Dorico can handle polychords, where a single chord symbol describes two 
simultaneous chords: in the popover, simply separate the two chords using the 
pipe character |. For example, type D|C7 for a D major chord over a C7 chord. 

To input a “no chord” symbol, type N.C., NC, no chord, or none into the popover. 
For a chord symbol that consists only of the root note, type e.g. Cbass or Gonly 
into the popover. 

Inputting chord symbols using your MIDI keyboard. When the chord symbol 
popover is open, you can play a chord on your MIDI keyboard to input a chord 
symbol. Options for how Dorico interprets the notes you play on your keyboard are 
found on the Chord Symbols page of Write ▸  Note Input Options, and include 
choices over things like whether Dorico should consider the inversion in which you 
play a given chord, or should always write the chord symbol as if it had been 
played in root position; whether Dorico should notate omissions (e.g. if you play C 
and E, should it be notated as C or C(omit5)); how it should notate added notes 
and suspensions; how it should handle complex enharmonic relationships between 
root and altered bass notes; and so on. You should examine these options carefully 
as the default settings will not suit every user. 

To input a chord symbol with an altered bass note, simply play the chord with the 
altered bass note at the bottom. Alternatively, you can play the chord and its 
altered bass note separately: hold down the keys for the chord, then while the keys 
are depressed, play the altered bass note. 

To tell Dorico the root of the chord to be input, either first play the root with one 
finger and then play the remaining notes of the chord while holding down the root, 
or play all the notes of the chord together, hold them down, then release and replay 
the root note. 

To input a polychord, play one chord with one hand, then while those keys are 
depressed, play the second chord with the other hand. 

To input a chord symbol that consists only of the root note, simply play only a 
single note. 

Navigation during chord symbol input. When the chord symbol popover is open, 
hitting Space will advance the popover to the next beat. You can also move the 
popover using the following key commands: 

 Ctrl+left/right arrow (Windows) or Command-left/right arrow (Mac): 
previous/next chord symbol. 
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 Tab: start of next bar. 
 Shift+Tab: start of previous bar. 
 Space: next beat. 
 Shift+Space: previous beat. 
 Left/right arrow: previous/next note/rest or rhythmic grid position, whichever is 

closer. 
 Backspace: previous chord symbol. 

When inputting chord symbols using a MIDI keyboard, by default the popover 
advances automatically to the next beat after you play a chord. You can change this 
behaviour using the Advance during chord symbol input via MIDI input option 
on the MIDI Input page of Note Input Options. 

Furthermore, you can define specific keys or buttons on your MIDI keyboard to 
trigger different navigation behaviours, by using the MIDI Learn button on the Key 
Commands page of Preferences to assign specific keys to the Note Input ▸  
Advance Chord Symbol Input commands. 

Editing an existing chord symbol. To edit an existing chord symbol, simply select it 
and hit Return or double-click it in Write mode: the popover will open, with the 
shorthand for the chord symbol ready to be edited. You can either edit the existing 
chord symbol by editing the shorthand, clear the popover and type an entirely new 
chord symbol, or play a new chord symbol on your MIDI keyboard. 

Transposition of chord symbols. One or more selected chord symbols can be 
transposed using Write ▸  Transpose. Chord symbols also appear at the 
appropriate transposed pitch when shown on transposing instruments and Edit ▸  
Transposed Pitch is chosen. 

Changing the enharmonic spelling of chord symbols. To respell a chord symbol for 
a transposing instrument in a transposing layout, simply edit the chord symbol as 
normal: if you change, for example, the root of Dbmaj13 from Db to C# without 
changing the quality, interval or alterations, the spelling of the chord symbol will be 
altered for all instruments with the same transposition. 

To remove an enharmonic spelling override for a chord symbol on the current 
instrument, edit the chord symbol as usual and type Alt+S into the chord symbol 
popover; to remove all enharmonic spelling overrides for a chord symbol, type 
Shift+Alt+S into the popover. 

Choosing above which staves chord symbols appear. By default, chord symbols 
appear above the staves belonging to rhythm section instruments (e.g. keyboards, 
guitars, bass guitars, etc.), but you can control this from the Players panel in Setup 
mode. Select a player, then right-click to access the Chord Symbols context 
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menu, and choose Show For All Instruments, Show For Rhythm Section 
Instruments, or Hide For All Instruments. 

Chord symbols may optionally be shown between the two staves of grand staff 
instruments, such as piano, by setting the Position of chord symbols on grand 
staff instruments option in the Position group on the Chord Symbols page of 
Engraving Options. 

Choosing in which layouts chord symbols appear. By default, chord symbols 
appear both in full score and part layouts. To change this, switch to Setup mode, 
select the player in question in the Players panel, right-click to access the Chord 
Symbols context menu, and choose Show in Full Score and Parts, Show in Full 
Score Only, or Show in Parts Only. 

Hiding individual chord symbols. To hide an individual chord symbol in the current 
layout, select the chord symbol and set the Hidden property in the Chord 
Symbols group in the Properties panel. A signpost is shown in place of the chord 
symbol. If you do not want to see these signposts, switch off View ▸  Signposts ▸  
Chord Symbols. 

Positioning chord symbols. Chord symbols are centered horizontally on the middle 
of the front notehead in the first voice column at the rhythmic position to which they 
are attached. You can instead choose to left-align chord symbols with the left-hand 
side of the front notehead in the first voice column (or even right-align them, though 
this typically produces unclear results) by setting Horizontal alignment of chord 
symbols on the Chord Symbols page of Engraving Options. This can also be 
overridden for an individual selected chord symbol using the Horizontal alignment 
property in the Chord Symbols group of the Properties panel. 

Chord symbols are aligned at the same vertical position across the width of the 
system by default, but you can switch off Align chord symbols across width of 
system on the Chord Symbols page of Engraving Options if you prefer each 
chord symbol to be positioned above the staff independently. 

Moving chord symbols. In Write mode, dragging a chord symbol or moving it with 
Alt+left/right will attach it to a new rhythmic position; be aware that moving a chord 
symbol to the same position as an existing chord symbol will delete the existing 
chord symbol at that position. 

In Engrave mode, dragging a chord symbol or nudging it with Alt+arrow keys will 
not change the rhythmic position to which the chord symbol is attached. 

Chord symbol appearance presets. Because there are many conventions for the 
appearance of chord symbols, Dorico provides a choice of different preset 
conventions that you can use as-is or as the basis of your own preferred 
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appearance. The presets are found at the top of the Chord Symbols page of 
Engraving Options, and are as follows: 

 
Boston 

 
Brandt-Roemer 

 

 
Indiana  

Japanese 
 

 
Jazz Standard  

Nashville 
 

 
New York 

 
Ross 

 

A further preset, simply called Default, is also provided, which uses a set of 
symbols intended to be as unambiguous as possible, avoiding the use of symbols 
for major seventh, augmented, diminished, and half-diminished, using standard 
accidentals, and so on. This is the preset that is chosen by default in new projects. 

The presets simply choose specific combinations of the options on the Chord 
Symbols page, and you can further adjust these options to suit your preferences. 

Changing the font used for chord symbols. To change the text font used for chord 
symbols, choose Engrave ▸  Font Styles, and edit Chord symbols font. It is not 
advised to edit the Chord symbols music text font, which is set to Bravura Text 
by default; this can only be set to a SMuFL-compliant font intended for use in text-
based applications. When using the option to show the word on instead of a slash 
or line to separate a chord from its altered bass note, you can edit the font used for 
that word by editing the Chord symbols altered bass separator font. 

Playback of chord symbols. To include chord symbols in playback, go to Play 
mode and expand the chord track at the top of the event display. Choose the 
playback device (VST instrument or MIDI device) that should be used, and switch 
on the speaker icon to enable playback. Chord symbols are played back as 
sustained chords, the duration being taken from the gap between one chord 
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symbol and the next. If the chord symbol was input using a MIDI keyboard, the 
chord will play back using the voicing that was used to input the chord symbol. 

MusicXML import. Chord symbols are imported from MusicXML files, but chords 
that specify Neapolitan, Italian, French, German, Pedal, Tristan and Other 
values for the kind element are ignored during import, as there is no information to 
specify what notes these chord symbols are meant to describe. 

Enharmonic spelling during MIDI step input 

Enharmonic spelling refers to the choice of note name and accidental to describe a 
note of a given pitch, normally according to the current key center or tonality – for 

example, whether a note should be spelled as F♯ or G♭. When inputting notes from 

a MIDI keyboard, there is no way to directly specify the desired spelling, so Dorico 
works out the optimal spelling using a sophisticated algorithm. 

The algorithm takes into consideration the current key signature, the intervals 
between the next and previous notes or chords, and the intervals between the 
notes of chords. If you choose to respell a note (using Write ▸  Respell ▸  Respell 
Using Note Name Above/Below), Dorico will also take that choice into 
consideration, and will use that spelling for further notes of that pitch. 

Broadly speaking, Dorico will prefer to notate notes outside the key signature using 
sharps if the figure is rising, and using flats if the figure is falling. When determining 
the spelling of a note, if one spelling will produce a simpler interval (for example, a 
major third rather than a diminished fourth), it will overall prefer the simpler interval. 

When inputting onto a grand staff instrument such as piano, Dorico will also use 
the context provided by any music already entered on the other staff: by way of 

example, Dorico will normally prefer B♭ over A♯, but if this note is input into the 

right-hand staff of a piano, and the left-hand staff includes an F♯ at that rhythmic 

position, Dorico will spell the note on the right-hand staff as A♯ since this produces 

a simpler interval between the notes in the two staves. 

As you input notes using your MIDI keyboard, you may notice that Dorico 
automatically respells previous notes or chords as you continue inputting: for 

example, if you input, in the key of C major, E followed by G♯, Dorico will spell the 

second note as G♯, but if you then input G♮, Dorico will respell the G♯ as A♭, 
because that spelling makes more sense in the context. If you want to prevent 
Dorico from making retrospective changes to notes you have already input, switch 
off Allow spelling of notes to be adjusted retrospectively on the MIDI Input 
page of Note Input Options. (STEAM-5203) 
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Piano pedal lines (STEAM-5661) 

Dorico now has the most comprehensive support for piano pedal lines of any 
scoring software. You can easily create pedaling for the sustain, una corda and 
sostenuto pedals, with support for modern sustain pedaling techniques, including 
changing the pedal level over the course of a single pedal instruction. 

Creating pedal lines with the mouse. Pedal lines can be created from the 
Keyboard section of the Playing Techniques panel in Write mode. 

 

The items on the first row create a new pedal line for the sustain, sostenuto or una 
corda pedals respectively. Either select the notes to which the pedal line should 
apply and click the relevant button, or, with nothing selected, click the relevant 
button and then click and drag in the score to create a pedal line and extend it to 
the desired duration. 

The items on the second row can be used to add retakes and changes of pedal 
level (to one-quarter depressed, half-depressed, three-quarters depressed, and 
fully depressed, respectively) to an existing pedal line: ensure that nothing is 
selected, click the relevant button, then click on the pedal line at the rhythmic 
position at which you want the retake or change of pedal level to be created. 

Creating pedal lines with the keyboard. You can also create pedal lines using the 
Shift+P popover, either based on the range of selected notes, or during step input.  

To create a pedal line of a particular duration, first select the notes to which the 
pedal line should apply, then type Shift+P and enter ped for the sustain pedal, 
sost for the sostenuto pedal, or unacorda for the una corda pedal. 

To create a pedal line during step input, position the caret at the rhythmic position 
where the line should begin, then type Shift+P and enter the appropriate 
shorthand for the desired pedal line. You can then extend the pedal line simply by 
advancing the caret with Space. When you want to stop the pedal line, type 
Shift+P again and enter * to stop a sustain pedal line, s* to stop a sostenuto pedal 
line, or u* to stop an una corda pedal line. 

You can also add retakes and changes of pedal level while inputting a pedal line in 
step input: when the caret is at the position at which you want it to appear, type 
Shift+P and enter ^ for a retake, 1/4 for a change of level to one-quarter 
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depressed, 1/2 for half-depressed, 3/4 for three-quarters depressed, or 1 for fully 
depressed. 

To edit the start position of a pedal line once it has been created, select the pedal 
line and type Alt+left/right to snap the whole line to the previous or next rhythmic 
position, or type Shift+Alt+left/right to snap the end of the line to the previous or 
next rhythmic position. 

Engraving Options. A comprehensive set of options to determine the appearance 
and positioning of pedal lines can be found on the new Pedal Lines page of 
Engraving Options. This includes options for which symbol should be shown at 
the start of each kind of pedal line, what should be shown for continuing lines at 
the start of a new system, the height and width of the retake notch, whether 
gradual changes of pedal level should be shown using a dashed or solid line, and 
many other options besides. 

Properties. The appearance of an individual pedal line can also be overridden by 
selecting it and adjusting the properties in the new Pedal Lines group in the 
Properties panel. Among other things, you can specify whether the start and end of 
a pedal line should be positioned before or after grace notes using the Starts 
before grace notes and Ends before grace notes properties. 

In Engrave mode, you can select each segment of a sustain pedal independently, 
and thus set properties independently. Selecting a retake or change of pedal level 
in a sustain pedal line will show the Pedal Line Retakes group of properties, 
which allows you to specify the pedal depression level before the retake (End level 
at retake) and the pedal depression level following the retake (Start level at 
retake). If the pedal should not be released altogether between the old and new 
levels, change Retake type to Change Level instead of Retake. 

Editing pedal lines in Engrave mode. When a pedal line is selected in Engrave 
mode, the following handles appear to allow fine graphical editing: 

 

At the start of the pedal line, the leftmost handle can be dragged left and right to 
move the start of the line horizontally; and the handle to the left of the start of the 
continuation line can be dragged up and down to change the start pedal level. 

At a retake, the handle to the left of the retake notch can be dragged up and down 
to change the pedal level before the retake, while the handle to the right of the 
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retake notch changes the pedal level after the retake; the handle below the center 
of the notch can be dragged left and right to move the whole retake horizontally. 

At the end of the pedal line, the handle at the tip of the hook can be dragged up 
and down to change the hook length; the handle to the right can be dragged up 
and down to change the final pedal level; and the handle below the hook can be 
dragged left and right to move the end of the line horizontally. 

Overriding start and restorative text. For pedal lines that use a text indication rather 
than a symbol, as una corda pedal lines do, for example, or as sustain pedal lines 
do if you choose to use plain Ped. text rather than the ornate symbol, you can 
override the text shown at the start of the pedal line by editing the Text property, 
the text shown at the start of the next system by editing the Continuation text 
property, and, for una corda pedal lines, the tre corde text shown at the end of the 
pedal line by editing the Restorative text property. 

Playback. Pedal lines are automatically played back. Sustain pedal lines send MIDI 
controller 64 (Sustain), sostenuto pedal lines send MIDI controller 66 (Sostenuto), 
and una corda pedal lines send MIDI controller 67 (Soft Pedal). Some VST 
instruments (such as Pianoteq and Garritan CFX Concert Grand) support partial 
depression of the sustain pedal – consult the manufacturer’s documentation for 
more details. 

Options for how Dorico plays pedaling are found on the new Pedal Lines page of 
Playback Options. You can control the speed of the initial pedal depression, the 
speed of a retake in the middle of a pedal line, and the speed of the final pedal 
release, and you can also specify whether the initial depression and the retake 
should be played before or after the onset of the notes or chords at that rhythmic 
position. 

MusicXML import. Sustain pedal lines are imported from MusicXML files. 
MusicXML can only describe the sustain pedal, and it cannot describe changes in 
pedal depression level. 

Repeat endings 

Dorico now supports the notation of repeat endings, sometimes known as volta 
lines, or as 1st and 2nd endings. Playback of repeat ending lines is not yet 
supported, but is planned for a future update. 

Creating repeat endings. To create a repeat ending, select the bars that will form 
the first ending, then click the button to create a first ending from the Repeat 
Endings section of the Repeat Structures panel on the right-hand side in Write 
mode. The first ending segment will be created, covering the selected bars, with a 
second ending segment created in the bar immediately following the first ending; a 
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suitable end repeat barline will be created at the end of the first ending if one is not 
already present. To add a repeat to the second ending, select the bars that will 
form the second ending, and click the button to add an additional ending from the 
Repeat Endings section: the existing second ending segment will become a 
closed line, with an end repeat barline created if necessary, and a third ending 
segment will be added in the bar following the second ending. This process can be 
repeated as often as required. 

Changing the number of times played. By default, each segment in the set of 
repeat endings is played once, and so will show a single digit corresponding to the 
time through the music on which each ending is played. To tell Dorico that an 
ending should be played more than once – for example, that the first ending should 
be played on the first three times through – set the No. times played property in 
the Repeat Endings group in the Properties panel to the number of repetitions to 
be played. The number shown under the relevant ending segment will automatically 
be updated, following the options defined in Engraving Options. It is not 
necessary to set this property on every segment, as Dorico will do its best to 
calculate how many times a segment should be played if the property is set 
inconsistently (it will prefer to add any unused repetitions to the final closed ending 
segment); it will enforce that the total number of times played must be greater than 
or equal to the number of segments. 

Changing the text shown in a segment. If you need to override the text displayed in 
a specific ending segment, you can set the Custom text property in the Repeat 
Endings group in the Properties panel. 

Engraving Options. Options controlling the design, default position, and display of 
number of times played can be found on the new Repeat Endings page of 
Engraving Options. 

Choosing where repeat endings appear. Repeat endings are system-attached 
items and appear above the instruments chosen in the System Objects section of 
the Staves and Systems page of Layout Options. 

Editing repeat endings in Write mode. Repeat endings can be dragged from bar to 
bar in Write mode by selecting any segment and dragging left or right, or using 
Alt+left/right arrow. Each segment can be made to include more or fewer bars by 
selecting the handle at the start or end of each segment and dragging left or right. 

Editing repeat endings in Engrave mode. In Engrave mode, the exact horizontal 
position of the hooks at the start and end of each segment of the repeat ending 
can be adjusted, the position of each segment relative to the staff, and the length 
of the hooks can all be edited both by nudging or dragging the appropriate 
handles, or using the properties in the Repeat Endings group. 
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MusicXML import and export. Repeat endings are imported from MusicXML files, 
with the limitation that the segments in the middle of a set of endings cannot have 
an open right-hand end, despite this being technically possible to represent in 
MusicXML. Repeat endings are also now included when exporting MusicXML files. 

Editing in Write mode 

It is now possible to edit the rhythmic position and, where appropriate, the duration 
of items in Write mode, and it is also easier to create items with the mouse. 

Creating with the mouse. You can now create and set the length of an item in a 
single operation with the mouse: with nothing in the score selected, click the item 
you want to create (such as an octave line) in the relevant panel, then click on the 
staff where you want the item to be created, and keep the mouse button held down 
while you drag the item to the desired duration. 

Editing with the mouse. Selected items with duration (such as slurs, hairpins, pedal 
lines, octave lines, trills, and so on) now show circular handles at their starts and 
ends. Dragging the start handle snaps the rhythmic position of the start of the item, 
leaving the end position in the same place (i.e. it lengthens and shortens the 
duration of the item); dragging the end handle snaps the rhythmic position of the 
end of the item, leaving the start position in the same place. To snap the item to a 
new rhythmic position without editing its length, drag the main body of the item 
rather than either of its handles. 

Editing with key commands. You can use the key commands Alt+left/right arrow to 
snap the selected item to the previous/next rhythmic position, and for items that 
have duration you can shorten or lengthen their duration with the key commands 
Shift+Alt+left/right arrow; add Ctrl to snap to or shorten or lengthen by the 
current rhythmic grid duration rather than the next logical position. 

Editing dynamics. Grouped dynamics can now be edited with the mouse: where a 
group begins or ends with a hairpin, a circular handle appears corresponding that 
can be dragged to a new rhythmic position; a similar handle also appears at the 
point where the type of dynamic changes in a messa di voce hairpin, allowing you 
to snap that inflection point to a new rhythmic position. Dragging the dynamic at 
the start or end of the group will scale the positions of the other dynamics 
proportional to the overall length of the group. Immediate or combined dynamics in 
the middle of a group of gradual dynamics can also be dragged to new positions, 
which will automatically shorten or lengthen the surrounding gradual dynamics 
appropriately. 

Creating items with the mouse. If you prefer using the mouse for input and editing 
to using the keyboard, new options in the Editing group of the General page of 
Preferences can make using Dorico more comfortable for you. When Allow 
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multiple items to be created with the mouse is set, you can create multiple 
items from any of the panels in Write mode without having to reselect the item 
each time. Under Creating items with the mouse, you can also choose whether 
Dorico should automatically create items at the position of the current selection 
(the default), or whether you want it to always load the cursor so that you can click 
to place the item. (STEAM-6102) 

Attachment lines. To make it clear to which rhythmic positions items are attached, 
a dark red dotted line is drawn from the left-hand side of each selected item (and, 
for items that have duration, such as slurs, hairpins, octave lines, pedal lines, and 
so on, from the right-hand side too) to the middle of the staff at the attachment 
position. This can be disabled by switching off View ▸  Attachment Lines. 

Editing note spacing (STEAM-5983) 

You can now edit the note or rhythmic spacing of your music in Engrave mode. To 
enable these spacing adjustments, activate the switch in the Note Spacing section 
of the left-hand panel in Engrave mode, and dashed lines representing spacing 
columns and handles for each spacing-significant item will appear. When the 
columns and handles are visible, you cannot make any selections or edits to items 
in the current layout: deactivate the switch on the Note Spacing section or switch 
to Write mode to resume normal selection and editing. 

 

Spacing adjustments and graphical adjustments. You can make two kinds of 
adjustments to the horizontal position of notes and chords, grace notes, rests, 
clefs, key signatures, time signatures, barlines, and so on: spacing adjustments, 
which increase or decrease the amount of rhythmic space to the left and right of 
the item, and which affect the whole spacing column (i.e. all items that start at that 
rhythmic position across all staves); and graphical adjustments, which move a 
selected item on a single staff only, in a way that does not affect the spacing of 
other items. To make a spacing adjustment, select a square handle, hold Alt and 
use the left and right arrow keys to adjust in small increments, and add Ctrl 
(Windows) or Command (Mac) to adjust in larger increments. To make a graphical 
adjustment, first select the square handle above the staff, then select the circular 
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handle that appears on the middle staff line, and use the same key commands. You 
can switch between selecting related square and circular handles by hitting Tab. 

When you make a spacing adjustment to a primary rhythmic position, both the 
square handle itself and the dashed line representing the spacing column are 
colored red. 

When you make a graphical adjustment to an item, a horizontal red line is drawn 
joining the item’s circular handle to its original position (i.e. the position at which it 
is still considered to be for the purposes of spacing). 

Adjusting secondary voice columns. When multiple voices are active at the same 
rhythmic position, you can adjust the position of each voice column independently. 
A square handle appears for each voice column, allowing you to make spacing and 
graphical adjustments for the notes in that column independently of the first 
column. If you find that you need to make an adjustment to a voice that is currently 
sharing a voice column with another voice, you can move it into its own voice 
column using the Voice column index property, which will allow spacing and 
graphical adjustments independently of other columns. 

Navigating between handles. You can navigate between handles using the arrow 
keys. Hold Shift to make a multiple selection of handles. Press Tab to switch 
between the square handles for adjusting spacing and the circular handles for 
adjusting graphical offsets. 

Adjusting multiple items at once. Select multiple handles either via marquee 
selection or using Shift+arrow keys, and then use the key commands to make 
spacing or graphical adjustments to all the selected handles at the same time. 

Removing adjustments. To remove a single spacing or graphical adjustment, select 
the handle and hit Delete; if the item has both a spacing and graphical adjustment, 
both adjustments will be removed. To remove only a graphical adjustment, select 
the item in Write mode and choose Edit ▸  Reset Position. To remove spacing 
adjustments over a larger region, select one or more handles in the region you want 
to remove them, then choose Engrave ▸  Note Spacing ▸  Reset Layout (which 
removes all spacing adjustments in the current layout), Reset Selected Frames 
(which removes all spacing adjustments in the music frames in which one or more 
handles are currently selected), or Reset Selected Systems (which removes all 
spacing adjustments in the system or systems in which one or more handles are 
currently selected). 

Locking the system. When you make any spacing or graphical adjustment to an 
item, the system on which you are making the adjustment is locked: Dorico will 
create a system break at the start of the adjusted system (if one does not exist 
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already) and at the start of the following system. This ensures that making spacing 
adjustments does not cause the casting-off of your layout to change. 

System fullness indicator. When editing note spacing, a new indicator in the right-
hand page margin shows you at a glance how full each system is, expressed both 
as a percentage, and as the number of spaces occupied out of the total number of 
available spaces (which is measured from the start of rhythmic space to the right of 
the initial clef and signatures to the final systemic barline). When a system is too 
empty, the indicator is colored purple; when it is more than 70% full it is colored 
green; and when a system is over-full (more than 100%), it is colored red. 

Indenting the system. Two large square handles appear at either end of each 
system: on the left-hand side, aligned with the top staff line of the top staff, and at 
the right-hand side, aligned with the bottom staff line of the bottom staff. These 
handles allow you to indent either end of the system from the frame, using the 
same key commands for the other types of handles. Unlike editing the spacing 
within a system, indenting either end of the system does not lock the system, so 
the casting off can change. 

Properties. It is also possible to specify spacing and graphical adjustments for 
items outside of the dedicated tool in Engrave mode using the Properties panel. 
You can make spacing adjustments for most non-note items using the Spacing 
offset property found in that item’s property group, and graphical adjustments 
using the Offset X property found in the Common group. For notes, spacing 
adjustments are made using the Voice column spacing offset property, and 
graphical adjustments are made using the Voice column X offset property, both of 
which are found in the new Note Spacing group. 

Adjusting the position of a bar rest. Unlike other rests and notes, bar rests do not 
show handles, but it is possible to adjust the horizontal position of a bar rest 
relative to its bar using the Offset X property in the Common group of the 
Properties panel. 

Filters (STEAM-5893) 

Selection filters are used to narrow down a selection of notes and other items in 
your project, based on criteria that you specify. A new Edit ▸  Filter submenu has 
been added, containing filters that select or deselect items of different kinds. To 
use a filter, first select multiple items – for example, by clicking in a blank part of a 
bar to select all notes and other items in that bar, then extending the selection by 
holding Shift and clicking in another bar in the same or another staff – then choose 
the filter corresponding to the item you want to remain selected, or to the item you 
want to remove from the selection. 



 

 
Dorico Version History Page 80 Steinberg Media Technologies GmbH 

Whether a filter will leave only the chosen item selected or will deselect the chosen 
item is determined by whether Select Only or Deselect Only is chosen at the top 
of the Edit ▸  Filter submenu. 

The following filters are available: 

 Notes and Chords: selects or deselects notes, grace notes, and tuplets 
 Grace Notes: selects or deselects only grace notes 
 Rests: selects or deselects explicit rests, explicit bar rests, and implicit rests 
 Voices submenu: allows you to select or deselect all items belonging to either 

All Up-Stem Voices, All Down-stem Voices, or if your selection encompasses 
only a single staff, material in any of the numbered voices on the staff. 

 All Dynamics: selects or deselects immediate (including combined and force) 
dynamics and gradual dynamics (including hairpins, messa di voce, cresc./dim. 
lines) 

 Immediate Dynamics: selects or deselects immediate dynamics only 
 Gradual Dynamics: selects or deselects gradual dynamics only 
 All Tempos: selects or deselects all immediate, relative and gradual tempos 
 Immediate Tempos: selects or deselects immediate tempos (e.g. Andante) 

only 
 Relative Tempos: selects or deselects relative tempos (e.g. a tempo) only 
 Gradual Tempos: selects or deselects gradual tempos (e.g. rit./accel.) only 
 Arpeggio Signs 
 Chord Symbols 
 Clefs 
 Glissando Lines 
 Holds and Pauses 
 Key Signatures 
 Lyrics 
 Octave Lines 
 Ornaments and Trills 
 Pedal Lines 
 Playing Techniques 
 Rehearsal Marks 
 Slurs 
 Text: i.e. Shift+X text events 
 Time Signatures 
 Tuplets: selects tuplet brackets/numbers (but not the notes within them) 
 All Breaks: selects or deselects frame and system breaks 
 Frame Breaks: selects or deselects frame breaks only 
 System Breaks: selects or deselects system breaks only 
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Play mode 

Editing played or notated durations. The event display in Play mode now 
allows you to display and edit either the played durations or the notated 
durations of notes. A new pair of buttons (shown on the right) have been 
added to the Play mode toolbox to switch between these two modes. 

When viewing played durations, the main body of each note in the piano roll 
display represents the played duration, including all intrinsic playback effects (such 
as shortening a note due to a staccato articulation, or lengthening it due to a slur), 
while the notated duration is shown as a thin line at the bottom of each note event. 
When viewing notated durations, this arrangement is reversed: the played duration 
is shown as a thin line at the bottom of each note event, whereas the main body of 
the note represents the notated duration. 

Editing played durations. When editing the start position or duration of notes in the 
event display, the event display is now updated in real-time as you edit, rather than 
only after you release the mouse. Notes whose playback duration have been edited 
show up in a darker color in the piano roll display. 

To remove any edits made to the played durations of notes back to their default 
start position and length, select the affected notes and choose Play ▸  Reset 
Playback Overrides. 

Editing notated durations. When editing notated durations, you can move notes 
earlier and later in time by selecting them and dragging them left and right, which 
snaps them to positions described by the current rhythmic grid value. 

Notes can also be dragged up and down to change their pitch (or you can use 
Alt+up/down arrow, or Ctrl+Alt+up/down arrow, as you would in Write mode). 

You can also change the durations of notes by selecting them and dragging the 
right-hand end of any selected note. As with moving notes earlier later in time, note 
durations are snapped according to the current rhythmic grid value. 

Finally, notes can be cut and pasted in the event display. When pasting, the 
destination rhythmic position will be determined by the position of the playhead. 

Voices in the event display. All voices for each instrument are now shown in a 
single track. (STEAM-6202) 

Ruler. The ruler at the top of the event display in Play mode now shows bar and 
beat divisions for the prevailing time signature. 

Scrolling, zooming and navigating. There have been significant improvements to 
the user experience of working with the event display in Play mode: 
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 The disclosure state of each track in the event display is now persistent when 
switching away from and back to Play mode during a single editing session (it is 
not yet persisted when saving and reopening the project, but this is planned). 

 You can now scroll and zoom the event display with two-finger gestures if you 
have a multi-touch trackpad. 

 Horizontal scroll and zoom of the event display is constrained, so that you 
cannot scroll off the start or end of the flow, or zoom out such that the flow does 
not occupy the whole width of the window. 

 When expanding a track in the event display, the piano roll view is now centered 
on the range of notes played by that instrument. 

 When the pointer is over the vertical piano keyboard display at the left of the 
event display for a track, Shift+mouse wheel scrolls the piano roll vertically. 

 The thresholds for clicking either end of or the body of a note in the event 
display have been adjusted, so it’s easier to select the note by clicking on it, and 
the mouse pointer updates as it hovers over the parts of a note to show what 
will happen when you click there. 

Playing technique display. To visualize how Dorico maps playing techniques onto 
the various keyswitches and articulations provided by the VST Expression Map in 
use for an instrument, when you expand an instrument’s track in Play mode you will 
now see an additional informational lane, which shows which regions will be played 
by different switches within the current VST Expression Map. Hover over a region 
of the lane for a tool tip containing more detailed information. 

Support for MIDI output devices 

Dorico can now play back through any connected MIDI output devices. A new 
MIDI Instruments section has been added to the right-hand panel in Play mode, 
allowing you to add any of your MIDI devices in a similar manner to adding a new 
VST instrument. Once a MIDI device has been added, you can choose to route 
playback from any instrument in your project to the MIDI device by editing the 
settings in the relevant track header on the left-hand side of the event display in 
Play mode. 

A new MIDI button has been added to the toolbar in the Mixer, allowing you to 
show a MIDI fader for each instrument. Each MIDI fader sends MIDI controller 7 
(Volume), and the pan slider above the fader sends MIDI controller 10 (Pan). You 
cannot solo or mute MIDI faders. (STEAM-5920) 
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Flows 

Duplicate an existing flow. You can make a copy of a flow in your project – for 
example, to revise the music while maintaining the current state as a separate flow 
– by selecting the flow in the Flows panel in Setup mode, then choosing Duplicate 
Flow from the context menu. 

Splitting an existing flow. You can split an existing flow into two by selecting a note 
or other item at the point at which you want the flow to be split, and choosing Write 
▸  Split Flow. 

Importing flows from another Dorico project. You can now import one or more 
flows from another Dorico project into the active project by choosing File ▸  Import 
▸  Flows. You will be prompted to choose the source Dorico project that contains 
the flow or flows you want to import. A dialog appears in which you can choose 
which flow or flows to import from the source project, and you can also choose 
how Dorico should handle assigning the music in the imported flow or flows to 
players in the destination project: 

 Create All New Players will create a new player in the destination project for 
every player assigned to the flow or flows in the source project, and will also 
create new part layouts as needed for those players. 

 Merge with Existing Players Where Possible will attempt to assign the music 
in the imported flows to existing players. It will use an existing player provided it 
has the same instruments or a superset of the instruments of the player in the 
imported flow. 

Importing a flow from a MusicXML file. When a Dorico project is open, choosing 
File ▸  Import ▸  MusicXML will import the music from that MusicXML file as a new 
flow in the active project. If you want to open the MusicXML file as a new project 
instead, choose File ▸  Open and open the MusicXML file that way instead. As 
with importing one or more flows from another Dorico project, after you choose the 
source MusicXML file to import, a dialog appears in which you can choose how 
Dorico should handle assigning the music in the imported file to players in the 
destination project. 
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Improvements 

Accidentals 

It is now possible to make fine adjustments to the horizontal position of an 
individual accidental using the new Accidental X offset property, which appears in 
the Notes and Rests group of the Properties panel in Engrave mode. (STEAM-
6105) 

Arpeggio signs 

Playback. Arpeggio signs now play back, and options to control this playback are 
found in the new Arpeggio Signs group on the Timing page of Playback 
Options. You can control whether the arpeggiation should start or end on the beat, 
the speed of arpeggiation, and the maximum percentage of the written duration of 
the chord that can used to accommodate the arpeggio. The new Arpeggios 
Playback group in the Properties panel also allows you to override the default 
playback options for an individual arpeggio sign. (STEAM-3909) 

Engrave mode. It is now possible to move an arpeggio sign left or right relative to 
the chord to which it belongs, either by nudging it with Alt+left/right, dragging it 
with the mouse, or adjusting the X offset property in Engrave mode. (STEAM-
5775) 

Barlines 

Two new options have been added to the Barlines page of Engraving Options:  

 Barline length for single-line instruments allows you to specify by how many 
spaces the barline should extend above and below the single staff line, 
assuming it does not join with another staff above or below. (STEAM-5730) 

 Barline at end of system coinciding with start repeat allows you to choose 
between showing a single or double barline at the end of one system when a 
start repeat barline appears at the start of the next. (STEAM-5195) 

Beams 

Splitting a beamed group. A new Edit ▸  Beaming ▸  Split Beam command has 
been added, which splits an existing beam group into separate groups at the 
positions of the selected notes. The command formerly called Break Beam is now 
called Make Unbeamed, to make clear what it actually does. (STEAM-5792) 

Beam slants for concave shapes. New options for determining when beams should 
be horizontal, rather than slanting up or down, have been added to the Advanced 
Options section within the Slants group on the Beams page of Engraving 
Options. 
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When determining whether a beamed group of three or more different pitches 
should be considered concave (i.e. that the notes in the middle of the beamed 
group are closer to the beam than the notes at the ends of the beamed group), you 
can now determine whether a group should be considered concave when the inner 
note closest to the beam is strictly closer than the notes at the ends of the beamed 
group, or whether it can be at the same staff position as the notes at the ends of 
the beamed group. By default, inner notes at the same staff position as the notes at 
the ends of the beamed group will cause the beam to be horizontal, which was not 
the case previously; to restore the previous behavior, set Inner note at same 
position as outer note to Do not treat as concave. 

By default, for a beamed group to be considered to have a concave shape, the 
inner note closest to the beam must be closer than the note at each end of the 
beam, i.e. closer (or at the same position as) both outer notes. If you would prefer 
the group to be treated as a concave shape if the inner note is closer than only one 
of the outer notes, set Inner note closer to the beam than one but not both 
outer notes to Treat as concave. (STEAM-5636) 

Stem shortening. When note stems point outside the staff, which happens 
especially when multiple voices are active, stems are shortened as notes approach 
the outer lines and spaces. It is now possible to control the positions on the staff at 
which the shortening starts and stops, using the new options below the Stem 
Shortening heading in the Stems group on the Notes page of Engraving Options. 

In The Art and Practice of Music Engraving, Ted Ross recommends that the stem 
length of beamed eighth notes (quavers) should be shortened by a quarter of a 
space for a horizontal beam, and by half a space for a slanted beam. Dorico no 
longer does this by default in new projects, as it makes the default stem lengths for 
beamed eighths shorter in comparison to unbeamed notes, but if you want to 
restore this behavior, set Stem shortening for beamed groups to Shorten 
beamed stems. 

Finally, it is now possible to specify the minimum stem length separately for notes 
of different durations: quarter notes (crotchets) and longer; eighth notes (quavers); 
and 16th notes (semiquavers) and shorter. The interaction of the desired minimum 
stem length, shortening according to staff position, and the snapping of beam lines 
to valid sit/straddle/hang positions according to their ideal slants is complex. 

Brackets and braces 

A new option When only one staff of braced group is shown has been added to 
the Design group of the Brackets and Braces page of Engraving Options. When 
set to Draw brace, a brace will be drawn spanning a single staff if only one staff of 
a grand staff instrument such as a piano is shown on that system; when set to Do 
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not draw brace, a brace will only be drawn if both staves of the grand staff 
instrument are shown on that system. (STEAM-5580) 

Casting off (STEAM-6139, STEAM-6140) 

A new Casting Off section has been added to the Staves and Systems page of 
Layout Options, providing options to influence how Dorico casts off your music. 
Casting off is the process of determining how many and which bars appear on 
each system, and how many systems appear on each page. The new options in 
this section are as follows: 

 Fixed number of bars per system: fixes the number of bars on the system, 
regardless of their width. Multi-bar rests and complete bars with open meter are 
counted as a single bar; if a bar with open meter is split across a system break, 
each portion either side of the system break is counted as a single bar. Fixing 
the number of bars per system is not appropriate for all kinds of music, but it is 
often done in music for session recording, as fixing (say) four bars per system 
typically allows enough room for annotations, cues, and other material to be 
written in by the player in the session. 

 Fixed number of systems per frame: fixes the number of systems in each 
music frame; since a music frame normally occupies almost the full height of the 
page, this option therefore normally determines the number of systems on each 
page. Fixing the number of systems per frame is most often done in instrumental 
parts, where it is typical for there to be 10 or 11 systems per page. 

 Scale number of systems by frame height: allows Dorico to reduce the fixed 
number of systems in the frame proportionally with the height of the music 
frame. This is useful if you generally want to have, say, 10 systems per page, but 
because the first page of your part includes material such as the title, composer, 
instrument name, etc., the height available for music is reduced compared to 
subsequent pages, and when using this option, Dorico can put eight or nine 
systems in this first frame instead. 

In addition, the existing option Allow open bars to be split across system 
breaks has been moved from the Note Spacing page of Layout Options. 

Clefs 

French violin clef. The French violin clef (a G clef positioned on the bottom line of 
the staff, and where that bottom line represents G4, i.e. the G above middle C) has 
been added to the Uncommon Clefs section of the Clefs and Octave Lines 
panel. 

Coloring clefs. It is now possible to change the color of clef changes using the 
Color property in the Common group of the Properties panel. 
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Copy and paste 

A new Edit ▸  Paste Into Voice submenu has been added, making it possible to 
paste a selection consisting of notes and other items all belonging to a single voice 
into another voice, either one of the existing voices on the destination staff (in 
which case the pasted material will be merged with any existing material in the 
existing voice), or a new up-stem or down-stem voice. (STEAM-5420) 

Dynamics 

Dorico automatically groups abutting dynamics together when you create them, 
and grouped dynamics are aligned at the same vertical position below or above the 
staff, moving together if a note or other item protruding from the staff requires them 
to be moved from their default position to avoid a collision. 

When you paste an individual dynamic or a group of dynamics from one staff to 
another, at the same rhythmic position, the dynamics are linked between those 
staves, which means that if you edit one of the dynamics on one staff, the other 
instances of that dynamic on the other staves with which it is linked will 
automatically update. 

It is now possible to control both how dynamics are grouped and how dynamics 
are linked between staves. Select one or more dynamics, and use the appropriate 
item from the Edit ▸  Dynamics submenu, which can also be found in the context 
menu: 

 Group Dynamics: groups the selected dynamics together; if any of the 
selected dynamics are already part of a group, then the groups are combined 
into a single larger group. 

 Ungroup Dynamics: breaks the group of any selected dynamics; the group will 
be removed altogether. 

 Remove From Group: removes only the selected dynamic or dynamics from 
the group, leaving the rest of the group intact. 

 Link: links selected dynamics on multiple staves together, provided they are 
compatible, i.e. that they are at the same rhythmic position, and they are the 

same kind of dynamic (you cannot link, for example,  and ). 

 Unlink: unlinks the selected dynamics such that they are no longer linked to 
dynamics on other staves. If the selected dynamic is part of a group, the group 
itself is unlinked from the other staves, and can then be further edited 
independently. 

To show which dynamics are grouped and linked, when you select a dynamic, any 
other dynamics that are part of the same group or are linked to dynamics on 
another staff are drawn in blue, while the selected dynamic is drawn in the normal 
orange selection color. (STEAM-3528) 
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Engrave mode 

When editing frames, it is no longer possible to select any of the items within a 
music frame, for consistency with the other special editing tools in Engrave mode. 

It is now possible to use marquee selection for each of the special editing tools in 
Engrave mode, which makes it easier to select multiple frames, or multiple staff 
spacing handles, or multiple note spacing handles. (STEAM-5953) 

It is also now possible to navigate between frame handles using the arrow keys 
when editing frames in Engrave mode. Press Tab to switch between selecting 
either the whole frame, whose outline is now shown using a bolder line when 
selected, and selecting individual handles, which are shown as filled in when 
selected. (STEAM-5769) 

Fonts 

The Noto Sans JP font family is now installed along with Dorico, and is used as the 
default font family for text in new projects created in the Japanese language version 
of Dorico. (STEAM-5865) 

A new Default text font family option has been added to the General page of 
Preferences, which is set to Academico for all languages except Japanese, for 
which it is set to Noto Sans JP. Changing this option will change the font used by 
the Default text font font style and the Default text paragraph style, from which all 
of the other font, paragraph and character styles in your project inherit the font. 
(STEAM-5873) 

Font styles 

Font styles are used to define the appearance of various notations within Dorico: 
they are distinct from paragraph and character styles, which are used for text that 
you type into text frames or directly into the music using the Shift+X text tool. Font 
styles are used for things like lyrics, tempo marks, the text drawn in the middle of a 
glissando line, playing techniques, and so on. 

For font families that include extended styles or weights (such as condensed, light, 
semibold, etc.) can now be chosen in the Engrave ▸  Font Styles dialog, enabling 
the use of any weight or style of any font on your computer for items like lyrics. 

When opening projects created in earlier versions, Dorico will attempt to map the 
bold and italic flags that were used to choose bold, italic, or bold italic styles of the 
chosen font onto the most appropriate weight and style of the font. Note that in 
previous versions it was possible to choose a weight of a font that was not actually 
available, in which case the operating system would have synthesized a font style 
(e.g. if a bold weight was not available, choosing the bold option would cause a 
bold font to be generated on demand), which often looks poor. If a font style in an 
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older project requests a font weight that is not available, that font style will now be 
set to use the regular or normal weight of that font instead. 

Beware that Windows and macOS approach font naming in very different, and 
largely incompatible, ways. On Windows, the list of accessible styles is hardcoded 
to regular, italic, bold, and bold italic, which means that fonts with extended styles 
instead appear in the font menu as separate fonts – for example, Adobe’s Minion 
Pro font has regular and condensed widths, and on Windows these will appear as 
separate families, Minion Pro and Minion Pro Cond. On macOS, by contrast, a 
font like Minion Pro will appear as a single font family, with all the extended styles 
listed in the Style menu alongside regular, italic, bold, and bold italic. When moving 
projects between Windows and macOS computers, be aware that if you use one 
of the extended styles of a given font, you may need to edit the font style on the 
destination platform to ensure the expected style is used. (STEAM-5846) 

Instrument changes 

Multi-staff instruments. When a player has a combination of instruments assigned 
that includes both single- and multi-staff instruments, the option Allow individual 
staves of multi-staff instruments to be hidden (on the Vertical Spacing page of 
Layout Options) is now better integrated with hiding empty staves. When one or 
more staves of a multi-staff instrument are hidden, Dorico now correctly determines 
which staff or staves should be shown based on which staff next has any music 
written, to try to reduce the number of redundant changes from one staff to another 
on different systems. (STEAM-5688) 

Vertical position of labels. A new option Minimum distance above items outside 
staff for instrument change labels has been added to the Instrument Changes 
page of Engraving Options, controlling the vertical gap that Dorico should leave 
when an instrument change label is pushed away from the staff by an item 
protruding above the staff. (STEAM-5927) 

Key commands (STEAM-5977) 

You can now use your MIDI keyboard to trigger commands within Dorico. Ensure 
that you have a project open, then open the Preferences dialog and go to the Key 
Commands page. For the command to which you want to assign a MIDI trigger, 
click MIDI Learn, then play the note or chord or hit the button or pad that you want 
to be mapped to this command, and click Add MIDI Command to save the new 
trigger. Rotary controls and faders are not currently supported. 

Key signatures 

Signposts for key signatures. Key signatures that show no accidentals, such as a 
key signature of C major or A minor, or a change to such a key in a project in which 
cancellation naturals at key changes are not shown, now appear as signposts. To 
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hide these signposts, switch off View ▸  Signposts ▸  Key Signatures. Note that 
to copy and paste a key signature, or a passage of music including a key signature, 
the signpost must be visible and selected to be included in the copy and paste 
operations. (STEAM-5342) 

Naturals in custom key signatures. Custom key signatures can now include natural 
accidentals if needed. (STEAM-5645) 

Lyrics 

A new option Systems on which verse numbers appear has been added to the 
Verse Numbers group on the Lyrics page of Engraving Options, allowing you to 
specify whether verse numbers should be shown at the start of each line of lyrics 
only on the first system, or on all systems, as sometimes done in hymnals. (STEAM-
5735) 

MIDI import 

Instrument detection. The mapping of tracks in imported MIDI files onto 
instruments has now been significantly improved. (STEAM-6271) 

Clean lengths. The import of note durations has been significantly improved: notes 
that overlap or are separated by a small amount are now notated as abutting, rather 
than overlapping or separated by rests of very short durations. The detection and 
quantization of tuplet rhythms has also been significantly improved. 

MusicXML import 

A new MusicXML Import page has been added to the Preferences dialog, 
allowing you to choose what information should be retained when opening a 
MusicXML file as a new project or when importing it as a new flow into an existing 
project. 

Now that it is possible for you to choose what information is retained, Dorico now 
retains less information by default: explicit rests are not imported, meaning that rest 
grouping will use Dorico’s defaults; explicit accidentals are not imported, meaning 
that which notes show accidentals will be determined by the prevailing notation 
options; forced durations are not imported, meaning that how notes are broken up 
into tie chains will be determined by the prevailing notation options; and rest 
positioning is not imported, meaning that rests will be vertically positioned relative 
to the staff according to the prevailing notation options. 

Navigation 

A new Edit ▸  Go To submenu has been added, containing some basic commands 
for navigating around your project. Go To Bar, with the default key command 
Ctrl+G (Windows) or Command-G (Mac), allows you to navigate to a bar within 
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one of the flows in your project. Go To Previous Flow and Go To Next Flow 
navigate to the start of the previous or next flow. (STEAM-6115, STEAM-6116) 

Note input 

The perceived latency of input via MIDI keyboard is now much lower: the notes that 
you play on your keyboard are now echoed back to you immediately, rather than 
being played back at a fixed length after the note has been input. The echoed note 
may be transposed depending on the transposition of the instrument onto whose 
staff you are inputting, and the current state of the Write ▸  Input Pitch options. 
(STEAM-5290) 

Note spacing 

The option Minimum distance between adjacent rhythmic items on the 
Spacing Gaps page of Engraving Options now has a different effect than in 
previous versions. 

Previously the value specified by this option was almost never used in practice, 
because it was applied from the left-hand side of one spacing column and the left-
hand side of the next: because almost all spacing columns contain an item wider 
than this minimum (e.g. a notehead), in fact the distance between two items at 
adjacent rhythmic positions was a tiny value, around 1/20 of a space. This meant 
that, for all intents and purposes, that successive columns could practically touch. 
This was particularly noticeable, for example, with tightly-spaced notes on ledger 
lines, as the ledger lines would appear to touch. 

Now, the value is applied from the right-hand extent of one spacing column to the 
left-hand extent of the next, which ensures that successive rhythmic items – such 
as tightly-spaced notes on ledger lines – no longer appear to touch. (STEAM-
3803) 

Options 

Dorico’s five options dialogs – Layout Options, Notation Options, Note Input 
Options, Engraving Options, and Playback Options – all provide buttons to save 
the current set of options as the defaults for new projects. 

A suite of improvements in this update allow you to reset back to your saved 
defaults if you have made changes in the dialog that you later decide you want to 
discard; reset back to the factory defaults (i.e. ignoring your saved defaults); and 
remove your saved defaults so that new projects created thereafter will use the 
factory defaults. 

A new button Reset to Saved Defaults appears in the button bar at the bottom of 
each dialog; this button will read Reset to Factory if you have not yet saved any 
default settings for that dialog. If you have saved user defaults but want to reset to 
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the factory defaults instead, you can hold Ctrl (Windows) or Command (Mac) and 
click the button (which will instead say Reset to Factory while the Ctrl/Command 
key is held down). 

To remove saved defaults, if saved user defaults are found, holding Ctrl/Command 
will cause the Save as Default button to read Remove Saved Defaults instead, 
and clicking that button will delete the saved user defaults. (STEAM-5883) 

Ornaments 

The naming of the default ornaments shown in the Baroque and Classical section 

of the Ornaments panel has been corrected. , which was previously named 

“mordent”, is now named “short trill”; , which was previously named “inverted 

mordent”, is now named “mordent”. (STEAM-5849) 

The ornaments shown in Clavier-Büchlein vor Wilhelm Friedemann Bach by J.S. 
Bach have also been added to the Baroque and Classical section of the 
Ornaments panel, together with the Haydn ornament, the long schleifer ornament, 
and a few of the more common ornaments used by Couperin. 

Page layout 

Copying frames between pages. When editing a pair of master pages, you can 
now copy the layout from the left-hand page to the right-hand page or vice versa 
by clicking the appropriate L→R or R←L button in the toolbar at the top of the 
master page editor. 

Furthermore, you can also copy any selected frame or frames to other pages in 
your layout as follows: 

 Enable the frame editing tool by clicking the switch at the top of the Frames 
section of the left-hand panel in Engrave mode. 

 Select the frame or frames you want to copy to another page. 
 Select the page or pages to which you want the selected frames to be copied in 

the Pages panel on the right-hand side. Select multiple pages using Ctrl+click. 
 Right-click in the Pages panel to show the context menu, and choose Copy 

Selected Frames to Selected Pages. (STEAM-5813) 

Moving page overrides. It is now possible to move multiple selected overridden 
pages in the Pages panel in Engrave mode and move them earlier or later, which 
swaps the selected range of overridden pages with the pages immediately to their 
left or right. To move a range of pages by a larger distance, right-click the Pages 
panel and choose Move Pages from the context menu to open a simple dialog 
from which you can choose the page before or after which the selection of pages 
should be moved to. (STEAM-6196) 
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Disabling automatic adjustment of staff spacing. If you would prefer Dorico never 
to adjust the distances between staves and systems from the ideal values specified 
in Layout Options, switch off the new Automatically resolve collisions between 
adjacent staves and systems option in the Minimum Gaps section of the 
Vertical Spacing page. (STEAM-6229) 

Improved vertical justification. When justifying the gaps between systems, Dorico 
now considers whether the distance between successive systems is already larger 
than the ideal distance specified on the Vertical Spacing page of Layout Options, 
and if so, it prefers to add the remaining unjustified space between systems that 
currently have smaller gaps, to produce an overall more even result. (STEAM-
6197) 

Playback 

Score following during playback. Dorico now automatically moves the music to 
keep the playhead in view during playback in Setup, Write and Engrave modes. 
(STEAM-3943) 

VST 2.x plug-ins. The process of whitelisting VST 2.x plug-ins so that they can be 
used with Dorico has been simplified. Firstly, in addition to the default 
vst2whitelist.txt file that is included with your Dorico installation, listing those VST 
2.x plug-ins that Steinberg have qualified for use with Dorico, a second 
vst2whitelist.txt file can now be loaded from a user-specific location that will not 
be overwritten if you subsequently update or reinstall Dorico. When Dorico starts 
up, it reads both the default whitelist file and your user-specific whitelist file to build 
up the list of whitelisted plug-ins. 

If you want to whitelist any VST 2.x plug-ins that are not included on the default 
whitelist, you should place your own vst2whitelist.txt file here: 

 Win: C:\Users\username\AppData\Roaming\Steinberg\VSTAudioEngine_64 
 Mac: /Users/username/Library/Preferences/VSTAudioEngine 

Secondly, the vst2whitelist.txt file now need contain only the filename of the VST 
plug-in to be whitelisted, minus its file extension (.dll on Windows and .vst on 
Mac), with the name of each plug-in on its own line in the text file. (AD-293) 

Dynamics playback. Playback sounds in the HALion Sonic SE library provided with 
Dorico that use VST Note Expression for dynamics (including saxophone, choir, 
and others) now use MIDI controller 11 (Expression) by default, which allows them 
to play dynamics until Dorico supports VST Note Expression, which is planned for 
a future update. (STEAM-5933) 
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Playing techniques 

Creating playing techniques. It is now possible to input a playing technique either 
via the Shift+P popover or the Playing Techniques panel while the caret is visible: 
the chosen playing technique will appear immediately after it is input, rather than 
only appearing once a note or chord has been input at that rhythmic position. 
(STEAM-4943) 

Additional playing techniques. Some new playing techniques are available in new 
projects, including m.d./m.s. (mano destra/mano sinistra) in the Keyboard section, 
text versions of the common mutes in the Brass section, con bocca chiusa in the 
Vocal section, and air/Aeolian/key clicks in the Wind section. 

Rests 

It is now possible to nudge a selected rest up or down by a small amount using the 
Offset Y property in the Common group of Properties, which appears only in 
Engrave mode. For dotted rests, only the main rest shape will be affected by the 
offset, so the rhythm dot or dots will remain in the space in which they are currently 
positioned. If you need to move a rest by one or more whole spaces, use the Rest 
pos. property in the Notes and Rests group instead: when using this property, 
rhythm dots will snap to the space closest to the rest. (STEAM-6350) 

Selections 

Where two or more items overlap, or are superimposed, it is now possible to select 
each item in turn by hold Alt+Shift and clicking. (STEAM-3816) 

Slurs 

 A new Tied Notes group has been added to the Slurs page of Engraving 
Options, with options to determine whether slurs should start or end on the first 
or last note in the tie chain. These options can also be overridden for an 
individual slur by setting the Start pos. on tie chain or End pos. on tie chain 
properties as appropriate. (STEAM-5144, STEAM-6024) 

 A new option Slurs starting on the last note or ending on the first note of a 
beamed group has been added to the Endpoint Positioning group of the 
Slurs page of Engraving Options, allowing you to specify whether slur 
endpoints should be positioned as if the notes are unbeamed (in which case the 
slur endpoint will be positioned closer to the notehead) or as if they are beamed 
(in which case it will be positioned closer to the stem tip). (STEAM-5772) 

 When adjusting the position of either end of a slur in Engrave mode with the 
mouse, you can hold Alt to rotate the slur instead of moving only the selected 
endpoint, which maintains the slur’s shape. (STEAM-5770) 

 The calculation used for Maximum angle for slurs is now relative to a 
horizontal slur, rather than relative to the angle between the first and last note 
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under the slur. A new option Maximum angle for cross-staff slurs has also 
been added, set to a larger angle by default. (STEAM-5771) 

Staff labels 

A new option Minimum indent for systems with staff labels has been added to 
the Staves and Systems page of Layout Options. When a system is set to show 
staff labels, now the indent of the system is determined by the width of the widest 
staff label or the value of this option, whichever is the wider; if this is the first 
system, then the value of Indent first system of flow is then added on top. In this 
way, it is possible to obtain a uniform indent for each system even when the staff 
labels change. (STEAM-6026) 

Staves 

A new Custom Staff Size dialog has been added to the Edit ▸  Staff Size 
submenu, allowing you to change the size of the staves belonging to a player to 
any percentage scale factor. Select any note or chord in any of the staves 
belonging to the player whose staves you want to resize, then open this dialog. 

 

Choose one of the preset sizes from the Rastral size menu, or specify a custom 
scale percentage. The resulting staff size is shown in the preferred unit of 
measurement (as specified in Preferences). Click OK and the sizes of all the staves 
belonging to the instruments held by that player are updated. (STEAM-5659) 

Text 

System text. It is now possible to create text items that will appear at the system 
object positions defined on the Players page of Layout Options, and in all layouts, 
by choosing Write ▸  Create System Text, which has the default key command 
Shift+Alt+X. System-attached text also splits multi-bar rests. (STEAM-5583) 

Font size in part layouts. Each paragraph style can now optionally define a 
separate size for part layouts. (STEAM-5582) 

Time signatures 

Inserting time signatures. When adding a time signature with Insert mode switched 
on, time is inserted before any later time signature to ensure that the bar prior to 
the later time signature is always the correct length. (STEAM-6279) 
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Dashed barlines in aggregate time signatures. When creating an aggregate time 
signature, where a sequence of time signatures exists within a single bar, you can 
choose whether the subdivisions within the bar should be separated with a dashed 
barline when creating the time signature in the Shift+M popover. To show the 
dashed barline, separate each time signature with | (pipe); to hide the dashed 
barline, instead use : (colon). By way of example, 4/4|3/4 will show a dashed 
barline, while 2/4:3/4 will not. (STEAM-5633) 

Tokens 

It is now possible to use tokens that correspond to specific flows inside text 
frames. For example, to show the title of the third flow, use the token 
{@flow3title@}. To find out what number to insert in the token, look at the Flows 
panel in Setup mode, which shows the flow number in the bottom right-hand 
corner of the block corresponding to each flow. (STEAM-5818) 

Tuplets 

A new Repeated Tuplets group has been added to the Tuplets page of 
Engraving Options, containing new options that allow the tuplet ratio and bracket 
for successive identical tuplets to be hidden automatically. To hide such tuplets, 
set Successive tuplets of the same unit and ratio to Hide ratio and bracket; 
the tuplet ratio and bracket of repeated tuplets will then be hidden after the number 
of tuplets specified in Number of repeated tuplets before ratio and bracket can 
be hidden have been encountered. The final option in this group allows you to 
specify whether tuplets should continue to be hidden if the pattern of repeated 
tuplets is broken, for example by a rest or notes not part of the tuplet pattern. 
(STEAM-5734) 

User interface 

 A new View ▸  Zoom ▸  Custom Zoom dialog has been added, with key 
command Alt+Z (also accessible by clicking the little magnifying glass icon in 
the status bar, next to the button showing the current zoom level), allowing you 
to quickly zoom to any magnification. Type Alt+Z to open the dialog, type the 
desired zoom level (or use the up and down arrows to increase or decrease the 
current zoom level in increments of 25%), and hit Return to confirm the change. 
(STEAM-5783) 

 The operation of the hand tool has been improved: when using the hand tool to 
move the music around on the screen, the selection is not changed, which 
makes it practical to use the hand tool to make a selection that ends outside the 
current view. (STEAM-5918)  

 When attempting to open a project that is already open, a window belonging to 
that project is now brought to the front. (STEAM-5709) 
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 An extra page has been added to the end of the guided tour for each mode, 
telling you how to view it again. If you would like to review the guided tour for 
any of Dorico’s five modes, simply choose Help ▸  Guided Tour. (STEAM-
5509) 

 Window ▸  Previous Mode is now implemented, allowing you to quickly toggle 
between the current mode and the previously chosen mode. You can also 
assign a key command to this function in Preferences for quicker access. 
(STEAM-5981) 

 A new option Double-click in Setup or Engrave mode switches to Write 
mode has been added to the General page of Preferences. Switch this option 
off if you would prefer that double-clicking within a music frame in Setup or 
Engrave mode should not switch to Write mode and start note input. (STEAM-
4529) 

 It is now possible to assign key commands to the three special editing modes in 
Engrave mode, i.e. frame editing (Edit, Edit Frames), staff spacing (Engrave, 
Edit Staff Spacing), and note spacing (Edit, Edit Note Spacing). (STEAM-
5815) 

 Properties that properly apply only to music in a specific frame chain are no 
longer misleadingly shown as if they apply when viewing music in galley view. 
(STEAM-6261) 

 It is now possible to use comma (,) as a decimal separator in the spin controls 
that display spaces in fractional values in the Properties panel and the options 
dialogs. (STEAM-6251) 

Voices (STEAM-5201) 

New options have been added to the Edit ▸  Voice submenu: 

 Swap Voice Contents swaps the voices used by the notes and chords in the 
selection. 

 Change Voice allows you to change the voice used by the notes and chords in 
the selection, listing the voices already in use on the staff (in which case the 
selected notes and chords will be merged into the existing notes and chords of 
that voice), and allowing you to change notes into a new up-stem or down-stem 
voice as needed. 

Both editing operations affect only the first selected instrument: if you select music 
from multiple instruments, the remaining instruments’ music will be unaffected. 

Furthermore, Swap Voice Order (which changes the graphical order of opposing 
two voices, allowing you to position them either head-to-head or stem-to-stem as 
you wish) has been moved from the Edit ▸  Stem submenu to the Edit ▸  Voice 
submenu. 
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Performance 

Deleting and reordering flows in Setup mode is now significantly faster. (STEAM-
5643) 

Installation 

When downloading Dorico via the Steinberg Download Assistant, Dorico is now 
delivered as three separate packages for your convenience: the main application 
installer, the HALion Sonic SE plug-in and its content, and the HALion Symphonic 
Orchestra content. It is still strongly recommended that all three packages should 
be installed on your computer for correct operation of Dorico. Even if you already 
have HALion Sonic SE or HALion Symphonic Orchestra installed, it is 
recommended that you run the installers provided with Dorico, as they may include 
required updates to the plug-ins or content. Your existing installation will be 
detected and updated to avoid duplicating the content on your system. 

Troubleshooting 

A new option Help ▸  Create Diagnostic Report has been added, which creates 
an archive called Dorico Diagnostics.zip and saves it to your desktop. If you are 
encountering any technical problems when using Dorico relating to the application 
crashing, or problems with audio and playback devices, please consider including 
the Dorico Diagnostics.zip file when you contact support or when you post your 
query to the user forum, as this archive contains useful information that may allow 
Steinberg staff to diagnose and resolve your problem more quickly. 
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Issues resolved 
ID # Component Issue 

STEAM-5488 
Arpeggio 
signs 

Copying and pasting music with arpeggio signs now correctly retains the arpeggio signs in 
the pasted material. 

STEAM-5549 
Arpeggio 
signs 

Arpeggio signs are no longer incorrectly removed when using the Change Instrument 
feature to change one instrument held by a player into another. 

STEAM-5800 
Arpeggio 
signs 

Adding a cross-staff arpeggio sign in situations where either or both staves include notes 
in multiple voices now correctly creates the arpeggio across all voices. 

STEAM-5896 Articulations 
Articulations no longer incorrectly avoid ties that are on the opposite side of the notehead 
to the articulations themselves. 

STEAM-5118 Bar numbers 
Bar numbers drawn at the start of the system no longer incorrectly move horizontally when 
a start repeat barline appears at the start of the system. 

STEAM-5332 Barlines 
Special barlines no longer show a redundant time signature signpost if they do not also 
coincide with a change of time signature. 

STEAM-6172 Barlines Start repeat barlines at the start of the flow now draw as expected in galley view. 

STEAM-6224 Barlines 
Adding a barline (e.g. a double or start repeat barline) with an existing barline selected no 
longer causes the new barline to be added one bar later than expected. 

STEAM-4768 Bars 
Adding bars via the Shift+B popover now correctly considers the prevailing alternating 
time signature, if any. 

STEAM-5705 Bars 
Deleting bars via the Shift+B popover now correctly considers any ongoing octave lines, 
lyrics, and grouped dynamics. 

STEAM-6163 Bars 
When deleting bars via the Shift+B popover, a time or key signature at the beginning of 
the first bar to be deleted, that time or key signature is no longer deleted. 

STEAM-6267 Bars 
If the caret is positioned in the middle of a bar when deleting bars via the Shift+B popover, 
the bar in which the caret is positioned is now completely deleted. 

STEAM-5592 
Brackets and 
braces 

Creating, deleting or otherwise editing a player group in Setup mode now correctly 
updates the brackets and braces in the score immediately. 

STEAM-4751 Dynamics 
The handles that appear in Engrave mode for hairpins have been improved, such that they 
follow the mouse more closely during drag operations. 

STEAM-5295 Dynamics 
Cutting and pasting dynamics that are part of a group now works more reliably, with the 
dynamics offset correctly when pasted. 

STEAM-5295 Dynamics Cutting and pasting dynamics that are linked together now works more reliably. 

STEAM-5761 Dynamics 
Using Alt+click to repeatedly copy dynamics no longer results in duplicate dynamics being 
created. 

STEAM-5971 Dynamics 
Dynamics at grace note rhythmic positions now track the mouse pointer correctly when 
dragging them in Engrave mode. 
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ID # Component Issue 

STEAM-6123 Dynamics 
When entering dynamics into the Shift+D popover while the caret is visible, advancing the 
popover with Space will now correctly only extend a hairpin if it was the final dynamic 
entered into the popover. 

STEAM-4813 Flows Adding more than 79 flows to a single project no longer causes a crash (Windows only). 

STEAM-6169 Grace notes 
Attempting to set the Grace note before barline property on a grace note at the very start 
of the flow no longer causes Dorico to crash. 

STEAM-5731 
Holds and 
pauses 

Fermatas on barlines now draw in the correct position relative to barlines on single-line 
percussion instruments. 

STEAM-5732 
Holds and 
pauses 

Fermatas on barlines are now positioned correctly if the barline results from a local time 
signature (i.e. one specific to a single staff). 

STEAM-5733 
Holds and 
pauses 

The option Gap to right of caesura in the Horizontal Position group of the Holds and 
Pauses page of Engraving Options now works as expected. 

STEAM-6104 
Holds and 
pauses 

Reset Position now takes effect immediately for a selected fermata, caesura or breath 
mark, rather than only appearing to take effect after another nearby edit. 

STEAM-6117 
Holds and 
pauses 

A problem whereby a fermata over a barline could drift further and further away from the 
staff during editing in galley view has been resolved. 

STEAM-6147 
Holds and 
pauses 

Fermatas positioned on barlines now break multi-bar rests in the correct position. 

STEAM-5644 
Instrument 
changes 

A redundant key signature no longer appears if the point at which an instrument change 
occurs coincides with a key change. 

STEAM-5686 
Instrument 
changes 

Changing between a multi-staff instrument and a single-staff instrument no longer 
unnecessarily shows a clef if one of the staves is hidden because it is empty, and it shows 
the same clef as the existing staff. 

STEAM-5757 
Instrument 
changes 

When an instrument change occurs at the end of a system, the required clef change and, if 
the transposition of the new instrument is different, the required key signature now 
correctly appear. 

STEAM-5758 
Instrument 
changes 

If all the notes belonging to an instrument in a given system have been crossed to another 
staff, and the option to allow some staves belonging to an instrument to be hidden is 
enabled, the destination staff is now shown correctly, so that the notes appear. 

STEAM-5765 
Instrument 
changes 

A problem whereby redundant instrument change labels would appear during note input 
close to the point at which the instrument transition occurs has been resolved. 

STEAM-5777 
Instrument 
changes 

When one staff of a grand staff instrument is hidden and the single staff shown changes 
from one system to the next, Dorico no longer shows redundant clef changes. 

STEAM-4787 
Key 
signatures 

It is now possible to add microtonal accidentals when using a traditional Western key 
signature, provided the current tonality system’s EDO value is divisible by 12. 

STEAM-6301 
Key 
signatures 

Under rare circumstances, deleting a key signature on a single staff could cause a crash. 
This problem has now been resolved. 

STEAM-5859 Layouts 
Layouts whose names have not been explicitly overridden will now correctly update when 
the instruments attached to their associated players are changed after a project has been 
saved and reopened. 
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ID # Component Issue 

STEAM-5928 Localization 
Some key commands that were defined in the English version of Dorico but were missing 
from the localized versions have now been restored. 

STEAM-6221 Localization 
The names of font, paragraph and character styles are now correctly translated in the 
relevant editing dialogs. 

STEAM-6289 Localization 
When running in a language other than English, OS-provided dialogs such as Open and 
Save are now fully translated (Mac only). 

STEAM-6268 Lyrics 
In rare circumstances, dragging a lyric hyphen could cause Dorico to crash. This problem 
has now been resolved. 

STEAM-6269 Lyrics 
Lyric extender lines and hyphens now draw in the correct positions if they cross a system 
break in the middle of a bar, or in open meter. 

STEAM-4171 MIDI import The detection and quantization of tuplets in MIDI files has been significantly improved. 

STEAM-5285 Mixer 
The Mixer window now correctly updates immediately in response to changes to players 
and instruments made in Setup mode. 

STEAM-6217 
Multi-bar 
rests 

Multi-bar rests will no longer collide with key signatures or time signatures at either end of 
the bar when spacing is tight. 

STEAM-6347 
Multi-bar 
rests 

Multi-bar rests are now positioned correctly above single-line percussion instruments. 

STEAM-6369 
Multi-bar 
rests 

A double or other special barline in the middle of a bar now correctly causes a multi-bar 
rest to be split. 

STEAM-4892 
STEAM-5807 

MusicXML 
import 

Numbered instruments are now imported more intelligently from MusicXML files. 

STEAM-6089 
MusicXML 
import 

The Ends voice property is no longer set on the final note in each voice in an imported 
MusicXML file, which could cause rests not to appear when adding more music at the end. 

STEAM-5706 Navigation 
Navigating with the right arrow in galley view no longer sometimes fails to navigate onto a 
rest. 

STEAM-5710 Navigation 
Navigating with the up and down arrows in a single-staff layout in galley view will no longer 
sometimes incorrectly navigate horizontally. 

STEAM-1995 Note input 
Using chord mode to add notes to existing notes and chords no longer incorrectly removes 
articulations that were originally present. 

STEAM-4869 Note input 
Using Alt+left/right to move notes by the current rhythmic grid resolution now handles 
tuplets correctly. 

STEAM-5234 Note input 
Inputting a rest by playing a note or chord on a MIDI keyboard with rest input engaged 
after having previously input a chord now correctly inputs a rest, rather than the note or 
chord played. 

STEAM-5571 Note input 
Creating octave lines, gradual tempos, and gradual dynamics based on the selection now 
always produces a line of the expected duration at the rhythmic start of the selection. 

STEAM-5678 Note input 
Step input from a MIDI keyboard no longer causes a crash when inputting into a score 
using a tonality system other than 12-EDO. 
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ID # Component Issue 

STEAM-5805 Note input 
Changing the order of players in Setup mode is now correctly reflected in the order in 
which staves are visited when you move the caret up and down between staves in galley 
view. 

STEAM-5805 Note input 
Changes made to the order of players and instruments in Setup mode are now correctly 
reflected in the order in which staves are navigated by the caret during note input in galley 
view. 

STEAM-5950 Note input 
Double-clicking a note above the top of the top staff or below the bottom staff in the 
system now shows the caret correctly. 

STEAM-5952 Note input 
Deleting a tuplet with an expanding ratio (e.g. 2:3 rather than 3:2) no longer incorrectly 
deletes any adjacent tuplets. 

STEAM-6041 Note input 
Moving the caret left now always correctly navigates to the nearest rhythmic grid position, 
rather than to the last note in the voice. 

STEAM-6234 Note input 
Copying and pasting system and frame breaks, and note spacing changes, from one layout 
to another now retains the relevant properties in the new copies. 

STEAM-6246 Note input 
Using a MIDI keyboard to input notes in a layout-specific music frame would previously 
ignore the accidentals played on the keyboard. This problem has now been resolved. 

STEAM-6246 Note input 
Using a MIDI keyboard to input into a layout-specific frame chain (rather than the main 
music frame chain from the master page) now inputs notes with accidentals correctly. 

STEAM-6319 Note input 
Using Alt+up/down arrow to change the pitch of notes in a frame chain with a player filter 
applied now works correctly. 

STEAM-5812 Noteheads 
When copying and pasting notes that use a different notehead type, the changed 
notehead type is now correctly retained in the pasted material. 

STEAM-5843 Notes 
It is now possible to set the stem direction of a note in a project created by importing a 
MusicXML file directly, without first removing its forced stem direction. 

STEAM-5720 Octave lines 
It is now possible to nudge octave lines using Alt and the arrow keys (or use Ctrl+Alt for 
larger steps) in Engrave mode. 

STEAM-6078 Octave lines 
Under rare circumstances it was possible for dotted octave lines of a certain length to 
draw as solid lines. This problem has been resolved. 

STEAM-5878 Ornaments 
Changing an existing glissando line from drawing with a straight line to drawing with a 
wiggly line now correctly immediately updates the appearance of the line. 

STEAM-4497 Page layout 
Setting the Space size property on a system or frame break now results in the initial value 
(of 4.96pt, equivalent to a 7mm/0.28” staff) taking effect immediately. 

STEAM-5535 
STEAM-5911 

Page layout 
Editing the Wait for next frame/system break properties for a selected frame or system 
break now causes the casting-off of the layout to be updated immediately. 

STEAM-5624 
STEAM-5826 

Page layout Changing the order of frames within a chain of music frames now works reliably. 

STEAM-5669 Page layout 
Deleting a flow in a project with multiple flows no longer sometimes causes all music in a 
layout to stop drawing, if one of the music frame chains in the layout was set to show only 
the flow that has subsequently been deleted. 



 

 
Dorico Version History Page 103 Steinberg Media Technologies GmbH 

ID # Component Issue 

STEAM-5755 Page layout 
Under some circumstances, changing the vertical position of a rest could incorrectly cause 
the staff spacing to widen, or dynamics to move unnecessarily. These problems have been 
resolved. 

STEAM-5819 Page layout 
Under rare circumstances, it was possible for Dorico to crash when changing the frame 
chain to which a music frame belongs. This problem has been resolved. 

STEAM-5910 Page layout 
Inserting blank pages before the page containing the first page of a flow no longer 
sometimes causes the start of the flow to be missing from the music frame chain. 

STEAM-5923 Page layout 
Locking the contents of a single music frame containing music from multiple flows now 
works correctly. 

STEAM-5930 Page layout 
Attempting to lock a system or frame with a system or frame break signpost selected will 
no longer cause a crash. 

STEAM-6151 Page layout 
Lock System will no longer lock the wrong system if you select a clef, key signature, or time 
signature at the end of the system to specify the end of the system to be locked. 

STEAM-6311 Page layout 
After adjusting staff spacing, undo now correctly only undoes the last spacing adjustment, 
rather than clearing spacing adjustments. 

STEAM-6317 Page layout 
Under some circumstances, deleting an item that causes the casting-off of the music to 
change, then undoing that deletion, would not return to the original casting off. This is fixed. 

STEAM-5760 Performance 
When your computer is connected to wifi, Dorico no longer polls the available networks 
every 10 seconds, which can in some circumstances result in high network latency. 

STEAM-5963 Play mode 
When a note is partially scrolled out of view in the event display in Play mode, it no longer 
incorrectly shows a border at its left-hand side, making it appear it starts at that position. 

STEAM-6063 Play mode 
Changing the settings in an instrument’s track header no longer incorrectly causes the 
event display to scroll back to the beginning. 

AD-244 Playback 
A problem whereby the ports in the chosen audio device could become disconnected, 
causing no sound to be heard on playback, has been fixed. 

STEAM-4803 Playback 
When choosing a different audio device in the Device Setup dialog, the list of sample 
rates is now correctly updated to show the sample rates supported by the active device. 

STEAM-4806 Playback 
If you attempt to choose an audio device that is currently unavailable in Device Setup, 
Dorico will no longer incorrectly show you that this device is chosen, instead showing you 
the device that is actually in use. 

STEAM-5553 Playback 
Articulations such as staccato, accent etc. now only affect notes in the voice to which they 
belong. 

STEAM-5718 Playback Short appoggiaturas before dotted notes now play back with the correct length. 

STEAM-5719 Playback 
Grace notes before the beat now always correctly truncate the preceding rhythmic note in 
playback. 

STEAM-5727 Playback 
Short (unmeasured) grace notes that coincide with a change of tempo now play back with 
the correct length. 

STEAM-5748 Playback 
Notes played as keyswitches defined in expression maps for octave-transposing 
instruments are no longer themselves incorrectly transposed by one or more octaves. 
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ID # Component Issue 

STEAM-5749 Playback 
Measured two-note tremolos now play back with the correct duration for notes of an eighth 
(quaver) and shorter in duration. 

STEAM-5756 Playback 
When multiple projects are open, the playhead now only moves in the project that is 
playing back. 

STEAM-5837 Playback 
The playhead no longer incorrectly jumps back to the start of the system it has just finished 
playing before proceeding to the next system. 

STEAM-5407 Playback 
Hitting the button to rewind to the beginning in the Transport during playback now 
correctly restarts playback from the start of the flow. 

STEAM-5851 
STEAM-5802 

Playback 
Notes with tremolos or arpeggio signs within slurs no longer sometimes fail to play back 
correctly because of the Playback Options to humanize the start positions of notes. 

STEAM-5982 Playback 
After changing the endpoint for an instrument in Play mode, manually assigning an 
endpoint for a newly-created instrument would result in no playback. This problem has now 
been fixed. 

STEAM-5982 Playback 
Players and instruments added to your project after you have overridden the VST 
instrument or MIDI output used by an existing instrument in your project will now be played 
back correctly. 

STEAM-6072 Playback 
MIDI program changes defined as actions in VST Expression Maps are now output 
correctly during playback. 

STEAM-6128 Playback 
Program changes arising from switches in VST Expression Maps are now output before all 
notes at that rhythmic position. 

STEAM-6290 Playback 
If you start playback immediately after selecting a note, that note no longer sometimes 
incorrectly holds on after playback has started. 

STEAM-5747 Players 
Single letters such as I or A at the end of an instrument’s name will no longer incorrectly be 
interpreted as a Roman numeral and converted into a number. 

STEAM-4942 
Playing 
techniques 

Changing the properties of one or more selected playing techniques now correctly 
updates the appearance of the playing technique across its whole range. 

STEAM-4943 
Playing 
techniques 

When entering playing techniques using the Shift+P popover during note input (i.e. when 
the caret is visible), the chosen playing technique now appears immediately after 
confirming the popover, rather than after a note has been input at that rhythmic position. 

STEAM-5768 
Playing 
techniques 

Text playing techniques are no longer incorrectly scaled to a smaller size when attached to 
grace note positions. 

STEAM-5389 Printing 
When selecting multiple layouts to be printed or to be exported as graphics, all pages of all 
selected layouts are now correctly printed or exported under all circumstances.  

STEAM-5791 Printing 
Rests are no longer incorrectly printed in color when the View options to show Voice 
colors or Implicit rests are switched on. 

STEAM-5561 Rests Setting the color of a bar rest via Properties now correctly updates the score immediately. 

STEAM-5701 Rests 
Changing the number of empty bars at the end of a flow no longer incorrectly causes the 
tacet al fine multi-bar rest to disappear if shown. 
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ID # Component Issue 

STEAM-5680 Selections 
Using Shift+left/right arrow to extend block selections now works in any music frame 
chain, not only the main music frame chain from the master page. 

STEAM-6320 Selections 
Select All now works correctly in any music frame chain, not only the main music frame 
chain from the master page. 

STEAM-5746 Slurs 
Setting the End offset property for a single-segment slur no longer incorrectly also sets 
the End handle offset property. 

STEAM-5832 Slurs 
It is no longer possible to create zero-length slurs (for example, by selecting multiple notes 
of the same chord and hitting S), which can cause the placement of other items, like 
articulations, to be incorrect. 

STEAM-6134 Slurs 
It is no longer possible to create linked slurs across multiple staves that do not start and 
end at the same rhythmic position. 

STEAM-5101 Staff labels 
Changing the Staff labels paragraph style now correctly updates the appearance of the 
staff labels in the score. 

STEAM-4614 Tempo 
Tempo marks are now correctly aligned at the start of a bar with a special barline but no 
time signature. 

STEAM-5693 Tempo 
If a tempo item’s properties are set such that no printable text will appear (e.g. the text is 
empty, and the metronome mark is hidden), a signpost will now always appear. 

STEAM-6113 Tempo Tempo marks are no longer sometimes incorrectly offset to the right in galley view. 

STEAM-5552 Text 
Double-clicking a text item in Setup or Engrave mode now switches to Write mode before 
opening the editing popover. 

STEAM-5856 Text 
Changing the name of a player in Setup mode now correctly immediately updates any text 
items in the score that are using the {@playerName@} token. 

STEAM-5875 Text 
Changing a font style now correctly shows the effect on any styles that inherit from it 
without having to confirm and reopen the Font Styles dialog. 

STEAM-5786 
Time 
signatures 

If a bar is split either side of a system break, the time signature no longer incorrectly draws 
at the start of the second system. 

STEAM-5890 
Time 
signatures 

The signpost text that appears for an aggregate time signature now correctly shows the 
broken pipe character that indicates the dashed barline subdivisions between the different 
time signatures. 

STEAM-6020 
Time 
signatures 

The Pick-up bar of control in the Create Time Signature section of the Time Signatures 
panel now correctly creates a pick-up bar using the beat length of the time signature to be 
created, not a fixed quarter note (crotchet) beat length. 

STEAM-5745 Tremolos Strokes on one-note tremolos no longer sometimes draw too close to the notehead. 

STEAM-5696 Tuplets 
The ratio for a hidden tuplet number shown in the signpost now matches the ratio that will 
be shown when the tuplet number is shown, rather than its lowest common denominator. 

STEAM-5704 Tuplets 
If tuplets are hidden by way of the options in Engraving Options, an appropriate signpost 
will now always appear. 
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ID # Component Issue 

STEAM-2201 
STEAM-1786 

User interface 
All items in Dorico’s panels now draw at the correct high-resolution pixel density on high-
DPI or Retina displays. Previously some panel items were still drawing in low resolution. 

STEAM-5299 User interface 
The Expression Maps dialog now correctly shows which expression map is loaded when 
the dialog opens by selecting it in the left-hand list. 

STEAM-5517 User interface 
To make it clear that you cannot transpose up or down when transposing by a unison, but 
rather can only transpose by a quality, e.g. augmented or diminished, the Up and Down 
buttons are now disabled in Write ▸  Transpose when transposing by a unison. 

STEAM-5604 User interface 
Entering or exiting full screen mode by clicking the green traffic light button in the window 
title bar now correctly updates the checked state of the View ▸  Full Screen menu item. 

STEAM-5614 User interface 
Key commands edited in the Preferences dialog when only the Hub window is open rather 
than a project window now correctly take effect immediately, rather than only taking effect 
when a project window is opened. 

STEAM-5715 
STEAM-6095 

User interface 
The Expression Maps dialog now shows the correct information for the initially selected 
expression map when the dialog opens. 

STEAM-5717 User interface 
The guided tour is now correctly triggered for the mode a project opens in, rather than 
waiting until the user changes mode to trigger the tour. 

STEAM-5793 User interface 
The spin box showing the chosen channel in the track header in Play mode is now wide 
enough to show channel numbers higher than 9. 

STEAM-5891 User interface 
Under some circumstances it was possible for changes made in one options dialog to be 
incorrectly applied to another open project, if the corresponding options dialog was also 
open for that project. This problem has been resolved. 

STEAM-5892 User interface 
It is now possible to use undo and redo (and other key commands) while a modeless 
options dialog is in focus. 

STEAM-5898 User interface 
Moving the focus between the two panes of a horizontally or vertically split view now 
correctly updates the state of Dorico’s menus immediately. 

STEAM-5901 User interface 
Changing the selected layouts and flows in Layout Options and Notation Options 
respectively now always ensures that the option values shown in the dialog reflect the 
current selection of layouts or flows. 

STEAM-5984 User interface 
When you remove a player from a flow in Setup mode, you will now be prompted that 
completing this operation will delete the player’s music, and ask you to confirm the action. 

STEAM-6135 User interface 
Some minor problems with assigning playing techniques in the Expression Maps dialog 
have been resolved. 

STEAM-6166 User interface 
Repeated key commands that include a modifier (e.g. holding down Alt+left arrow) are no 
longer sometimes interpreted as if the modifier is not held down (Mac only). 

STEAM-6191 User interface 
Dragging a tab from one group to another within the project window (i.e. with a horizontal 
or vertical split) now correctly activates the tab immediately after the drag is completed. 

STEAM-6206 User interface 
Dorico will no longer crash if you attempt to undo with the Steinberg Hub window in focus, 
or if the current tab in the project window does not contain a layout. 

STEAM-6250 User interface 
Attempting to save default options from one of Dorico’s options dialogs will no longer 
crash if the user application data folder is non-writable. 
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ID # Component Issue 

STEAM-6281 User interface 
Enabling editing of frames, staff spacing, or note spacing, or switching back into Engrave 
mode with one of these tools active, now correctly clears any selection from Write mode. 

STEAM-6283 User interface 
When deleting a flow from the Flows panel in Setup mode, Dorico no longer incorrectly 
changes the selection in the panel, making it appear as if the wrong flow will be deleted. 

STEAM-6349 User interface 
Moving one or more players up or down in the custom player order list on the Players 
page of Layout Options now always keeps the selected players in view. 

STEAM-5795 Views 
A problem whereby some items could move further and further away from the staff while 
the music is being edited in galley view has been resolved. 

STEAM-5926 Views 
It is no longer possible to set a non-percentage zoom level (such as zooming to page width 
or height) in galley view. 
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Dorico 1.0.30 

February 2017 

This version contains the following improvements and issue resolutions. 

Improvements 

Accidentals 

Accidentals are now listed in the Accidentals section of the Key Signatures and 
Accidentals panel in Write mode in order of ascending pitch delta (i.e. accidentals 
that lower the pitch are listed before those that raise the pitch). (STEAM-5545) 

Auto-backup 

Dorico now makes a backup copy of your project each time you save it. By default, 
backups are stored in a folder called Backup Projects inside your chosen save 
location (which is, by default, a folder called Dorico Projects in your user 
account’s documents folder). A subfolder inside the backup location is created for 
each project, and each time you save, that version is timestamped and placed in 
that location. To conserve disk space, Dorico will keep only five backups of each 
project by default, with the oldest backup being deleted as each new backup is 
created. You can change the number of backup projects saved by setting Number 
of backups per project in the Files group of the General page of Preferences. 

To open a backup project, simply open it in the usual way, either by choosing it 
from the File ▸  Open dialog or by double-clicking it in Windows Explorer or the 
Finder. Dorico will open the backup project as if it were a new, untitled project, so 
that you can choose where to save it and what to call it. (STEAM-5639) 

Bar numbers 

A new option Position bar numbers at start of system after clef and key 
signature has been added to the Bar Numbers page of Layout Options, 
switched off by default. When switched on, if a bar number would appear at the 
start of the system, it will be positioned immediately to the right of the preamble at 
the start of the system, rather than aligned with the initial systemic barline. 
(STEAM-5513) 

Barlines 

A new thick barline type has been added. It can be created from the Barlines 
section of the Bars and Barlines panel in Write mode, or by typing thick into the 
Shift+B popover. (STEAM-5493) 
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Brackets and braces 

Two new options have been added to the Brackets and Braces page of 
Engraving Options: (STEAM-5504) 

 Brace distance from systemic barline allows you to control the default 
distance of the brace from the initial systemic barline. 

 Brace distance from bracket allows you to control the default distance of the 
brace from the thick bracket line, if the Secondary bracket appearance option 
is set to Brace. 

Clefs 

The Shift+C popover for adding clefs now accepts French names for common 
clefs: sol for treble G clef, fa for bass F clef, ut5 for baritone clef, ut4 for tenor clef, 
ut3 for alto clef, ut2 for mezzo soprano clef, and ut1 for soprano clef. (STEAM-
4582) 

Color 

More items in the score can now have their colors changed via the Properties 
panel: slurs, tuplet brackets, ornaments, arpeggios, playing techniques, and holds 
and pauses. (STEAM-5477) 

Dynamics 

It is now possible to create forzando dynamics with higher intensities than  by 

typing e.g. fffz into the Shift+D popover. 

Grace notes 

 The interpretation of grace notes during playback has been improved. An 
unslashed grace note of an eighth (quaver) or longer in duration will by default 
be interpreted as a so-called long appoggiatura (as described in Robert 
Donington’s The Interpretation of Early Music), being played on the beat of the 
rhythmic note it precedes, and taking half of its duration (or half of its undotted 
duration, if the rhythmic note is dotted). An unslashed grace note of a 16th 
(semiquaver) or shorter in duration will be interpreted as a so-called short 
appoggiatura, being played on the beat of the rhythmic note it precedes, but 
being played as short as possible. (STEAM-5448) 

 A new group of options has been added to the Timing page of Playback 
Options, allowing you to specify whether single unslashed grace notes should 
be played back as a long appoggiatura, and the threshold for the written 
duration of the grace note below which it should be played back as a short 
appoggiatura. You can also specify the exact duration of a short appoggiatura, 
expressed as a fraction of the duration of a quarter note (crotchet) played at 
120 quarters per minute, i.e. 0.5 seconds. (STEAM-5451) 
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 A new option Horizontal offset from stem has been added to the Grace 
notes section of the Notes page of Engraving Options, allowing you to specify 
the default horizontal offset of the grace note slash relative to the note stem. 
(STEAM-5534) 

Hub window 

A new Tutorials tab has been added to the left-hand pane in the Hub window, 
which provides a list of the latest videos added to the Dorico YouTube channel. 
There are now many useful tutorial videos available to help you learn how to use 
the software. 

A new Videos button has also been added at the top of the Hub window, which 
links directly to the Dorico YouTube channel. 

Instruments 

The following changes have been made to transposing woodwind and brass 
instruments: 

 All common (and some uncommon) horn transpositions are now provided, with 
variants both with and without key signatures. 

 Bass in B♭ and E♭ now have variants that show a bass clef either at transposed 

pitch or at concert pitch. 

 Sousaphone in B♭ and E♭ now have variants that show a treble clef at 

transposed pitch. 

 Variants of euphonium in B♭, baritone horn in B♭ and tenor trombone in B♭ that 

show bass clef at concert pitch without an octave transposition have been 
added. 

 Piccolo in D♭, soprano flute, contrabass flute, tenor trumpet in E♭, bass trumpet 

in C (also known as valve trombone), alphorn in F♯, cornett (or zink) in C and D 

have all been added. 

An organ instrument that uses only two staves (manuals only) and an SATB choir 
set up for two staves have also been added. (STEAM-5702) 

Lyrics 

A new option Punctuation for verse numbers has been added to the Lyrics page 
of Engraving Options, allowing you to specify whether verse numbers should be 
appended with a period (full stop). (STEAM-5492) 

Players 

The option Uses custom player order on the Players page of Layout Options is 
now fully functional, and allows you to change the order of players in one layout 
from the order specified in the Players panel in Setup mode. (STEAM-3686) 
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Popovers 

Except for the Shift+K key signatures and Shift+T tempo popovers, all the 
popovers in Write mode are now case insensitive. (STEAM-5532) 

Printing 

A new option Collate copies has been added to the right-hand panel in Print 
mode, switched on by default. When switched on, Dorico will print all pages of 
each copy of each layout to be printed in sequence; when switched off, Dorico will 
print the desired number of copies of the first page, then the desired number of 
copies of the second page, and so on. (STEAM-5491) 

Project Info 

The File ▸  Project Info dialog now defaults to showing you the information for the 
current flow, rather than the entire project. If you select a flow in the Flows panel in 
Setup mode, if you invoke the dialog either from the File menu or from the right-
click context menu, the dialog will open to the page for the first selected flow. If no 
flows are selected in Setup mode, the dialog will instead open to the page for the 
current flow you are editing, which is denoted by the flow whose name is shown in 
the document title bar. (STEAM-5530) 

Rests 

Dorico automatically fills the gaps between notes with rests of the appropriate 
duration. These are known as implicit rests, because they are implied by the gaps 
between the notes. Rests that are explicitly entered during note input using Force 
Duration, or rests that were explicitly created by way of importing a MusicXML file, 
are known as explicit rests. Explicit rests cannot be suppressed using the Starts 
voice and Ends voice properties. Dorico 1.0.30 introduces new tools for working 
with rests. 

First, a new command Edit ▸  Remove Rests has been added, which will set the 
Starts voice and Ends voice properties appropriately such that any rests in the 
selection are removed. If you see extra rests arising from secondary voices that you 
would prefer did not appear, simply select them individually, or select a range of 
bars containing rests that you would prefer did not appear, and choose Edit ▸  
Remove Rests. (STEAM-5213) 

Second, a new option View ▸  Note and Rest Colors ▸  Implicit Rests has been 
added. When switched on, implicit rests will be colored gray in the score. Explicit 
rests will continue to be shown in black when this option is switched on. 

This option can be useful in diagnosing why, for example, a rest does not disappear 
when you set the Starts voice or Ends voice property on a nearby note: once you 
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identify a rest as an explicit rest, you can delete it, and the implicit rest that 
replaces it will respect the Starts voice or Ends voice property. (STEAM-5525) 

It is also now possible to suppress implicit rests before the first note in a voice by 
setting Starts voice on the first note in that voice, which will suppress all rests 
before that note to the start of the flow. You can also suppress implicit rests after 
the last note in a voice by setting Ends voice on the last note in that voice, which 
will suppress all rests after that voice. It is also possible to suppress implicit rests 
in any gaps between different voices that might occur in the middle of a flow, 
though this will require you to set Ends voice on the last note of the first voice, and 
Starts voice on the first note of the second voice, if the gap between those notes 
spans multiple barlines. (STEAM-5565) 

Tempo 

A new Circa appearance option has been added to the Absolute Changes group 
on the Tempo page of Engraving Options, allowing you to choose whether a 
metronome mark that shows an approximate tempo should show the equals sign 
between the note value and the approximate indication. (STEAM-5495) 

Text 

A new option Position of text relative to other items has been added to the Text 
page of Engraving Options, which is set to Avoid collisions in new projects. This 
option allows Dorico to move text items vertically to avoid collisions with other 
items. This will not be enabled by default in existing projects, since you may have 
already moved text items to avoid collisions, but you can enable it if you want to. 
(STEAM-5014) 

Tremolos 

A new group of options has been added to the Timing page of Playback Options 
to control the playback of unmeasured tremolos. You can specify the minimum 
number of tremolo strokes that will be interpreted as unmeasured in playback. This 
considers both the number of tremolo strokes and the number of beam lines that 
would be used for the note; for example, if the option is set to require three tremolo 
strokes, an eighth note (quaver) with two tremolo strokes will be played as 
unmeasured, because the eighth note’s single beam is included in the calculation. 

You can also specify the default length of the notes in an unmeasured tremolo, 
expressed as a fraction of the length of a quarter note (crotchet) played at 120 
quarters per minute, i.e. 0.5 seconds in length. (STEAM-5435) 
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Issues resolved 
ID # Issue 

STEAM-5226 
Audio export: A problem that would result in exported audio files being exported to the correct length but 
ending up either mostly or completely silent if the project had been played back completely before 
exporting audio has been resolved. 

STEAM-5537 
Accidentals: Attempting to add a new glyph to an accidental definition without a glyph selected in the list 
of glyphs no longer causes a crash. 

STEAM-5413 
Accidentals: The accidentals in the Accidentals section of the Key Signatures and Accidentals panel 
now stick on during note input in the same way as the accidentals in the notes panel on the left-hand side 
of the window. 

STEAM-5496 & 
STEAM-5457 

Arpeggio signs: The spacing of arpeggio signs relative to cross-staff notes has been improved. In 
particular, if two cross-staff arpeggio signs exist at the same rhythmic position on different instruments, 
each arpeggio sign will now be offset only by the width of the accidentals etc. on the instrument to which 
the arpeggio sign applies, rather than the width of accidentals on all instruments that have arpeggio signs 
at that rhythmic position. 

STEAM-5490 
Arpeggio signs: Arpeggio signs no longer move slightly to the left or right while dragging them in Engrave 
mode. 

STEAM-5485 
Arpeggio signs: The length of cross-voice arpeggio signs is now correctly updated when the pitches of 
the notes changes sufficiently that the highest or lowest note is now in a different voice. 

STEAM-5475 
Arpeggio signs: The length of cross-staff arpeggio signs now updates correctly after the distance 
between staves changes. 

STEAM-5112 
Articulations: The appropriate properties are now displayed in the Articulations of duration group of the 
Properties panel depending on whether a tenuto is present. 

STEAM-5617 
Audio export: Exporting to WAV will now always use the sample rate used by the current audio device; 
exporting to MP3 will always export at 44.1kHz. 

STEAM-5695 
Bars: In rare circumstances, it was possible for deleting bars using the Shift+B popover to cause Dorico 
to crash. This problem has been resolved. 

STEAM-5573 
Beams: Beam direction is no longer affected by the staff positions of rests within the beamed group, 
unless stemlets are in use. 

STEAM-5518 
Dynamics: A problem that prevented immediate dynamics immediately following a gradual dynamic (a 
crescendo or diminuendo) from playing back correctly has been resolved. 

STEAM-5503 
Dynamics: Typing e.g. f cresc. into the Shift+D dynamics popover will no longer discard the specified 
gradual dynamic when popover is closed. 

STEAN-5685 
Dynamics: Typing sf or sfz into the popover will now set the rfz/sfz style property as appropriate, so the 
dynamic will match the popover input. 

STEAM-5494 
Exporting graphics: A problem whereby graphics would not be correctly exported if the name of the layout 
to be exported contained one or more characters that are illegal in filenames has been resolved. 

STEAM-5567 
Exporting graphics: PDFs exported with the Mono option set are now always correctly exported in a true 
monochrome color space. 

STEAM-5500 
Layouts: Empty part layouts numbered higher than 10 are now correctly renamed when assigning players 
to them. 
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ID # Issue 

STEAM-5476 
Layouts: Changes made to player groups in the Players panel are now reflected immediately in the open 
layout, instead of incorrectly requiring the layout to be closed and opened again. 

STEAM-5464 Lyrics: Attempting to start lyric input with the final barline selected will no longer cause a crash. 

STEAM-5619 
Lyrics: A problem whereby lyrics could sometimes be pasted out of order when copying and pasting 
between flows or projects has been resolved. 

STEAM-4954 
STEAM-4994 

Mixer: Mute/Solo buttons now work correctly in the Mixer, and new buttons have been added to clear all 
Mute and Solo states. 

STEAM-4993 
Mixer: The state of the insert and send slots in the Mixer, including whether each is enabled or disabled, is 
now correctly saved and restored when saving and reopening a project. 

STEAM-5285 
Mixer: The Mixer now correctly updates in response to changes in the project, for example adding or 
removing players and instruments, without requiring that the window be closed and reopened. 

STEAM-5621 
Mixer: The responsiveness of the faders in the Mixer has been improved. It is no longer possible to move 
the faders with a two-fingered swipe gesture, but it is still possible to use a sideways swipe gesture to 
scroll the Mixer window. 

STEAM-5610 Mixer: The Mixer is no longer forced to be on top of all other windows (Windows only). 

STEAM-5482 
Mixer: It is now possible to route signal from any instrument output to the global effects channel; 
previously, this routing would only work for the default HALion Sonic SE 2 plug-in. 

STEAM-5635 
Multi-bar rests: Gradual tempo changes (such as rit./accel.) no longer cause multi-bar rests to break 
incorrectly. 

STEAM-5602 
Multi-bar rests: Deleting music from a part layout in which two or more instruments are included and multi-
bar rests are enabled no longer causes a crash under certain circumstances. 

STEAM-5728 
Note input: When selecting notes in instruments whose sounds require a transposition of one or more 
octaves in playback (e.g. double bass, bass guitar), the correct octave transposition is now applied. 

STEAM-5481 
Note input: You can now correctly override the choice of octave for the first note of a chord when 
inputting a chord using the computer keyboard in step input. 

STEAM-5577 
Note input: It is now possible to set key commands for double sharp and double flat accidentals that can 
be used to specify those accidentals during note input. 

STEAM-5600 
Note input: The initial duration chosen when note input starts will only be taken from the selected note if a 
single note is selected; if there are multiple notes and rests selected, or if the selected rest is longer than 
a quarter note (crotchet) in duration, the initial duration chosen will be a quarter note (crotchet). 

STEAM-5487 
Note input: Switching on Lock Durations during note input now correctly switches off rests, tuplets, or 
grace notes, if any of those tools were engaged. 

STEAM-5543 
Notation options: Some options from the Notation Options dialog were not correctly applied to new 
flows or new projects after having been saved as defaults; this problem has now been resolved. 

STEAM-5526 
Ornaments: When selecting a mordent or turn and editing it by clicking another ornament type in the 
Ornaments panel in Write mode, the correct button now shows as selected in the panel after the edit. 

STEAM-5460 Playback: Dorico no longer crashes if it attempts to play notes lower than MIDI note 0. 
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ID # Issue 

STEAM-5522 
Playback: Starting playback in a large project is now considerably faster. This also reduces the time it 
takes to open larger projects. 

STEAM-5456 
Playback: A problem that would cause the playback of legato (either triggered by slurs or the legato 
playing technique) to be overridden, so that there is no audible legato effect, has been resolved. 

STEAM-5367 Playback: The nat. playing technique now correctly resets all other active playing techniques. 

STEAM-5498 
Playback: Grace notes at the same position in multiple voices or instruments are now correctly played at 
the same time. 

STEAM-5533 
Playback: Only those flows assigned to the current layout are played back, in the order in which they are 
listed in the Flows panel in Setup mode, rather than relying on the presence of a full score layout (the 
absence of which would previously have caused there to be no playback at all). 

STEAM-5638 
Playback: Audio devices with ampersand characters in their names can now be chosen correctly in the 
Device Setup dialog. 

STEAM-5396 
Playback: Keyswitch notes are now correctly cleared when playback stops, so that starting playback again 
does not sometimes result in Dorico playing the wrong technique. 

STEAM-5721 
Playback: Keyswitch notes and MIDI controllers are now correctly chased when starting playback from the 
middle of a flow. 

STEAM-5595 
Playback: When opening an existing project, the correct playback data for the current layout is now set up 
immediately, and switching the Flow drop-down in Play mode correctly updates the event display. 

AD-281 
Playback: A problem whereby Waves NX plug-ins would not load or correctly display their user interface 
has been resolved. 

STEAM-5750 Playback: Reverb send level is now correctly set post-fader rather than pre-fader. 

STEAM-5647 
Players: When changing between two instruments with different numbers of staves held by the same 
player, if the option to allow one staff of a multi-staff instrument to be hidden if empty is enabled, Dorico 
no longer shows both staves of the two-staff instrument unless both contain music. 

STEAN-5616 
Players: Certain edits to music at or near a transition between different instruments held by the same 
player can no longer cause the following system to disappear temporarily. 

STEAM-5549 
Players: Changing the instrument held by a player no longer causes any arpeggio signs written for the 
original instrument to be lost. 

STEAM-5711 
Players: Under rare circumstances it was possible for Dorico to crash when moving a player from one 
group to another in Setup mode. This has now been resolved. 

STEAM-5640 
Printing: It is no longer necessary to switch on the View options checkbox in the Annotations section of 
the print options panel to print colored objects in color. 

STEAM-5615 
Printing: Typing a page number into the To spin control to determine the page range and then hitting Tab 
to move the focus to another control no longer causes a crash under some circumstances (Mac only). 

STEAM-5716 
Printing: Reopening a project that was last saved with Print mode active will now correctly show the print 
preview immediately, without requiring you to switch to a different mode and back again. 

STEAM-5656 
Properties: A problem whereby selecting a bar containing a playing technique that is otherwise empty 
could cause Dorico to crash has been resolved. 
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ID # Issue 

STEAM-5563 
Rests: Under some circumstances, bar rests that appear when notes that had been crossed to an 
otherwise empty staff from the staff above or below could appear at the wrong vertical position. This has 
now been resolved. 

STEAM-5478 Rests: Deleting a tuplet containing rests now always correctly renotates the rests that remain. 

STEAM-4875 
Rests: Under some circumstances, removing the Starts voice property from the first note in a tuplet would 
not cause any suppressed rests earlier in the tuplet to reappear right away. This has now been resolved. 

STEAM-5538 
Staff spacing: Edits to staff spacing are no longer incorrectly removed if the layout whose staff has been 
edited has been viewed in galley view during the current editing session. 

 
Text: A problem whereby double-clicking a text item to edit it would not work in certain circumstances 
involving music in multiple frame chains has been resolved. 

STEAM-5323 
Time signatures: A problem whereby setting the Ends interchangeable property on a time signature 
would not immediately cause the following bars to be redrawn correctly has been resolved. 

STEAM-5090 
Time signatures: Deleting and recreating a time signature change within an interchangeable range will 
now have the correct effect on the time signatures that come after it. 

STEAM-5470 
Time signatures: Rests are now correctly grouped according to the instrument-specific time signature, if 
one is present. 

STEAM-5609 
Transposing: Making a selection of music at the beginning of a flow that starts with a C major or A minor 
key signature will now correctly allow that key signature to be transposed. 

STEAM-5527 
Tremolos: When selecting a tremolo with four strokes, the correct button now shows as selected in the 
Tremolos panel in Write mode. 

STEAM-5564 
Tremolos: The playback of measured tremolos has been improved, such that the number of tremolo 
strokes now determines the note value of the repeated notes (one stroke = eighth note, two strokes = 
16th note, etc.), instead of simply dividing the written note value by two, four, etc. 

STEAM-5510 
Voices: When you use Edit ▸  Stem ▸  Swap Voice Order to swap the order of two voices, the resultant 
Voice column index values now appear correctly in the Properties panel. 

STEAM-5474 
User interface: The keyboard focus is now always returned to the main document area after clicking any of 
the buttons in the right-hand panels in Write mode, so that all key commands operate on the music as 
expected without having to click into the music area again. 

STEAM-5471 
User interface: A problem whereby the scrollbars in the right-hand panels in Write mode could either 
appear the wrong height (Mac and Windows), or too wide (Windows only), has been resolved. 

STEAM-3033 
User interface: It is now possible to assign key commands to key combinations that normally act as dead 
keys producing combining diacritics, such as Alt+E (Mac only). 

STEAM-4934 
User interface: The way scroll bars appear in Dorico’s panels has been revamped to ensure that they only 
appear when necessary. 

STEAM-5614 
User interface: Changes to key commands now take effect immediately, even if no project window is 
open. 

STEAM-5692 
User interface: Changing the selection of layouts in Layout Options without having made any changes to 
any of the options no longer incorrectly prompts that there are unsaved changes. 
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ID # Issue 

STEAM-5605 
User interface: When running in full screen, menus that pop up from buttons (e.g. in the status bar at the 
bottom of the window) no longer appear too high, as if the Dock were visible (Mac only). 

STEAM-5620 
User interface: When attempting to open many projects at the same time, Dorico no longer sometimes 
crashes. 

STEAM-5638 
User interface: Audio devices with an ampersand (&) in their name now appear correctly in the Device 
Setup dialog. 

STEAM-5574 
Localisation: Dorico will now start correctly if your user account name uses Japanese or other CJK 
Unicode characters (Windows only). 

STEAM-5471 
STEAM-5321 
STEAM-5590 

Localisation: Several issues related to assigning key commands using specific key combinations on 
French, German, Italian, Japanese and Russian keyboards have been resolved. 

 
Localisation: The key command Ctrl+A (Windows) or Command-A (Mac) was missing from the default 
sets of key commands in languages other than English; this has now been resolved. 

STEAM-5585 
Performance: A problem whereby commands (e.g. notes input in quick succession) could be executed in 
the wrong order or skipped has been resolved. 

STEAM-5629 
Performance: The speed of note input and editing in projects containing multiple flows has been 
significantly increased. 

STEAM-5579 
Performance: The speed of note input and editing in flows that have a lot of trailing empty bars has been 
significantly increased. 
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Dorico 1.0.20 

December 2016 

This version contains the following improvements and issue resolutions. 

Improvements 

Performance improvements 

Building on the improvements in Dorico 1.0.10, this update includes further 
significant improvements to the performance and reliability of Print mode. For 
example, selecting multiple layouts in Print mode is now considerably faster. 
(STEAM-5386) 

Arpeggio signs 

A new Arpeggiation section has been added to the Ornaments panel in Write 
mode, allowing the creation of arpeggio signs indicating upwards and downwards 
arpeggiation, as well as a non arpeggio bracket line indicating that a chord should 
not be arpeggiated. 

To create an arpeggio sign on a chord in a single voice, select any notehead in the 
chord, and either select the desired arpeggio sign from the Ornaments panel, or 
type Shift+O to open the ornaments popover, in which you can type arp (or 
arpeggio) for an upwards arpeggio, arpdown (or arpeggiodown) for a 
downwards arpeggio, or nonarp (or nonarpeggio) for a non arpeggio sign. Dorico 
will create the arpeggio line spanning all of the notes in the chord. Dorico will not 
create an arpeggio sign if only a single note exists in the selected voice. Arpeggio 
signs can also be created during note input in chord mode using the ornaments 
popover. 

To create an arpeggio sign that spans chords in multiple voices (e.g. across both 
staves of a piano or harp instrument), select any notehead in the first voice, then 
hold Ctrl (Windows) or Command (Mac) and select any notehead in the second 
voice, then create the arpeggio sign either using the panel or the popover, as 
described above. 

Dorico will automatically adjust the length of the arpeggio sign as the pitches of the 
notes in the voices to which the sign belongs change, or as notes are added to or 
deleted from the chords, and will automatically delete the arpeggio sign when only 
a single note remains at that rhythmic position in that voice. 

By default, any grace notes at the same rhythmic position as an arpeggio sign will 
be positioned to the left of the arpeggio sign. To make the arpeggio sign appear to 
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the left of the grace notes, select the arpeggio sign and set the Arpeggio before 
grace notes property in the Properties panel. 

Downwards arpeggio signs have an arrowhead at the bottom of the line by default, 
but upwards arpeggio signs have no arrowhead by default. Arpeggio signs can 
alternatively show a Couperin-style swash at their top or bottom. To override an 
individual arpeggio sign, select it and open the Properties panel, then set the Sign 
end property. The length of arpeggio signs can also be adjusted on a case-by-
case basis in Engrave mode. 

Options controlling the default appearance of arpeggio signs have been added to 
the new Arpeggio Signs page of Engraving Options. 

Arpeggio signs do not yet have any effect in playback, but this is planned for a 
future update. 

Brackets and braces 

A new option Additional vertical protrusion beyond top or bottom of staff has 
been added to the Design group on the Brackets and Braces page of Engraving 
Options, allowing the thick vertical line of the bracket to be lengthened slightly if 
needed to ensure a good join with the chosen bracket tip glyphs in the current 
music font. (STEAM-5408) 

Instruments 

A keyless timpani instrument type, i.e. a timpani that does not use a key signature 
and instead shows accidentals for each note as required, has been added and can 
be chosen from the instrument picker. (STEAM-5339) 

Key commands 

 It is now possible to change the default key commands for changing the pitch of 
notes (Alt+up/down arrow to move by step, Shift+Alt+up/down arrow to move 
by chromatic step, and Ctrl+Alt+up/down arrow to move by octave). These 
commands can now be found in the NoteEdit category. (STEAM-5453) 

 It is also now possible to assign key commands for Edit ▸  Stem ▸  Force Stem 
Up, Force Stem Down and Remove Forced Stem. These commands can now 
be found in the Edit category. (STEAM-5454) 

Lyrics 

A new Italic property has been added to the Lyrics group in the Properties panel, 
allowing any non-italic lyric to be made italic if necessary, for example for 
occasional words in a different language, or vocalizations interspersed within the 
text. (STEAM-5404) 
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Music fonts 

Dorico now reads the JSON metadata files for SMuFL-compliant fonts from the 
locations recommended by the SMuFL specification: 

 Windows: C:\Program Files\Common Files\SMuFL\Fonts\ 
 Mac: /Library/Application Support/SMuFL/Fonts/ 

Dorico will load the JSON file if it is named fontname.json (e.g. Bravura.json) and 
located inside a folder called fontname (e.g. Bravura) in the appropriate path for 
the operating system. 

If Dorico can load the JSON metadata file correctly, then the font will appear in the 
list of available music fonts in Engrave ▸  Music Fonts. (STEAM-2290) 

Note input 

To create a time signature or key signature that applies only to the staff on which 
the caret is currently located, enter the time signature or key signature into the 
Shift+M or Shift+K popover as usual, and type Alt+Return (instead of Return 
alone) to confirm the item to be created. (STEAM-5422) 

Notes 

A new option Stem direction for notes on the middle line of the staff has been 
added to the Stems group on the Notes page of Engraving Options, allowing you 
to choose whether Dorico should use musical context (i.e. the staff positions of 
notes preceding and following the notes on the middle line of the staff) or a fixed 
default to determine the stem direction of notes on the middle line of the staff. 
(STEAM-5348) 

Ornaments 

A new option Horizontal gap between trill marking and trill extension line has 
been added to the Trills group on the Ornaments page of Engraving Options, 

allowing you to determine the distance between the  sign and the extension line 

to its right. 

Page layout 

A new Rastral size menu has been added to the Space Size group on the Page 
Setup page of Layout Options, allowing the specification of staff size according to 
the rastral sizes used in traditional music engraving. The largest size is Size 0 
(9.2mm or 0.36”), and the smallest size in Size 8 (3.7mm or 0.15”), and the default 
staff size in a new project is now Size 3 (7mm or 0.28”). It is naturally still possible 
to choose any custom size, as before, by editing the Space size value directly. 
(STEAM-5353) 
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Two new options have been added to the Hide Empty Staves group on the 
Vertical Spacing page of Layout Options: 

 Allow individual staves of multi-staff instruments to be hidden: When 
switched on, Dorico will allow (say) the left-hand staff of a piano instrument to 
be hidden on a system on which it has no music; when switched off, the piano 
will only be hidden on a system if both staves can be hidden. (STEAM-5382) 

 Players excluded from hide empty staves: This provides a list of all of the 
players in the current layout, and allows you to specify a list of players that 
should never be hidden, even if their staves are empty throughout a system. 
(STEAM-4755) 

Playback 

 A new Playback Options dialog has been added to the Play menu. This dialog 
contains options to determine how Dorico should interpret specific markings 
during playback, such as the percentage by which the written duration of notes 
should be extended under a slur or when encountering a legato playing 
technique, by how much the dynamic should be increased when playing an 
accent or marcato articulation, and so on. The dialog also includes an initial set 
of options for beat stress (the amount by which the dynamic should be 
increased on primary and secondary beats in the current meter) and for 
humanization of dynamic level and note start position. 

 Single- and multiple-note tremolos now play back. Measured single-note and all 
multiple-note tremolos are played back directly by rendering additional note 
events, while unmeasured single-note tremolos can be played back using 
unmeasured tremolo samples if they are provided by the VST Expression Map in 
use for the instrument. (STEAM-3904) 

 Slurs and the legato playing technique are now played back by extending the 
duration of all but the last note under a slur. (STEAM-5148) 

 Grace notes now play back. Any number of slashed and unslashed grace notes 
at present all play back immediately before the rhythmic note they precede, 
stealing time from the preceding rhythmic note. Playback of a single unslashed 
grace note, taking half the written duration of the rhythmic note that follows, and 
stealing time from that following rhythmic note, will be added in a future update. 

 A new option Show playhead when stopped has been added to the Play 
group on the General page of Preferences. When switched on, the playhead 
(vertical green line) will appear both during playback and when stopped; when 
switched off, the playhead will appear only during playback. (STEAM-4718) 

Preferences 

The General page of Preferences has been organized into groups of related 
options. 
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Rests 

A new option Bar rests in additional voices has been added to the new Rests in 
additional voices group on the Rests page of Notation Options. In new projects, 
this option is set to Omit bar rests, which means that when an additional voice 
(typically a down-stem voice) stops, any subsequent bars in which that voice has 
no notes or chords prior to its reappearance will not be padded with bar rests. This 
reduces the number of occasions you would have to search backwards through 
the music to set the Ends voice property on the last note in the voice, which might 
be dozens or even hundreds of bars earlier. 

If you would prefer that Dorico continue to pad all intervening bars with bar rests, 
set the new option to Show bar rests, which will also be the value chosen in any 
projects created in versions of Dorico earlier than 1.0.20. 

Furthermore, when this new option is set to Omit bar rests, bar rests no longer 
appear in bars where the only notes and chords present have been crossed from 
another staff. (STEAM-5212, STEAM-4831) 

In addition, a new option Allow dotted rests equal to the length of a compound 
beat has been added to the Compound Time Signatures group on the Rests 
page of Notation Options. When set to Allow dotted rests, a rest of a dotted 
quarter (dotted crotchet) in 6/8 will be rendered as a single dotted quarter rest; if it 
is set to Split at beat subdivisions, it will be rendered as a quarter (crotchet) rest 
followed by an eighth (quaver) rest. (STEAM-5109) 

Finally, it is now possible to create explicit bar rests during note input. Either click 
the new Insert Bar Rest button in the Bars and Barlines panel in Write mode, or 
type rest into the Shift+B popover. (STEAM-5036) 

Templates 

The Brass band template has been improved, with corrected staff labels for the 
cornet and horn instruments, and appropriate clefs for the trombones. (STEAM-
5334) 

Tempo 

It is now possible to control the appearance of absolute and gradual tempo 
changes independently in Engrave ▸  Font Styles. Absolute, relative and reset 
tempo markings use the Immediate tempo text font style, while gradual tempo 
changes used the Gradual tempo text font style. (STEAM-5387) 

Views 

When changing view type from galley view to page view, or vice versa, if there is a 
selection, Dorico now attempts to center the selected item or items in the new 
view. (STEAM-5025)   
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Issues resolved 
The following table lists all issues that have been resolved in this version: 

ID # Issue 

STEAM-5344 
Copy and paste: Notes within tuplets that have been created with Force Durations set now retain their 
forced duration when pasted. 

STEAM-5269 
Copy and paste: Using R to repeat a selection no longer sometimes pastes items (such as dynamics) in 
the wrong location. 

STEAM-5414 
Dynamics: Dynamics between the two staves of a keyboard instrument are now correctly centered. The 
option Allow dynamics between braced staves to violate minimum distance by n spaces has been 
removed from the Dynamics page of Engraving Options. 

STEAM-5403 
Holds and pauses: Caesuras at the end of a bar now cause multi-bar rests to break at the bar in which 
they appear, rather than at the following bar. 

STEAM-5391 
Holds and pauses: Caesuras that precede a change of time signature or key signature no longer cause 
the time or key signature to be spaced incorrectly relative to the barline. 

STEAM-5380 
Instrument changes: Items that apply to the whole system, such as tempo markings, rehearsal marks, etc., 
now appear correctly above the top staff when the top staff uses instrument changes. 

STEAM-5352 
Key signatures and accidentals: Setting a non-Western accidental on a note no longer incorrectly also 
sets the same accidental on the note in transposing layouts; now, the accidental is only set in transposing 
layouts if the relative offset between the concert and transposed pitch notes are identical. 

STEAM-5341 
Key signatures and accidentals: Notes with non-Western accidentals now behave correctly when 
repitched, and do not continue to show the same accidental even if the offset of the pitch changes. 

STEAM-5162 
Key signatures and accidentals: The rule that every tonality system must have an accidental type that fulfils 
the role of the natural (i.e. does not change the pitch) is now enforced, and it is no longer possible to 
delete any built-in accidental type, or any accidental type that is in use in the project. 

STEAM-5383 
Key signatures and accidentals: Accidentals types that contain graphics now display correctly in the 
Accidentals section of the Key signatures and accidentals panel in Write mode. 

STEAM-5347 

Key signatures and accidentals: The option Notes following a change of key signature that shows 
cancellation naturals on the Accidentals page of Notation Options now works as expected. This option 
only takes effect if Dorico will show cancellation naturals at a change of key, as determined by the two 
options immediately above this one in the dialog. 

STEAM-5338 
Key signatures and accidentals: A problem whereby instruments that don’t show a key signature (e.g. 
Horn in F) would under some circumstances not show the required accidentals on some notes in extreme 
keys (i.e. key signatures of 7 sharps or flats) has been fixed. 

STEAM-5264 
Key signatures and accidentals: Cancellation naturals now appear if necessary at changes of key arising 
from changing between instruments with different transpositions.  

STEAM-5192 
Key signatures and accidentals: Changes of key that occur in the middle of a bar now correctly take effect 
on the notes that follow the key signature before the end of the bar. 

STEAM-5274 
Key signatures and accidentals: When importing MusicXML files that use other accidentals than the 
standard 12-EDO or 24-EDO accidentals, Dorico now automatically creates an appropriate tonality 
system in the resulting project. 

STEAM-5426 Layouts: Custom layout names are now correctly preserved when re-opening saved projects. 
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ID # Issue 

STEAM-5255 
MusicXML import: Dorico no longer crashes when encountering a MusicXML file that specifies an invalid 
number for slur elements. 

STEAM-5074 
MusicXML import: Dorico no longer fails to open compressed MusicXML (.mxl) files that contain internal 
filenames that use extended Unicode characters. 

STEAM-5354 
Navigation: Using up/down arrow to navigate to the staff above/below from a selected bar rest no longer 
sometimes skips over the next staff. 

STEAM-5318 
Navigation: Using Ctrl+up/down arrow to navigate to the system above/below now works correctly, for 
any number of staves in the system. 

STEAM-3035 
Note input: Specifying that the next note to be input should explicitly be above or below the previous note 
now works more reliably. 

STEAM-5351 
Note input: Moving the caret to the staff above/below with up/down arrow now correctly takes into 
account whether the caret is at a tuplet position on the original staff, and moves to an appropriate position 
on the destination staff. 

STEAM-5430 
Note input: When inputting notes into transposing instruments in a transposing layout, notes are no longer 
sometimes input in successively higher octaves for no discernible reason. 

STEAM-5359 
Note spacing: Tempo markings are no longer considered when determining the width of multi-bar rests, 
unless another tempo marking in a later bar would collide with a previous tempo marking, preventing some 
multi-bar rests from being made much wider than necessary. 

STEAM-5402 
Notes: Augmentation dots are no longer hardwired to be drawn using Bravura, so if you choose to use 
another music font via Engrave ▸  Music Fonts, you will see the appropriate glyph from the new font. 

STEAM-5163 
Notes: Pairs of opposing voices where notes in both the left- and right-hand columns show an accidental 
on the same staff position, and where the note in the right-hand column closest to a note in the left-hand 
column is at an adjacent staff position, are no longer offset by an unexpectedly large distance. 

STEAM-4989 
Notes: Syncopated patterns of the form short-dotted long (e.g. quarter-dotted half in 4/4) are now 
notated according to the options set in Notation Options regardless of whether or not the dotted long 
note is also tied out of the bar. 

STEAM-5357 
Page layout: Changing the master page set of a layout on the Page Setup page of Layout Options is 
now reflected immediately in the display in the Master Pages section of the right-hand panel in Engrave 
mode. 

STEAM-5187 
Page layout: Under rare circumstances, staff labels would sometimes fail to update after undoing an edit 
that results in the point at which an instrument change occurs changing. This has now been resolved. 

STEAM-5287 Playback: Dynamics are no longer ignored during playback if the flow begins with a rest. 

STEAM-5394 Playback: Multiple dynamics on the same note are now played back more sensibly. 

STEAM-5369 Playback: Accents now play back correctly when notes with accents alternate with notes without accents. 

STEAM-5371 Playback: Playing techniques on the very first note of the flow now play back correctly. 

AD-269 
Playback: Typing Command-Q while a VST plug-in window is in focus no longer incorrectly quits the VST 
audio engine, resulting in Dorico itself hanging upon exit. 



 

 
Dorico Version History Page 125 Steinberg Media Technologies GmbH 

ID # Issue 

AD-253 
Playback: A problem whereby the VST audio engine could crash when used on a computer with on-board 
Realtek sound hardware has been fixed (Windows only). 

AD-260 
Playback: When reopening a saved project that uses Kontakt, a burst of static is no longer sometimes 
emitted as the project loads (Mac only). 

STEAM-5401 Rests: It is now possible to set properties, including the staff position, of bar rests correctly once more. 

STEAM-5356 
Selections: Edit ▸  Select All now selects only the music in the current flow, not across all flows in the 
project. 

STEAM-5385 
Slurs: Slurs are no longer temporarily incorrectly positioned if Edit ▸  Reset Appearance is invoked when 
both the slur itself and the notes at either end of the slur are selected. 

STEAM-5399 
Staff spacing: Using Alt+click-drag to drag a staff containing one or more instrument changes now works 
correctly. 

STEAM-5370 
Staff spacing: Copy Staff Spacing will now work even if the user has not made any adjustments to the 
staff spacing on the source page. 

STEAM-5406 
Text: Pasting text terminated by a null character (e.g. from a text block in Finale) into Dorico will no longer 
cause the project to become corrupted when saving. 

STEAM-4963 
Text: Changing the stretch for text in a text item or text frame now correctly changes the shape of the 
characters themselves, rather than merely the distance between characters (Mac only). 

STEAM-4971 
Text: Changing the stretch for text in a text item or text frame now displays correctly on screen and is 
reproduced correctly both when printing and when exporting PDF graphics (Windows only). 

STEAM-5358 
Text: Changing the point size of multiple selected paragraphs using the controls in the text editing 
popover now works correctly, rather than changing the size of only the first selected paragraph. 

STEAM-5434 
Text: The size of the text editor is no longer incorrect when editing a text item belonging to a staff that 
uses a non-default staff size. 

STEAM-5177 
Ties: When Tie endpoint positioning in chords is set to Outermost ties above/below noteheads, 
others between, Dorico no longer sometimes incorrectly offsets the wrong tie in multi-voice contexts. 

STEAM-5395 
User interface: Message boxes spawned from one of Dorico’s options dialogs no longer cause the 
options dialog itself to disappear behind the main project window (Windows only). 

STEAM-5381 
User interface: It is no longer possible under some circumstances to show more than one instance of the 
Layout Options or Notation Options dialog for a given score simultaneously. 

STEAM-5263 
User interface: The color picker dialog no longer increases in height slightly with each invocation within a 
session (Mac only). 

STEAM-5392 
User interface: It is no longer possible to click the various Save as Default buttons in the Layout Options 
and Notation Options dialogs when more than one layout or flow respectively is selected; being able to 
do this in earlier versions could result in the saved options data being incomplete or inconsistent. 

STEAM-4527 
User interface: Menu items that can be checked to show their state now correctly show the assigned key 
command, if any. 

STEAM-5393 
Dorico will no longer fail to start if the user’s saved layout options data is incomplete or inconsistent; 
instead, the data will simply be ignored. 
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ID # Issue 

STEAM-5360 
Dorico will no longer crash on start-up if it is unable to create the user’s chosen default project save 
folder. 



 

 
Dorico Version History Page 127 Steinberg Media Technologies GmbH 

Dorico 1.0.10 

November 2016 

This version contains the following improvements and issue resolutions. 

Improvements 
This maintenance update introduces the following improvements: 

Performance improvements 

 The speed of note input, and undoing note input, has been substantially 
increased. 

 The speed of changing the pitch of a selection of notes using Alt+up/down 
arrow has been substantially increased. 

 The speed of adding and removing players in Setup mode has been 
substantially increased. 

 Unnecessary screen redraws during editing operations have been eliminated, 
providing a substantial improvement in the speed of redraw during editing 
operations. 

 The speed of creating a new project from a template has been substantially 
increased. 

 The speed of entering and working within Print mode has been substantially 
increased. 

Articulations 

A new group of options Slurs on the Articulations page of Engraving Options 
allow you to determine whether articulations of force (accent, marcato) or 
articulations of stress (stress, unstress) should be positioned inside or outside slur 
endpoints. 

A new option Position of tenuto relative to tied notes has been added to the 
Ties group on the Articulations page of Engraving Options, allowing you to 
choose whether tenuto articulations should be positioned on the first or last note of 
a chain of tied notes by default. An additional property has also been added to 
allow this default to be overridden for an individual tenuto. 

Beams 

A new option has been added to the Advanced Options section of the Slants 
group on the Beams page of Engraving Options, allowing you to specify whether 
beams containing repeated patterns of pitches should be allowed to have slants, or 
should always be horizontal. 
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Brackets and braces 

A new option has been added to the Approach group on the Brackets and 
Braces page of Engraving Options, allowing you to specify whether groups 
consisting of a single staff should show a bracket. 

Two new choices have been added to the Ensemble type option in the same 
group: British brass band (which provides separate bracketing groups for 
cornets; flugelhorn; tenor horns; baritone horns; trombone and bass trombone; 
euphonium; and percussion), and Big band (which provides separate bracketing 
groups for saxophones; trumpets; trombone and bass trombone; and rhythm 
section). 

Key signatures and accidentals 

 Instruments with (no key) in their names (e.g. French horn, timpani, etc.) are 
now correctly created with no key signatures, and instead show accidentals on 
every note as necessary. 

 An open or atonal key signature can now be created via the Shift+K popover by 
typing open or atonal. 

 It is now possible to change the enharmonic spelling of notes in part layouts 
independently of the full score layout. 

Licensing 

When using a time-limited or trial license, Dorico will now report the time remaining 
in the license at start-up, every 10 days, and every day during the final five days of 
the license period. 

Lyrics 

New Minimum distance from other items option in the Vertical Position section 
of the Lyrics page in Engraving Options provides a small amount of padding 
between items protruding outside the staff and the closest edge of the innermost 
line of lyrics. 

New option to show or hide elision slurs on lyrics in Japanese and other East Asian 
languages by default, in the East Asian Lyrics section of the Lyrics page in 
Engraving Options. In addition, there is a new property to override this default 
setting for an individual lyric. 

Note input and editing 

 A new scissors tool (shortcut U) has been added. Outside of note input, the 
scissors tool will remove any ties in the selected notes and chords. Inside note 
input, the scissors tool will cut any sounding notes in the voice indicated on the 
caret that are sounding at the current caret position. 
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 A new option Play notes during note input and selection has been added to 
the General page of Preferences. 

 New Write ▸ Input Pitch submenu allows you to choose between inputting in 
Written Pitch or Sounding Pitch, which is useful when inputting into 
transposing instruments or when copying instrumental parts. 

Page layout 

 The Edit ▸  Breaks and Edit ▸ Note Spacing menus have been removed, with 
their functions moved to the Engrave menu, in recognition of the fact that 
system and frame breaks can only be created in Engrave mode. New Edit ▸ 
Format Systems and Edit ▸ Format Music Frames submenus have been 
added, containing not only System Break and Frame Break, but also Lock 
Frame, Lock System, Make Into System, and Make Into Frame. 

 The default key command for system break is now Shift+S, and for frame break 
it is now Shift+F. 

Playback 

 A new option Suspend audio device in background has been added to the 
General page of Preferences, switched off by default. When switched on, this 
option releases the audio device when Dorico loses focus, unless it is playing 
back at the time, in which case Dorico retains ownership of the audio devices 
so that playback can continue. 

 Basic playback of changes in playing techniques has now been implemented for 
HALion Symphonic Orchestra, allowing playback of e.g. pizz. and arco 
instructions. 

 The Mixer window now labels each fader with the plug-in output channel and 
the short instrument name, and each fader is also color-coded using the same 
colors used in the track header for each instrument in Play mode. 

 The playhead is now shown in Play mode, and it moves through the music 
during playback. 

Selections 

 Navigating around the music with the arrow keys in Write mode has now been 
substantially improved. 

 Use Tab and Shift-Tab to select the next/previous barline in Write mode. 
 It is possible to start navigation in Write mode without the mouse: simply press 

any arrow key, which will select the first item closest to the top left corner of the 
view. 

 Extending the selection by holding Shift and using the arrow keys now works 
more reliably; hold Ctrl (Windows) or Command (Mac) to extend the selection 
by a bar at a time. 
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 Clicking within the staff but not on a note or other item now selects all of the 
music in that bar on that staff; hold Shift and click on another item or a blank 
part of the same or another to extend the selection. 

 New Edit ▸ Select to End of System and Edit ▸ Select to End of Flow menu 
items, to quickly extend the selection on the selected staff or staves to the end 
of the system or the end of the flow, respectively. In addition, Edit ▸ Select All 
now works as expected. 

 Holding Ctrl (Windows) or Command (Mac) while making a marquee selection 
now adds to an existing selection; holding Ctrl+Alt (Windows) or 
Command+Opt (Mac) while making a marquee selection now subtracts from 
an existing selection. 

 The middle mouse button can now be used instead of Shift to toggle between 
the default action when clicking and dragging, i.e. between moving the view or 
making a marquee selection. 

 Dragging a marquee selection over a barline will no longer select the barline. 

Time signatures 

Hidden time signatures are now shown using signposts, which allows them to be 
selected for copying and pasting, or for deletion. A new View ▸ Signposts ▸ Time 
Signatures menu item allows you to choose whether or not signposts for hidden 
time signatures should be displayed. 

Transposing 

A new Write ▸ Transpose dialog has been added, allowing the selected music or, 
if there is no selection, the entire flow to be transposed. Transposition can be 
specified either by quality of interval (e.g. major, minor, perfect, augmented, 
diminished) or by number of divisions of the octave. The dialog will not allow illegal 
transpositions that would result in notes that cannot be notated (e.g. sharper than a 
triple sharp, or flatter than a triple sharp, or using a microtonal accidental that does 
not exist in the current tonality system). 

In addition, a new Write ▸ Add Notes Above or Below dialog has been added, 
allowing the addition of notes of a given interval above or below the selected notes, 
providing a quick way of building chords over an extended passage of music. 

Tuplets 

Tuplets now show signposts if the tuplet ratio number/string is hidden, which 
allows them to be selected for copying and pasting, or for deletion. A new View ▸ 
Signposts ▸ Tuplets menu item allows you to choose whether or not signposts for 
hidden tuplets should be displayed. 
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Vertical spacing 

A new Staff Spacing section has been added to the left-hand panel in Engrave 
mode, allowing you to edit the vertical spacing of the music when switched on. 
Staves can be dragged with the mouse by clicking anywhere in the staff itself, or in 
the handle at the left-hand side of the system. The whole system can be dragged 
by clicking in the colored stripe immediately above the top staff in the system. 

Hold Alt while dragging a staff or system to also adjust the distance between all of 
the staves and systems below the staff or system being dragged, when there is no 
further room at the bottom of the music frame. 

Use the up/down arrow keys to select the handles at the left-hand side of the 
system; use Tab to cycle between selecting handles for systems and handles for 
staves. Hold Shift and use up/down arrow to extend the selection to the handle 
above/below. 

Nudge the selected staff, staves and/or systems using Alt+up/down arrow, and 
add Ctrl (Windows) or Command (Mac) to nudge in larger steps. 

Use Alt+J/K to nudge the selected staff, staves and/or system such that the 
distance between all of the staves and systems below the staves being nudged will 
also change, once there is no further room at the bottom of the music frame. 

When a staff or system has an overridden position, its handle or the colored stripe 
will be colored red. To remove a specific override, select the relevant handle and 
click Delete. 

To specify an exact distance, click on the numeric read-out in the left-hand margin, 
which allows the entry of a specific measurement, using the preferred units of 
measurement as determined in Preferences. 

To clear all overrides in the selected frame, choose Engrave ▸ Reset Staff 
Spacing. 

To copy the staff spacing from one page to other pages within the layout, click 
Copy Staff Spacing in the Staff Spacing section of the left-hand panel. A dialog 
appears in which you can choose the source page and range of destination pages. 
The staff spacing will be copied if the destination page has the same number of 
systems each containing the same number of staves as the source page. 

If the layout of music within the music frame changes because the music is cast off 
again, any staff spacing overrides for that passage of music will be removed. 

Voices 

 The option Gap between adjacent noteheads in different voices in the 
Voices section of the Notes page of the Engraving Options dialog now 
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respects negative values, allowing notes a second apart in opposing voices to 
be positioned more closely together. 

 New Edit ▸ Voice submenu, containing options to change the default stem 
direction of the voice of the selected note, or if note input is active, to change 
the default stem direction of the voice indicated on the caret. 

VST Expression Maps 

 A new dialog Play ▸ VST Expression Maps has been added, allowing you to 
create and edit expression maps to determine how changes in playing 
technique should be handled by the chosen virtual instrument. 

 VST Expression Maps for Cubase can be imported into your project via Play ▸ 
VST Expression Maps. 

 A new Endpoint Setup dialog has been added, accessed via each entry in the 
VST Instruments panel in Play mode, allowing you to specify which expression 
map is used by each channel on the chosen VST instrument. 

Issues resolved 
The following table lists all issues that have been resolved in this version: 

ID # Issue 

STEAM-4712 
Bars: Using the Shift+B popover to delete bars now also adjusts the position of any time signatures and 
key signatures that are affected by the deletion of bars preceding them. 

STEAM-5129 
Beaming: The behaviour of Edit ▸ Beaming ▸ Beam Together has been improved such that any selection 
that includes a tied note at its start or end will produce the expected beaming. 

STEAM-5040 
Beaming: A problem whereby rests under beams could be positioned incorrectly under some 
circumstances has been fixed. 

STEAM-5003 
Brackets and braces: The options to show sub-brackets and to draw sub-brackets using braces on the 
Brackets and Braces page of Engraving Options now work as expected. 

STEAM-5094 
Brackets and braces: Organ instruments with three staves now correctly show a brace spanning the 
upper two manual staves, leaving the pedal staff unbracketed. 

STEAM-4997 
Brackets and braces: Groups of players created in the Players panel in Setup mode now have separate 
brackets. 

STEAM-4981 Brackets and braces: Staff labels now draw correctly even when partially out of the viewport. 

STEAM-5050 
Brackets and braces: Long staff labels are now automatically wrapped if they exceed half the width of the 
music frame. 

STEAM-5099 
Brackets and braces: Instruments whose names have been overridden are no longer automatically 
numbered. 

STEAM-5119 
Brackets and braces: Saving and reloading a project in which there are multiple groups of players no 
longer incorrectly changes the order of players on reloading. 
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ID # Issue 

STEAM-4944 
Copy and paste: Copying and pasting individual dynamics from within a larger group of dynamics will now 
create new groups containing only the selected dynamics, rather than all of the dynamics from the original 
groups. 

STEAM-4948 
Copy and paste: Items of different types that are either specific to staves or voices are now mapped 
consistently when pasting, so that they don't end up on different staves than expected. 

STEAM-5085 Copy and paste: Attempting to paste an implicit rest followed by an explicit rest no longer causes a crash. 

STEAM-5007 
Copy and paste: When copying and pasting a selection that includes one or more empty instruments, the 
destination passage will also offset the appropriate number of empty instruments. 

STEAM-5027, 
STEAM-5041 

Copy and paste: It is now possible to copy from e.g. the right-hand staff of a piano instrument to the left-
hand staff, provided the source selection contains only material from a single staff. 

STEAM-5030 
Copy and paste: When copying and pasting dynamics, the pasted dynamics are now correctly left 
selected. 

STEAM-4837, 
STEAM-4839 

Copy and paste: Pasting material that includes dynamics or slurs into other staves at the same rhythmic 
position now result in the pasted dynamics and slurs becoming linked to the dynamics and slurs on the 
source staves. 

STEAM-5086 Dynamics: Attempting to set the color of a selected hairpin in Engrave mode no longer causes a crash. 

STEAM-4911 Holds and pauses: It is now possible to add a fermata to the final barline of a flow written in open meter. 

STEAM-5181 
Holds and pauses: A transitory spacing problem that could result in adding a caesura not resulting in 
space being added immediately has been fixed. 

STEAM-5145 Holds and pauses: Fermatas attached to barlines now always draw correctly in galley view. 

STEAM-5116 
Holds and pauses: Fermatas attached to barlines no longer sometimes cause a bar number at the start of 
the system to move incorrectly. 

STEAM-5171 
Instrument changes: Instrument change warning labels now appear correctly when the new instrument 
starts playing on the following system 

STEAM-5167 
Instrument changes: Instrument changes that occur near the start of the flow are now snapped to the start 
of the flow if the first instrument held by the player doesn't play at all before the new instrument starts 
playing. 

STEAM-5160 
Instrument changes: The light blue staff labels in galley view are now shown on each instrument, rather 
than for each player, making it easier to identify which staff is for which instrument held by each player. 

STEAM-5131 
Key commands: Key commands shown in tool tips are now correctly updated when key commands are 
edited. 

STEAM-4672 
Key commands: Setting a key command in the global context now correctly reports if there is a conflict 
with the same key combination in another context. 

STEAM-4985 
Key signatures and accidentals: Attempting to create a new accidental type in the Edit Tonality System 
dialog no longer causes a crash if an existing accidental is not already selected. 
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ID # Issue 

STEAM-5095 
Key signatures and accidentals: The Edit Key Signature dialog now correctly uses the bass F clef rather 
than the baritone F clef. 

STEAM-5057 
Key signatures and accidentals: Custom key signatures that use a newly-created accidental type are now 
shown correctly in the Custom Key Signatures section of the Key Signatures panel in Write mode. 

STEAM-5194 
Key signatures and accidentals: Custom key signatures now show the name supplied by the user as a 
tool tip when hovering over their button in the Key Signatures panel. 

STEAM-5136 
Key signatures and accidentals: Custom key signatures now transpose correctly in layouts set to 
transposing pitch rather than concert pitch. 

STEAM-5028 
Key signatures and accidentals: Repitching notes now works correctly in key signatures that have been 
chosen because they show one fewer sharp or flat than the enharmonic equivalent for transposing 
instruments. 

STEAM-5070 
Layout Options: Saving layout options as the defaults for future projects no longer causes new layouts to 
have either the wrong players and flows or no players and flows at all to be attached to them by default. 

STEAM-4986 
Layout Options: The option Use optical spacing for beams between staves on the Note Spacing page 
of Layout Options is now switched on by default in part layouts in new projects. 

STEAM-5130 
Layout Options: If the saved layout options refer to a non-default set of master pages that is not available 
in the new project, Dorico no longer crashes when creating the project. 

STEAM-5001 
Lyrics: Lyrics assigned to different voices but with the same line number now have the same vertical 
position. 

STEAM-5107 
Lyrics: Lyric extender lines and hyphens now stop correctly before the systemic barline at the end of the 
system. 

STEAM-5065 
Multi-bar rests: Grace notes positioned before a barline now draw correctly if the bar to which they are 
attached becomes consolidated into a multi-bar rest. 

STEAM-5093 Multi-bar rests: Fermatas now correctly cause multi-bar rests to break. 

STEAM-5237 
MusicXML import: Key signatures in MusicXML files that specify a number of fifths but no mode now 
import correctly. 

STEAM-4812 
Note input and editing: Using Space to advance a hairpin past a tuplet no longer engages sticky tuplet 
input, causing subsequent music to be overwritten unexpectedly. 

STEAM-5138 
Note input and editing: It is now possible to create a tied note longer in duration than a maxima, or 64 
quarter notes (crotchets). 

STEAM-5002 
Note input and editing: When using Lock to Duration, the caret now correctly advances to the end of the 
last note in the voice whose notes are being repitched. 

STEAM-4760 
Note input and editing: It is now possible to play chords on your MIDI keyboard when inputting ties with T 
or when Lock to Duration is active. 

STEAM-5072 
Note input and editing: The first note input via the mouse can now have an accidental and a rhythm dot if 
chosen from the panel. 

STEAM-5078 
Note input and editing: Double-clicking to start note input in galley view now always shows the caret at 
the correct location. 
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ID # Issue 

STEAM-5172 
Note input and editing: MIDI step-time input now correctly compensates for the octave transposition of 
the instrument (e.g. piccolo, double bass, guitar, tenor voice), if any. 

STEAM-5188 
Page layout: Graphics placed in graphics frames on master pages are now correctly saved and loaded 
with the project. 

STEAM-5083 
Page layout: A problem that prevented text frames from being deleted in some circumstances has been 
fixed. 

STEAM-5092 
Page layout: Using the formatting commands (e.g. make into system/frame, lock system/frame) in one 
layout no longer incorrectly removes formatting from other layouts. 

STEAM-4984 
Page layout: You can now remove overrides from all pages in the layout by clicking the Remove 
Overrides button in the Pages section of the right-hand panel in Engrave mode with no pages selected. 

STEAM-4886 
Playback: Dorico will now load sounds into all 16 channels of each instance of HALion Sonic SE, rather 
than leaving the final channel in each instance empty. 

STEAM-4496 
Playback: Dorico now compensates correctly for HALion patches that are transposed by one or more 
octaves (e.g. double bass, bass guitar). 

STEAM-4792 
Playback: The playback of hairpins has been improved such that immediate dynamics at either or both 
ends of the hairpin are now properly respected. 

STEAM-4988 
Playback: Attempting to open another project when the Mixer window is already open for the current 
project no longer causes Dorico to hang. 

STEAM-4955 
Playback: The default voice count for HALion Sonic SE in new projects has been increased from 128 to 
512. 

STEAM-4998 
Print mode: A problem whereby staff lines or other lines could appear the wrong thickness on the second 
and subsequent pages of exported PDFs has been fixed. 

STEAM-5098 Print mode: Exporting graphics files from multiple layouts in a single operation no longer causes a crash. 

STEAM-5042 Print mode: The default dots per inch (dpi) value for exported graphics is now 150dpi instead of 72dpi. 

STEAM-5097 
Print mode: Exporting multiple graphics no longer prompts separately to overwrite any found files: you can 
simply confirm that you want to overwrite all existing files at once. 

STEAM-5125 
Print mode: The Watermark text in the Annotations section of the print options panel will no longer be 
cleared incorrectly in the event that multiple selected layouts have conflicting values. 

STEAM-5219 
Print mode: Attempting to overwrite a graphics file that is locked by the filesystem (e.g. because it is open 
in another application) will no longer cause a crash. 

STEAM-4834 
Properties: It is no longer possible to set the values for dot diameter, dash length, and gaps between dots 
and dashes for ties and slurs to zero. 

STEAM-5063 Properties: Properties for X and Y offset for force and combined dynamics now appear correctly. 

STEAM-4570 Rehearsal marks: Rehearsal marks are now correctly centered above double and repeat barlines. 
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ID # Issue 

STEAM-4570 
Rehearsal marks: If the option to position rehearsal marks at the start of the system is chosen, the 
rehearsal marks are now correctly left-aligned with the systemic barline. 

STEAM-5035 
Rests: Rests that have properties set on them, e.g. to force a specific duration or to set a particular staff 
position, are now positioned in a manner consistent with other rests that don't have properties set. 

STEAM-5204, 
STEAM-4848 

Rests: It is now possible to select all individual rests in Engrave mode. 

STEAM-4979 
Selection: A problem whereby the marquee rectangle could be left behind if you hit Esc during a marquee 
selection has been fixed. 

STEAM-5143 
Slurs: A problem that prevented slurs starting in one voice and ending in another from being created 
correctly has been fixed. 

STEAM-4953 
Tempo: The Shift+T popover for tempo input is now much more flexible and will allow a much wider set of 
terms to be input. 

STEAM-5015 
Text: Edit ▸ Reset Appearance now clears any changes of font, size, and other typographical control in a 
selected text item. 

STEAM-5142 
Text: A problem whereby some Japanese fonts were truncated during text editing has been fixed (Mac 
only). 

STEAM-5061 Text: Creating a new text frame on a master page now sets the default paragraph style correctly. 

STEAM-4975 
Text: It is now possible to jump to the name of a specific font in the list of fonts in the text editor popover 
by typing the first letter or two of its name. 

STEAM-5055 
Text: Text frames that are too full now correctly truncate the text within the frame, rather than allowing the 
text to flow outside the frame. 

STEAM-5043 
Text: Copying and pasting text into Dorico from another application no longer causes the formatting of the 
text in the frame to be messed up. 

STEAM-5044 
Text: It is now possible to use the Unicode Hex Input input method to input extended Unicode characters 
into the text editor within Dorico (Mac only). 

 
Text: Paragraph styles in newly-created projects now inherit many of their settings from the Default Text 
paragraph style, making it possible to quickly change the main text font in use in your project by editing the 
Default Text paragraph style. 

STEAM-5154 Time signatures: Newly-created time signatures now correctly show that they are selected after creation. 

STEAM-5207 
User interface: The Layout Options, Notation Options, and Engraving Options dialogs now remember 
which page you were last looking at when you opened the dialog, and show that page when the dialog is 
reopened. 

STEAM-5208 
User interface: A read-out of the current page size using the user’s preferred measurement unit has been 
added to the Page Setup page of Layout Options. 

STEAM-5182 
User interface: The view type selector in the status bar no longer gets out of sync with the actual view 
used when switching layout. 

STEAM-4656 
User interface: When switching between modes, the state of the Hide/Restore Panels button on the 
toolbar correctly reflects which panels will be shown or hidden when clicked for that mode. 
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ID # Issue 

STEAM-5081 
User interface: Dorico no longer crashes when you right-click on a tab and choose to create either a 
vertical or horizontal split. 

STEAM-4978 
User interface: Dorico no longer allows the Mixer or Transport windows to be shown as full screen 
windows (Mac only). 

STEAM-4956 
User interface: The buttons on the toolbar to hide or show the Mixer and Transport windows now correctly 
reflect whether or not the Mixer and Transport windows are actually shown. 

STEAM-4908 
User interface: When closing the final project window and the Steinberg Hub is set not to reappear, the 
menus no longer disappear (Mac only). 

STEAM-4528 
User interface: New Write ▸ Create Voice and Next Voice menu items, intended to make the Shift+V 
and V key commands for use in note input more discoverable. 

STEAM-4039 
Zoom: The behaviour of zooming in when the selected item is close to the edge of the viewport has been 
improved. 

STEAM-5166 
Zoom: A problem whereby Dorico could crash when switching window mode when the zoom level is set 
to Whole page has been fixed. 

STEAM-5089 
Platform support: Dorico now uses DirectWrite to render all text and glyphs in its user interface, which 
should resolve the problem with icons appearing stretched or out of proportion until Dorico is restarted 
(Windows only). 

STEAM-4992 Localization: The names of templates that appear in the Steinberg Hub are now localised. 

STEAM-5305 
Localization: Typing characters that require the use of the Alt modifier (e.g. [, ] and |) into popovers now 
works correctly on non-English keyboards.  

STEAM-5312 
Localization: A number of problems with keys that produced accented characters when specifying key 
commands in the Key Commands page of Preferences have been fixed. 

STEAM-4893 
Localization: The handling of key commands in the Japanese language version of Dorico has been 
overhauled. 

STEAM-5310 
Localization: Changing the keyboard language on the Key Commands page of Preferences now takes 
effect immediately, rather than requiring a restart of Dorico. 

STEAM-5313, 
STEAM-5314 

Localization: The default key commands for French, Spanish, Italian, and Portuguese have been revised in 
relation to the various keyboard handling fixes. 
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Dorico 1.0.0 

October 2016 

Initial release version. 
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Known issues and solutions 

Frequently asked questions 
Answers to frequently asked questions about Dorico can be found online in the 
Dorico forum. 

Knowledge base 
For the latest information about issues and solutions you may encounter when 
running Dorico, please consult the Knowledge Base. 

Entering the eLicenser Activation Code (Mac only) 
When you first run Dorico and are prompted to enter your Activation Code, you 
may find that after you have successfully activated your Soft-eLicenser, you must 
quit and restart Dorico for the application to detect that it is fully licensed. 

Key commands to transpose notes by an octave (Windows only) 
The Intel Graphics Adaptor drivers used by many Windows computers define a 
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut 
Ctrl+Alt+up/down/left/right arrows. 

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for 
transposing notes by an octave. 

For information about how to disable the default Intel Graphics Adaptor key 
command, consult the Knowledge Base. 

Audio export 
No progress dialog appears on Mac during audio export. A busy cursor will appear 
for the duration of the export operation. Check that the operation has completed 
successfully before you try to play back the exported audio file. You can verify that 
the export has completed successfully by checking the file size of the exported file: 
if it is reported as 0 bytes, the file is still locked for writing.  

https://www.steinberg.net/forums/viewtopic.php?f=246&t=104450
https://helpcenter.steinberg.de/hc
https://helpcenter.steinberg.de/hc
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